# TABLE OF CONTENTS

## FRONT MATTER

<table>
<thead>
<tr>
<th>Table of Contents Page</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019 Course Schedule</td>
<td>2-4</td>
</tr>
<tr>
<td>Developmental Staging Series - Excerpt from Kimmel et al., 1995</td>
<td>5-16</td>
</tr>
</tbody>
</table>

## ZEBRAFISH DEVELOPMENT AND GENETICS COURSE MATERIALS

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Zebrafish Development &amp; Gastrulation - Solnica-Krezel</td>
<td>17-23</td>
</tr>
<tr>
<td>Adult Zebrafish: A Model for Tissue Regeneration - Poss</td>
<td>24-31</td>
</tr>
<tr>
<td>Introduction to Microscopy &amp; Imaging - Collazo, Raible, Fadool &amp; Yelon</td>
<td>32-35</td>
</tr>
<tr>
<td>Light Sheet Microscopy - Huisken</td>
<td>36-41</td>
</tr>
<tr>
<td>Microinjection and Morpholinos - Mullins &amp; Pauli</td>
<td>42-51</td>
</tr>
<tr>
<td>Germ Cell Experiments - Pauli</td>
<td>52-58</td>
</tr>
<tr>
<td>Designing and Constructing GuideRNAs for CRISPR - Giraldez</td>
<td>59-62</td>
</tr>
<tr>
<td>RNA-Seq Analysis Resources - Giraldez</td>
<td>63</td>
</tr>
<tr>
<td>Imaging in situ and Immunostained Embryos - Amacher &amp; Houart</td>
<td>64-72</td>
</tr>
<tr>
<td>Chimeric Analysis - Amacher, Fadool, Collazo &amp; Schilling</td>
<td>73-80</td>
</tr>
<tr>
<td>High Resolution Cell Transplantation in Late Stage Embryos - Houart</td>
<td>81-82</td>
</tr>
<tr>
<td>Live Imaging &amp; Tracking Innate Immune Cells - Hutttenlocher</td>
<td>83-96</td>
</tr>
<tr>
<td>Visual and Locomotor Behaviors - Granato, Fadool &amp; Wyart</td>
<td>97-110</td>
</tr>
<tr>
<td>In vitro Fertilization - Amacher</td>
<td>111-116</td>
</tr>
<tr>
<td>Quantitative Morphometrics of Muscle Cell Attachments - Schilling</td>
<td>117-132</td>
</tr>
<tr>
<td>Labeling Cells with Photoconvertible Fluorescent Proteins - Yelon</td>
<td>133-140</td>
</tr>
<tr>
<td>Controlling Protein Subcellular Localization with Light - Clarke</td>
<td>141-143</td>
</tr>
<tr>
<td>Transgenesis and Imaging Subcellular Structures - Marlow</td>
<td>144-148</td>
</tr>
<tr>
<td>Lipid Metabolism Visualization - Farber</td>
<td>149-154</td>
</tr>
<tr>
<td>Visualizing Genetically-encoded Calcium Indicators in the Heart - Yelon</td>
<td>155-158</td>
</tr>
</tbody>
</table>

## APPENDICES

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purview of Roundtable Discussions</td>
<td>159-160</td>
</tr>
<tr>
<td>Course Faculty Contact Information</td>
<td>161-163</td>
</tr>
<tr>
<td>Student Contact Information</td>
<td>164</td>
</tr>
<tr>
<td>Sponsors</td>
<td>165</td>
</tr>
</tbody>
</table>
# 2019 ZEBRAFISH GENETICS AND DEVELOPMENT COURSE SCHEDULE

### Mon 5 Aug
- **2:00 – 5:00**  Student check-in (Swope)
- **6:00 – 6:30**  Light dinner – cold cuts & veggies (Lobby of Candle House 104/5)
- **6:30 – 6:45**  Welcome: Sharon Amacher and Debbie Yelon (Candle House 104/5)
- **6:45 – 7:45**  Overview: Zebrafish development and genetics: Lila Solnica-Krezel (Candle House 104/5)
- **7:45 – 9:30**  Student 3-min oral presentations and poster session (Candle House 104/5)

### Tues 6 Aug
- **8:30 – 9:15**  Introduction to stereoscopes, iPad/camera and server setup: Dave Raible & faculty (Loeb 260)
- **9:15 – noon**  Pit Talk and Lab: Zebrafish development (temporal dynamics, tissue organization, early embryo anatomy): Lila Solnica-Krezel, Dave Raible (Loeb 260)
- **Noon – 1:30**  Faculty (Lila Solnica-Krezel and Dave Raible) lunch with students (Swope)
- **1:30 – 6:00**  Adult dissection and Regeneration lab (fin and heart): Ken Poss (Loeb 260)
- **7:30 – 9:00**  Research Lectures and Discussion: Alex Schier and Dave Raible (Starr 209) followed by reception with get-to-know-who bingo in Loeb 256
- **9:00 – 11:00** Overnight time-lapse microscopy: Andres Collazo and Jim Fadool (Group 1)
- **9:00 – 11:00** Overnight time-lapse microscopy: Jan Huisken (Group 4)

### Wed 7 Aug
- **9:00 – 10:00**  Orientation, Health and Safety and Biosafety, IACUC Training (Meigs Room, Swope)
- **10:00 – 11:00**  Lecture: Introduction to Microscopy: Andres Collazo (Loeb 260)
- **11:00 – noon**  Hands-on microscopy & imaging (fluorescent dissecting scopes plus larval anatomy): Andres Collazo, Dave Raible, Jim Fadool, Debbie Yelon (Loeb 260)
- **Noon – 1:30**  Faculty (Ken Poss and Alex Schier) lunch with students (Swope)
- **1:30 – 3:30**  Hands-on microscopy & imaging (compound scopes): Andres Collazo, Dave Raible, Jim Fadool, Debbie Yelon (Loeb 260)
- **3:30 – 5:00**  Lecture and Discussion: Light Sheet Microscopy: Jan Huisken (Starr 209)
- **5:00 – 6:00**  Round Table: Responsible Conduct in Research: Amacher and Yelon (Starr 209)
- **7:30 – 9:00**  Research Lectures & Discussion: Lila Solnica-Krezel and Ken Poss (Starr 209) followed by reception with get-to-know-who bingo in Loeb 256 with party games
- **9:00 – 11:00**  Overnight time-lapse microscopy: Andres Collazo and Jim Fadool (Group 2)
- **9:00 – 11:00**  Overnight time-lapse microscopy: Jan Huisken (Group 3)

### Thurs 8 Aug
- **8:30 – 11:30**  Pit Talk and Lab: mRNA and CRISPR injections: Andi Pauli & Mary Mullins (Loeb 260)
- **11:30 – noon**  Needle pulling demo: Adair Oesterle (Sutter Instruments) (Loeb 260)
- **Noon – 1:00**  Faculty (Jan Huisken and Andi Pauli) lunch with students (Swope)
- **1:00 – 2:00**  Developmental Genetics review: Mary Mullins (Starr 209)
- **2:00 – 3:00**  Round Table: Morpholino use: Mary Mullins, Sharon Amacher, Andi Pauli (Starr 209)
- **3:00 – 5:00**  CRISPR design workshop: Antonio Giraldez (Starr 209)
- **5:00 – 6:00**  Round Table: Genome Editing: Giraldez and faculty (Starr 209)
- **7:30 – 9:00**  Research Lectures and Discussion: Andi Pauli and Antonio Giraldez (Starr 209)
- **9:00 – 9:45**  Wrap-up mRNA injected embryos: Andi Pauli & Mary Mullins (Loeb 260)
- **9:45 – 11:45**  Overnight time-lapse microscopy: Andres Collazo and Jim Fadool (Group 3)
- **9:45 – 11:45**  Overnight time-lapse microscopy: Jan Huisken (Group 1)
- **9:45 - ???**  Finalize t-shirt design

### Fri 9 Aug
- **9:00 – 11:45**  Pit Talk and Lab: Morpholino and CRISPR injections: Andi Pauli & Mary Mullins (Loeb 260)
- **Noon – 2:00**  Facility visit and Lunch: Aquatic Systems: Sharon Amacher, Debbie Yelon, & suppliers (meet in courtyard; travel to Rowe; back to courtyard for pizza lunch with vendors)
2:00 – 6:00  Bioinformatics Pit Talk and Lab – Functional genomics, epigenomics and resources, including RNA-seq analysis: Antonio Giraldez (Starr 209)

7:00 – 7:45  Research Lecture and Discussion: Mary Mullins (Starr 209)

8:00 – 9:00  MBL Friday Evening Lecture: Steven Haddock (Lillie Auditorium)

9:00 – 9:30  Check injected embryos from the AM: Andi Pauli and Mary Mullins (Loeb 260)

9:30 – 11:30 Overnight time-lapse microscopy: Andres Collazo and Jim Fadool (Group 4)

9:30 – 11:30 Overnight time-lapse microscopy: Jan Huisken (Group 2)

**Sat 10 Aug**

8:30 – 9:30  Introduction to ZFIN, atlases, and web resources: Houart and Amacher (Loeb 263)

9:30 – 10:00 Pit Talk: Immunostaining & in situ hybridization: Houart and Amacher (Loeb 260)

10:00 – Noon Mounting, analysis, and imaging of fixed embryos: Houart and Amacher (Loeb 260)

Noon – 1:00  Faculty lunch (Mary Mullins and Antonio Giraldez) with students (Swope)

1:00 – 5:00  Lab: Continuation from morning (Loeb 260)

5:00 – 6:00  Make presentations of immunostaining and in situ hybridization images (Loeb 260)

7:30 – 8:15 Research Lecture and Discussion: Corinne Houart (Starr 209)

8:15 – 10:00 Wrap-up: student presentations with Corinne Houart and Sharon Amacher (Starr 209)

10:00 – 10:30 Check injected embryos from Friday’s injection module for germline phenotype

**Sun 11 Aug**

9:00 - 9:45 Research Lecture and Discussion: Anna Huttenlocher (Loeb 263)

9:45 – 10:45 Round Table: Disease models: Anna Huttenlocher and Jeff Gross (Loeb 263)

10:45 – noon Pit Talk: Chimeric Analysis: Sharon Amacher and Jim Fadool (Loeb 260)

Noon – 1:00  Faculty lunch (Anna Huttenlocher and Sharon Amacher) with students (Swope)

1:00 – 6:00  Chimeric analysis Lab: Blastula transplants: Sharon Amacher, Jim Fadool, Andres Collazo, and Tom Schilling (Loeb 260)

7:30 – 10:00  Faculty & Staff Event; Student self-organized social time (Starr 209)

10:00 – 11:00  Optional overnight time-lapse microscopy of transplants (on your own)

**Mon 12 Aug**

8:30 – 9:00  Check CRISPR injected embryos for pigmentation (and other) phenotypes (Loeb 260)

9:00 – 9:30  Pit Talk: “High resolution” transplants

9:30 – noon  Lab: “High resolution” transplants (Houart; small groups rotate) and imaging early transplants (Michael Granato, Tom Schilling, Jim Fadool, Andres Collazo)

Noon – 1:00  Faculty lunch (Anna Huttenlocher and Sharon Amacher) with students (Swope)

1:00 – 2:30  Continuation of the morning lab (Houart); Check on regenerating fins (Poss and Yelon)

2:30 – 4:30  Free Time (*Faculty meeting held for 1 hour during this time*)

4:30 – 6:00  Student/Faculty Challenge (Scavenger Hunt)

6:30 – 9:00  Course BBQ (courtyard between Loeb/Rowe/Starr)

**Tues 13 Aug**

8:30 – 10:30  Wrap up chimeric analysis: Sharon Amacher, Jim Fadool, Michael Granato, Corinne Houart: Transplant show and tell by group (Loeb 260)

10:30 – noon  Lecture and Discussion: Husbandry, breeding and raising fry: April Freeman (Starr 209)

Noon – 1:00  Faculty lunch (Kara Cerveny and Dave Daggett) with students (Swope)

1:00 – 2:00  Pit Talk: Imaging + Quantification of cell signaling *in vivo*: Anna Huttenlocher (Loeb 260)

2:00 – 6:00  Lab: Imaging + Quantification of cell signaling *in vivo*: Anna Huttenlocher (Loeb 260)

7:30 – 9:00 Research Lectures and Discussion: Sharon Amacher and Michael Granato (Starr 209)

9:00 - 9:30 Wrap-up of Imaging/Quantification: Anna Huttenlocher (Loeb G70)

10:00  Stony Beach evening quiet field trip to see bioluminescence

**Wed 14 Aug**

9:00 – 10:00  Pit Talk Behaviors: Michael Granato, Jim Fadool, Andy Pendergast (Team Wyart)
2019 ZEBRAFISH GENETICS AND DEVELOPMENT COURSE SCHEDULE

(Loeb 260)

10:00 – noon  Lab: Motor, visual, and sensory-motor integration: Granato, Fadool and Dowling, Team Wyart (Loeb 260)

Noon – 1:30  Faculty (Michael Granato and John Dowling) lunch with students (Swope)

1:30 – 5:00  Lab: continuation: Behaviors: Michael Granato and Jim Fadool (Starr 209)

5:00 – 6:00  Round Table: Transgenesis: Flo Marlow (Starr 209)

6:00 – 6:15  Instructions about downloading materials for Quantitative morphometrics module

7:30 – 9:00  Research Lectures and Discussion: Jim Fadool and Tom Schilling (Starr 209)

9:00 – 10:30  Fin regeneration results and terminal imaging: Poss and Yelon (Loeb 260)

10:30  Confirm download of materials for Quantitative morphometrics module (Loeb 256)

Thurs 15 Aug

9:00 – 11:30  Pit Talk and Lab: In vitro fertilization (IVF) Sharon Amacher (Loeb 260)

11:30 - noon  Pit Talk: Quantitative morphometrics: Tom Schilling (Loeb 263)

Noon – 1:00  Faculty (Jim Fadool and Tom Schilling) lunch with students (Swope)

1:00 – 5:00  Lab: Quantitative morphometrics: Tom Schilling (Loeb 260)

5:00 – 6:00  Wrap up and group presentations for quantitative morphometrics

7:30 – 9:00  Research Lectures and Discussion: Jon Clarke and Flo Marlow (Starr 209)

9:00 – 9:30  IVF wrap-up (plus look again in the morning)

9:30 – 11:00  Reception in Loeb 256

Fri 16 Aug

8:15 – 9:00  Pit Talk: Photoconversion and optogenetics: Yelon and Clarke (Loeb 260)

9:00 – noon  Rotations/Demonstrations: Photoconversion: Yelon, Protein mis-localization: Clarke, Lipid metabolism, part 1: Farber (Loeb 260)

Noon – 1:30  Faculty (Jon Clarke and Flo Marlow) lunch with students (Swope)

1:30 – 2:00  Pit Talk: Imaging metabolism and subcellular structures: Marlow and Farber (Loeb 260)

2:00 – 5:45  Rotations/Demonstrations: Subcellular structures: Marlow; Lipid metabolism: Farber; Cardiac conduction: Yelon (Loeb 260)

7:30 – 9:00  Research Lectures and Discussion: Debbie Yelon and Steve Farber (Starr 209) followed by reception in Loeb 256

Sat 17 Aug

9:30 – noon  Cardiac regeneration results and terminal imaging: Poss and Yelon (Loeb 260)

Noon – 1:30  Faculty (Debbie Yelon and Steve Farber) lunch with students (Swope)

1:30 – 3:00  Round Table: Zebrafish in Education: Kara Cerveny, Dave Daggett, Steve Farber (Starr 209)

3:00 – 6:00  Prepare photo contest submissions and 5-minute student presentations of favorite data (Starr 209). Photo contest images (individual & group entries) must be submitted by 6 pm.

7:30 – 9:00  Chi-Bin Chien Memorial Research Lecture: Sarah Kucenas (Speck Auditorium, Rowe) followed by reception in Loeb 256

Sun 18 Aug

9:00 – noon  Falmouth Road Race and/or finalize preparation of 5-min presentations

Noon – 1:30  Faculty (Sarah Kucenas) lunch with students (Swope)

1:30 – 3:30  Five-minute student presentations of favorite piece of data (Starr 209)

3:30 – 4:30  Course Wrap-up discussion with Amacher and Yelon (Starr 209)

6:00 – 10:00  Course Dinner and Student Awards (Swope Patio)

Mon 19 Aug

Breakfast, room checkout and departure
Stages of Embryonic Development of the Zebrafish

CHARLES B. KIMMEL, WILLIAM W. BALLARD, SETH R. KIMMEL, BONNIE ULLMANN, AND THOMAS F. SCHILLING

Institute of Neuroscience, University of Oregon, Eugene, Oregon 97403-1254 (C.B.K., S.R.K., B.U., T.F.S.); Department of Biology, Dartmouth College, Hanover, NH 03755 (W.W.B.)

<table>
<thead>
<tr>
<th>Period</th>
<th>h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zygote</td>
<td>0</td>
<td>The newly fertilized egg through the completion of the first zygotic cell cycle</td>
</tr>
<tr>
<td>Cleavage</td>
<td>¾</td>
<td>Cell cycles 2 through 7 occur rapidly and synchronously</td>
</tr>
<tr>
<td>Blastula</td>
<td>2¼</td>
<td>Rapid, metasynchronous cell cycles (8, 9) give way to lengthened, asynchronous ones at the midblastula transition; epiboly then begins</td>
</tr>
<tr>
<td>Gastrula</td>
<td>5¼</td>
<td>Morphogenetic movements of involution, convergence, and extension form the epiblast, hypoblast, and embryonic axis; through the end of epiboly</td>
</tr>
<tr>
<td>Segmentation</td>
<td>10</td>
<td>Somites, pharyngeal arch primordia, and neurones develop; primary organogenesis; earliest movements; the tail appears</td>
</tr>
<tr>
<td>Pharyngula</td>
<td>24</td>
<td>Phylotypic-stage embryo; body axis straightens from its early curvature about the yolk sac; circulation, pigmentation, and fins begin development</td>
</tr>
<tr>
<td>Hatching</td>
<td>48</td>
<td>Completion of rapid morphogenesis of primary organ systems; cartilage development in head and pectoral fin; hatching occurs asynchronously</td>
</tr>
<tr>
<td>Early larva</td>
<td>72</td>
<td>Swim bladder inflates; food-seeking and active avoidance behaviors</td>
</tr>
<tr>
<td>Stage</td>
<td>h</td>
<td>HB</td>
</tr>
<tr>
<td>----------------------</td>
<td>---</td>
<td>----</td>
</tr>
<tr>
<td><strong>Zygote period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-cell</td>
<td>0</td>
<td>1,2</td>
</tr>
<tr>
<td><strong>Cleavage period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-cell</td>
<td>¾</td>
<td>3</td>
</tr>
<tr>
<td>4-cell</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>8-cell</td>
<td>1¾</td>
<td>5</td>
</tr>
<tr>
<td>16-cell</td>
<td>1½</td>
<td>6</td>
</tr>
<tr>
<td>32-cell</td>
<td>1¾</td>
<td>7</td>
</tr>
<tr>
<td>64-cell</td>
<td>2</td>
<td>8</td>
</tr>
<tr>
<td><strong>Blastula period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>128-cell</td>
<td>2¼</td>
<td>9</td>
</tr>
<tr>
<td>256-cell</td>
<td>2½</td>
<td>7</td>
</tr>
<tr>
<td>512-cell</td>
<td>2¾</td>
<td>9</td>
</tr>
<tr>
<td>1k-cell</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>High</td>
<td>3½</td>
<td>&gt;11</td>
</tr>
<tr>
<td><strong>Oblong</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5%</td>
<td>3</td>
<td>11</td>
</tr>
<tr>
<td><strong>Sphere</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>12</td>
<td>Spherical shape; flat border between blastodisc and yolk</td>
</tr>
<tr>
<td><strong>Dome</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4½</td>
<td>13</td>
<td>Shape remains spherical; yolk cell bulging (doming) toward animal pole as epiboly begins</td>
</tr>
<tr>
<td><strong>30%-epiboly</strong></td>
<td>4½</td>
<td>14</td>
</tr>
<tr>
<td><strong>Gastrula period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50%-epiboly</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td><strong>Germ-ring</strong></td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td><strong>Shield</strong></td>
<td>6</td>
<td>15</td>
</tr>
<tr>
<td><strong>75%-epiboly</strong></td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td><strong>90%-epiboly</strong></td>
<td>9</td>
<td></td>
</tr>
<tr>
<td><strong>Bud</strong></td>
<td>10</td>
<td>17</td>
</tr>
<tr>
<td><strong>Segmentation period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-somite</td>
<td>10½</td>
<td>First somite furrow</td>
</tr>
<tr>
<td>5-somite</td>
<td>11½</td>
<td>18</td>
</tr>
<tr>
<td>14-somite</td>
<td>16</td>
<td>19</td>
</tr>
<tr>
<td>20-somite</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>26-somite</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td><strong>Pharyngula period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prim-5</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>Prim-15</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Prim-25</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>High-pec</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td><strong>Hatching period</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long-pec</td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>Pec-fin</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Protruding-mouth</td>
<td>72</td>
<td></td>
</tr>
</tbody>
</table>

*EL, embryo length; PF, pectoral fin; h, hours of development at 28.5°C; HB, approximate stage no. in the Hisaoka and Battle (1958) zebrafish staging series (reasonably accurate through HB stage 20); HD, head diameter in dorsal view; NO, Nomarski optics; H/W, height/width; Prim, Prim stages refer to the no. of the myotome to which the leading end of the posterior lateral line primordium has advanced; YB, yolk ball; YE, yolk extension; YSL, yolk syncytial layer; HTA, head-trunk angle; OVL, otic vesicle length.
1-cell
0.2 h

2-cell
0.75 h

4-cell
1 h

8-cell
1.25 h

16-cell
1.5 h

32-cell
1.75 h

64-cell
2 h

128-cell
2.25 h

256-cell
2.5 h

512-cell
2.75 h

1k-cell
3 h

high
3.3 h

Fig. 1 (Legend to Fig. 1 appears on page 259).
Fig. 1 (continued).
Fig. 1 (continued).

10-somite 14 h
14-somite 16 h
18-somite 18 h
21-somite 19.5 h

26-somite 22 h
prim-6 25 h
prim-16 31 h
prim-22 35 h
Fig. 1. Camera lucida sketches of the embryo at selected stages. The animal pole is to the top for the early stages, and anterior is to the top later, except for the two animal polar (AP) views shown below their side view counterparts for germ-ring and shield gastrulas. Face views are shown during cleavage and blastula stages. After shield stage, the views are of the embryo's left side, but before the shield arises one cannot reliably ascertain which side is which. Pigmentation is omitted. Arrowheads indicate the early appearance of some key diagnostic features at yolk mass, and differential shrinkage during fixation distorts the normal relationship. Nevertheless, if preservation is good enough, one can fairly reliably stage fixed and whole-mounted embryos (e.g., immunolabeled ones) using other criteria. One cannot easily stage an embryo after it is sectioned.

Photographs
The accompanying photographs are of living embryos, anesthetized for the later stages. The original photographs were made as color slides (Kodak Ektachrome 160T DX), and the black and whites plates are reproduced from internegatives. Sets of copies of the
Figure 4. Drawings of the embryo at 1 day postfertilization

24 h
dorsal

hindbrain

brain cavity (3rd ventricle)
cerebellar fold

hatching gland
caudal vein
dorsal aorta; unpaired
yolk underneath

vacuolated notochord cells

lateral
dorsal aorta (not completed, yet)

otic pit

heart anlage

hindbrain

cerebellar fold

floor plate

notochord

notochord sheath

blood islands

pronephric duct

hatching glands

ventral

small heart beat

3rd brain ventricle (midbrain)

blood cells

forebrain

urinogenital opening

ventricular aqueduct
Figure 5. Drawings of the embryo at 2 days postfertilization

2d
dorsal

lateral

ventral
Figure 6. Drawings of the larva at 5 days postfertilization

5d. Wildtype pigmentation pattern
Figure 7. Drawings of the larva at 7 days postfertilization

7d

**dorsal**
- forebrain
- midbrain
- hindbrain
- pectoral fin
- notochord
- meckel's cartilage of the mandibular arch
- olfactory pit
- 3rd ventricle
- otoliths
- otic capsule
- eye
- camellium
- hindbrain
- central canal
- myotomes
- dorsal fin
- floor plate
- notochord
- dorsal aorta
- caudal fin

**lateral**
- mouth
- eye
- lens
- forebrain
- hyoid
- gill arches
- pectoral fin
- atrium
- ventricle
- heart
- pectoral fin
- swim bladder
- ventral fin
- anus
- posterior cardinal vein

**ventral**
- meckel's cartilage of the mandibular arch
- mandibular arch
- hyoid arch
- gill arches
- liver
- posterior cardinal vein
- stomach
- intestine
- heart
- pronephric duct
- pronephric region
- intestine
- posterior cardinal vein
- dorsal aorta
- 180° turn of the dorsal aorta

Remark: blood vessels not indicated
Fig. 23. Sculpturing of the brain rudiment during the segmentation period. A: We do not see morphological subdivisions at the six-somite stage (12 h). B: By the 18-somite stage (18 h) about ten neuromeres have developed—the telencephalon (T), diencephalon (D), mesencephalon (M), and about seven hindbrain rhombomeres (r1–r7). C: At prim-5 (24 h) the epiphysis (E) is present in the midline of diencephalic roof, and the ventral diencephalon has expanded as the rudiment of the hypothalamus. The dorsal midbrain, or tectum (M), is now partitioned from the ventral midbrain, or tegmentum. The cerebellum (C) is evident at the hindbrain/midbrain boundary region. The floor plate (FP) extends in the ventral midline up to, but not including the forebrain. Reproduced, with permission, from Kimmel (1993). © 1993, Annual Reviews Inc. Scale bars = 200 μm.
Fish vs human

From Butler and Hodos, 1996
Introduction to the zebrafish

Lila Solnica-Krezel and Gina Castelvecchi (TA)

Materials for Monday (August 5th) and Tuesday (August 6th) – to help introduce the zebrafish, stages of embryonic development and mutants (Based on Chuck Kimmel's notes with modifications by Lila Solnica-Krezel, Diane Sepich, Terin Budine, and Margot Williams)

I. Monday evening introductory lecture: “Zebrafish as a model of vertebrate development”

II. Tuesday morning lab introduction. “Watching embryos develop – a primer for the first lab”.

III. Tuesday Lab notes “Exploring the zebrafish embryo: stages, mutants and cytoskeleton”

We separately provide copies for you of the 1995 Kimmel et al. paper “Stages of embryonic development of the zebrafish”, which will be useful in the lab. A PDF version is on the lab's Mac, and also PDF files of the following introductory papers:


I. Monday evening

Zebrafish as a model of vertebrate development

Status of the zebrafish as a model for vertebrate genetics and development
Some features of the zebrafish and its embryo make it an attractive system for learning about development and how genes control development.

1. The zebrafish as a genetic model:
2. Mutants! Useful tools to understand how axis is induced the nervous system is wired, and many other problems.
• First developmental mutants in zebrafish identified by such screens. Chuck Kimmel and Charline Walker find *spadetail, cyclops*.
• Janni Nüsslein-Volhard (Tubingen) & Wolfgang Driever (Boston): The large scale genetic screens. Now many mutations, identifying hundreds of developmentally acting genes are available, and are being characterized and mapped.
• Mary Mullins and Francisco Pelegri maternal-effect screens.
• Nancy Hopkins and retroviral insertion mutants.
• TILLING & ILLING mutants
• Sequence-specific Nuclease Systems
  o Zinc finger Nucleases
  o TALE Nuclease
  o CRISPR/Cas9
• Genetic compensation – a new geneticists’ nightmare

3. Zebrafish genome
4. Spatiotemporal gene expression
   a. Whole mount in situ hybridization
   b. RNA-seq
   c. Single cell RNA-seq

5. Transgenics.
4. Axis specification.
5. Germ layers specification and patterning.
   • Epiboly
   • Internalization
   • Convergence & Extension

II. Tuesday morning
Watching embryos develop – a primer for the first lab

In the Stages paper (see ZFIN for better images), embryonic development is divided into a set of developmental periods (e.g. the period of gastrulation), and further subdivided into an open-ended series of stages. We use time-lapse movies in this class meeting (see also “About the Quicktime Movies”, below) to introduce what is happening during the early developmental periods:

• 1-cell (or zygote period) (0-0.7 hours post fertilization; hpf) Newly fertilized egg. The non-yolky blastomere segregates towards the animal pole. You can watch the cytoplasmic segregation, the formation of the first blastomere and then its
division.
  - Blastula (2.2-5.2 hpf). Cell size and shape of the blastodisc tells you the stage. Yolk syncytial layer (YSL) formation at the midblastula transition (3hpf), and the likely function of the dorsal YSL as a Nieuwkoop organizing center. Midblastula transition and the origin of zygotic gene expression. Early 'random' (?) cell movement. Morphogenesis begins in the late blastula. Epiboly by radial intercalation -- scatter of clonally-related cells. The blastoderm margin as zone of lower cell-scattering.
  - Gastrulation (5.2-10 hpf). Epiboly continues and conveniently indicates stage. Beneath the EVL the blastoderm begins marginal ingress to develops two layers. The outer epiblast feeds the inner hypoblast (or mesendoderm). Both layers undergo convergence and extension. The first organ, the notochord, becomes delineated by establishment of the axial/paraxial boundaries in the mesoderm (eventually the notochord/somite boundary).

**In the Lab: Exploring the embryo – developmental stages, mutants, and the cytoskeleton**

*Before you start: Young embryos are very delicate!*

1. Young embryos cannot tolerate the pressure of tearing a chorion roughly around them.
2. Passing through the air/water interface will rupture dechorionated embryos, so keep them submerged.
3. Embryos in their chorions are surprisingly robust. They can tolerate being placed in a dish and having the surrounding buffer removed with a pipette tip. This is handy when the buffer is being changed or the embryos transferred into fix or when they are dropped onto the counter.
4. The working stock for most applications with dechorionated embryos is 0.3x or 30% Danieau (1.8 mM Ca^{2+}).
5. For performing microsurgery or dechorionating very young embryos with pronase, use 1x Danieau Buffer (100%; 5.4 mM Ca^{2+}).
6. 2% Methylcellulose is very dense and will hold embryos reasonably well for time lapse, but it will allow you to turn the embryo if needed. Lower percentage Methylcellulose can be used with a trade off in terms of stability for ease of movement.

WHAT WE DO: We do three ‘experiments’ to answer the three questions below, and will observe 2–3 mutants with phenotypes that manifest during gastrulation. Our purpose is to begin to become familiar with the early developmental pattern, normal and abnormal, of our zebrafish *Danio rerio* and ask about the role of microtubule cytoskeleton in the early inductive and morphogenetic processes.

Questions:
How would you characterize the division pattern of the early cleavages?
Is the cleavage pattern correlated with the dorsal-ventral embryonic polarity?

1. Dechorionate embryos in 0.3x Danieau Buffer. Take your time. Young embryos cannot tolerate pressure, so tear a hole in the chorion with a pair of watchmaker forceps, adjust your forceps and tear again until you have a hole large enough for the embryo to fall through. Then turn the chorion so the embryo can fall out.

2. Put a drop (or several drops) of Methyl Cellulose solution to fill the circle in the center (approx 250 µL) on the glass bottom dish or (about 150 µL) on a 24x60 mm bridged coverslip. Both configurations are intended for inverted microscopes.

3. Take embryo and buffer in a large bore Pasteur pipette.

4. Place the tip of the pipette deeply into the bottom of the Methyl Cellulose and allow the embryo to fall down the pipette to the tip and out into the methylcellulose.
   * Passing through the air/water interface will rupture embryos, so keep them submerged;
   * The embryo should fall down from the tip of the pipette into the methylcellulose slowly by itself. But if not, give it a little bit pressure without introducing too much buffer;
   * If the embryo is dropped near the surface instead of the bottom of the methylcellulose, it may take a long time to sink to the bottom. Stirring the surrounding methylcellulose would help them get to the bottom in a few minutes. But never touch the embryo anywhere as it would possibly generate damages.

5. To adjust the position of the embryo, stir the methylcellulose near the embryo with your forceps. If you want to place additional embryos on the dish, put them far enough away so your stirring will not inadvertently disturb their position.

6. Gently add buffer to the glass bottom dish or place a coverslip on the bridged coverslip.

Experiment 2. Treat cleavage and sphere stage embryos with Nocodazole

Questions:
What is the organization of microtubule cytoskeleton during early zebrafish development?
What are the roles of microtubules during the cleavage stages?
What is the organization of microtubule cytoskeleton during gastrulation?
What are the roles of microtubules in gastrulation movements?

* All solutions and tips should be collected as hazardous waste as we are required to do. Intraperitoneal (Mouse) LD50: 39.53 mg/kg (LD50 for 50 kg mouse is 1977 mg or 1.98 g IP).

1. Distribute 1 mL of 0.3x Danieau (1.8 mM Ca²⁺) solution to each of 3 wells of 24-well
plate, which is in a secondary container, like a tray (for safety purposes).

2. Drop in ~10 1-cell stage or 2-cell stage embryos per well, letting them fall into solution from the pipette. Dechorionation is not necessary here.

3. Add 1 µL of 10 mg/mL Nocodazole stock solution in DMSO (provided) to one well of embryos. Pipette up and down and swirl very gently to mix (final working concentration will be 10 µg/mL).

4. Add 1 µL DMSO to a second well of embryos as a control group.

5. Incubate early cleavage-stage embryos at 28.5 C for 30 minutes then examine the progress of development compared with controls.

6. Add 1 µL of 10 mg/mL Nocodazole stock solution (10 µg/mL final) to the third well of embryos at sphere-stage (4 hpf). Incubate at 28.5 C for 1 hour (you can check them after lunch), then examine epiboly progression compared with DMSO-treated controls.

**Alternative experiments:**
1. Treat early epiboly stage (sphere, 4 hpf) embryos with 10 µg/mL nocodazole to disrupt microtubules.
2. Test the effectiveness of nocodazole on embryos inside chorion versus those dechorionated.

**Experiment 3. Treat sphere and shield stage embryos with Nodal inhibitor SB505124**

**Questions:**
What is the effect of inhibiting Nodal signaling (a morphogen with critical roles in embryonic patterning and morphogenesis) on gastrulation movements? On the nascent body plan? On which tissues develop within the embryo?

* Note, this treatment requires that embryos are dechorionated.

* **All solutions and tips should be collected as hazardous waste as we are required to do.** LD50 (Mouse) =12 mg/kg. (LD50 for 50 kg mouse is 600mg or 0.6 g).

1. Distribute 0.25 mL of 1% agarose in 0.3x Danieau (1.8 mM Ca^{2+}, provided) to coat the bottom of 3 wells of 24 well plate, which is in a secondary container, like a tray. Allow to set.

2. Distribute 0.75 mL of 0.3x Danieau (1.8 mM Ca^{2+}) solution to each well (this brings the total volume to 1 mL).

3. Dechorionate ~30 embryos, then add ~10 embryos per well, letting them fall into the solution from the pipette.

4. Add 5 µL of 10 mM SB505124 stock in DMSO (provided) to one well of embryos any time before 4 hpf, pipette up and down and swirl very gently to mix (final working
concentration will be 50 µM).

5. Add 5 µL DMSO to a second well of embryos as a control group

6. Add 5 µL of SB505124 stock to the third well of embryos at a time point of your choice: I recommend somewhere between 5-6 hpf, so you will need to do this quickly after lunch before afternoon lab starts.

7. Incubate at 28.5 C overnight. Examine the progress of development when you can throughout the day, especially at late gastrulation stages (8-10 hpf). Also check them at 24 hpf tomorrow. Compare to mutant embryos below… any similarities?

**Examination of mutant phenotypes**

If our fish cooperate, we have three different mutants to examine: *knypek* (*kny*) and maternal zygotic *one eyed pinhead* (*MZoep*), which we will examine at gastrulation stages. Observe them carefully under the microscope, compare them to their siblings, and answer the following questions:

1. Are any tissues missing from *knypek* mutants? If so, which ones?
2. In what other ways do these mutants differ from their siblings at 24hpf?
3. How do MZoep mutants look different from WT? What do you think is the morphogenetic basis of these differences?
4. Any guesses as to what genes, pathways, or processes are disrupted in these mutants?

**Solutions**

**Danieau Buffer**

0.3 x Danieau medium:
- 17 mM NaCl
- 2 mM KCl
- 0.12 mM MgSO4
- 1.8 mM Ca(NO₃)₂
- 1.5 mM HEPES, pH 7.6 which forms a pH of 7.6 without adjustment

*I love this name, but the numbering is confusing (0.3x is 30%). To be clear, we will indicate Ca²⁺ molarity. The working stock for most applications is 0.3x or 30% Danieau (1.8mM Ca²⁺);
*For performing surgery or dechorionating very young embryos with Pronase, use 1x which is 100% (5.4 mM Ca²⁺) Danieau Buffer;
*A concentrated stock of 10x version, so 3x Danieau (18mM Ca²⁺), can be autoclaved for sterile use and longer storage.

**50 mM SB 505124 solution in DMSO**

5mg SB505124
1.5 mL 100% DMSO

**10 mg/mL nocodazole solution**

2mg of nocodazole
200 µL of 100% DMSO

2% MethylCellulose
2 g Methylcellulose
100 mL of 0.3x Danieau Buffer (i.e., 1.8 mM Ca	extsuperscript{2+}).
*Don't heat Methylcellulose as it will become MORE dense (think molecular gastronomy's hot ice cream);
*Expect to rock this material for 4 days at 4C. Inspect and shake several times;
*Even after it looks dissolved uniformly, there may still be a few undissolved particles which will be visible under microscope and can be disturbing on your images or movies. Centrifugation of the aliquots in 1.5 mL Eppendorf tubes at high speed would help get rid of most of them;
*2% Methylcellulose is very dense and will hold embryos reasonably well for time lapse, but it will allow you to turn the embryo if needed;
*Lower percentage Methylcellulose can be used with a trade off in terms of stability for ease of movement.

Notes:
We need about 5 µL of nocodazole (10 mg/mL) and 20 µL of SB505124 (10 mM) per group. Last year we had 10 student groups, so a total of 50-60 µL of nocodazole (10 mg/mL) and 200-250µl of SB505124 (10 mM) should be sufficient.
1- INTRODUCTION

Throughout this course, you will learn advantages of zebrafish in studying multiple aspects of biology, focusing on embryonic and larval stages. With the emergence of sophisticated molecular genetic tools, the adult stage is being studied by an increasing number of labs. For example, zebrafish can regenerate a wide array of organs and appendages after injury, making them a unique vertebrate model for genetic analysis of tissue regeneration.

Conceptual and mechanistic studies of heart regeneration in adult zebrafish helped establish a robust field of cardiac repair that extends to many species including mammals. This section provides an introduction to adult zebrafish anatomy and models of tissue regeneration – in particular we focus on surgical resection of the cardiac ventricle.

This lab will be divided into three parts:

1- Dissection of adult zebrafish organs
2- Resection of the adult cardiac ventricle and amputation of the adult caudal fin
3- Imaging tissue regeneration –
   Amputated fins will be imaged at 5 & 8 days post-amputation.
   Resected ventricles will be dissected and imaged by whole mount at 12 days post-injury.
II- MATERIALS AND PRE-SURGERY PREPARATION

1- Prepare the surgery area and lay out the needed tools
   2 pairs of fine forceps
   2 pairs of iridectomy scissors (1 straight and 1 curved)
   Tricaine solution for anesthetizing fish
   A finger bowl for tricaine solution
   PBS for adult tissue dissection
   Petri dishes for PBS
   1 tank of fresh fish water to recover fish post-surgery
   Fish net
   Sponge
   Razor blade
   Lab tape
   Plastic spoon
   Pipette
   Kim wipes

2- Fish:
   EK fish: Adult tissue dissection
   Tg(tcf21:DsRed2; cmic2:EGFP) fish: Ventricular resection surgery.

3- Prepare sponge:
   Use a razor blade to cut the sponge, which will be used to hold a fish upside down

III- ADULT ZEBRAFISH DISSECTION

Male dissection
In this section we will use a male EK strain fish to dissect out testes, heart, and brain.

1- Euthanize one male fish in Tricaine solution for ~5 minutes until gilling movements have stopped for a few minutes.

   Place the fish upside down (ventral side up) in the pre-cut sponge.

2- Start by the cutting the skin starting at the level of the anal fin and cutting rostrally towards the gills. Use 2 pairs of forceps to open up the fish and remove the internal organs.
3- Removing the internal organs will expose the testes. These are long, white, Y-shaped organs that are attached to the dorsal body wall. Use your forceps to detach the testes from the body wall at the three attachment points (marked in the figure below by red arrows).

4- Remove the testes and place them in PBS. Examine the testes under the microscope to the seminiferous tubules.

5- Return to the male fish to dissect the heart next. Using 2 pairs of forceps, tease apart the skin and silvery pericardial sac the cover the heart. This will expose the cardiac bulbus arteriosus (or outflow tract), ventricle, and atrium. Dissect the heart out by detaching the bulbous arteriosus and place in PBS. Observe the cardiac chambers under the microscope.

6- Finish the dissection of the male fish by dissecting the brain. Cut off the head of the fish using a razor blade and place on a small petri dish wrapped with kim wipe. Fix the head upside down at the level of the eyes with one pair of forceps. Using another pair of forceps, remove the soft tissue that covers the ventral side of the skull and then remove the eyes. Use small scissors to carefully cut the bone from the ventral side of the brain and expose the brain with a pair of forceps. Place the head in PBS and separate the brain from what is left of the dorsal skull.
Female dissection
In this section we will use a female EK strain fish to dissect out ovaries and gastrointestinal organs.

1- For female dissection, you have the choice of using a pre-cut sponge or a small petri dish wrapped with kim wipe. Alternatively a dissection mat could be used.

2- Euthanize one female fish in Tricaine solution.

3- Place the fish on its side on the dissecting mat.

4- Cut the skin and underlying muscle on the belly of the fish, between the operculum (that covers the gills) and the anal fin (as marked by dashed line below). This will expose the ovaries and parts of the internal organs.

5- Collect the ovaries in PBS and observe under the microscope. Removing the left ovaries will fully expose the internal organs. Begin to identify the swim bladders, liver, and intestine.

6- Using a pair of forceps, detach the internal organs at the anal level (as shown in the figure below). Transfer the internal organs into PBS.
7- Dissect and examine:
   a large, lobed, highly vascularized liver,
   a three-part intestine (dissociating the anterior, mid, and posterior regions),
   a tube-like pancreas that runs along the intestine,
   a translucent greenish gallbladder,
   and a bright red spleen.
IV- ZEBRAFISH VENTRICULAR RESECTION SURGERY

Pre-surgery

1- Fish: In this section, we will use Tg(tcf21:DsRed2; cmhc2:EGFP) fish to practice ventricular resection. This double transgenic fish has epicardial cells labeled with DsRed and cardiomyocytes labeled with EGFP.

2- Wet the sponge with fish water and place under the dissecting microscope.

3- Place 1 fish at a time in Tricaine solution. Wait for the fish to be deeply anaesthetized. Watch as the gill movement slows down. Transfer the fish with a plastic spoon to the pre-cut, moist sponge.

Surgery

4- Place the fish upside down and hold it steady with forceps (using non-dominant hand). Locate the posterior medial margin of the heart.

5- Use the straight iridectomy scissors to puncture the skin and silvery pericardial sac. In order to do this without damaging the heart, aim the point of scissors anterolaterally at a shallow angle. You should be able to do this without inducing any bleeding. If the fish is bleeding profusely before you cut the heart, you may have punctured the heart or a major blood vessel that is located at the junction of the pericardium and the peritoneum.

6- Make an incision through both the skin and pericardium equal in length to about 2/3 that of the heart ventricle by cutting straight anteriorly. Do not cut through the bony brachial apparatus or the fish will bleed to death.

7- Spread the incision open laterally using forceps and use the curved surface of the curved iridectomy scissors to press gently on the fish’s belly approximately 5 mm posterior to the heart incision. This should cause the apex of the ventricle to protrude through the incision.

8- When the apex of the ventricle protrudes ventrally through the incision, slip the scissors...
around the ventricle and cut off a small chunk of the apex. The chunk should be big enough so that the lumen is penetrated, and you should see blood escaping the lumen rapidly for a brief moment before the heart slips back into the incision. If you remove greater than ~ 25% of the ventricle the fish will not survive. Make sure to remove the chunk from the animal.

9- Bleeding should be initially profuse, but a clot should begin to form within ~15 - 45 seconds after the cut. Blot the incision gently with a dry Kimwipe to prevent blood from getting into the gills and to stimulate clotting.

**Post-surgery**

10- Once a clot has formed, put the fish into the recovery tank.

11- Squirt water over the gills vigorously with a pipette until the fish starts regular gill movement is recovered or until the fish starts swimming.

12- Practice the surgery on a number of wild-type animals.

13- Proceed to injure transgenic animals harboring epicardial, cardiomyocyte, and vascular endothelial reporter cassettes. Keep 2-3 injured, transgenic animals to regenerate for ~12 days.

14- At 12 days post injury, dissect the heart, collect into PBS, and image the regenerating hearts in whole mount. Check that the apex of the cardiac ventricle was properly resected.
## V- Schedule

### August 6, 2019

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>13:45 – 14:15</td>
<td>Pit talk - Ken Poss</td>
<td>Adult dissection</td>
</tr>
<tr>
<td>14:15 – 14:45</td>
<td>Adult dissection demonstration</td>
<td>Dissection by Ken Poss and Fei Sun</td>
</tr>
<tr>
<td></td>
<td>EK Male – Testes, heart, and brain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EK Female – Ovaries, intestine, spleen, liver, bladder, and kidneys</td>
<td></td>
</tr>
<tr>
<td>14:45 – 15:30</td>
<td>Student dissections</td>
<td>1 student per station</td>
</tr>
<tr>
<td></td>
<td>Each student dissects 1 Male EK and 1 Female EK fish</td>
<td></td>
</tr>
<tr>
<td>15:30 – 16:15</td>
<td>Heart injury demonstration</td>
<td>Protocol for adult cardiac resection and fin amputation by Ken Poss and Fei Sun</td>
</tr>
<tr>
<td>16:15 – 17:30</td>
<td>Student surgeries</td>
<td>2 students per station</td>
</tr>
<tr>
<td></td>
<td>Fin amputation: $Tg(osx:mCherry; fli1:EGFP)$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Heart resection: $Tg(tcf21:DsRed2; cmlc2:EGFP)$</td>
<td>One on one practice with Ken Poss and Fei Sun</td>
</tr>
<tr>
<td>17:30 – 18:00</td>
<td>Analysis discussion</td>
<td>Whole mount examination of resected ventricles and amputated fins</td>
</tr>
</tbody>
</table>

### August 12, 2018

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>22:30 – 23:30</td>
<td>Imaging regeneration</td>
<td>Analyze regenerating fins</td>
</tr>
<tr>
<td></td>
<td>$Tg(osx:mCherry; fli1:EGFP)$</td>
<td></td>
</tr>
</tbody>
</table>

### August 14, 2018

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>13:30 – 16:00</td>
<td>Imaging regeneration</td>
<td>Imaging regenerating fins</td>
</tr>
<tr>
<td></td>
<td>$Tg(osx:mCherry; fli1:EGFP)$</td>
<td></td>
</tr>
</tbody>
</table>

### August 17, 2018

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 – 12:00</td>
<td>Imaging regeneration</td>
<td>Euthanize animals and collect regenerating hearts.</td>
</tr>
<tr>
<td></td>
<td>Whole mount imaging and analysis.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$Tg(tcf21:DsRed2; cmlc2:EGFP)$</td>
<td></td>
</tr>
</tbody>
</table>
Hands-on microscopy and imaging:
Fluorescent dissecting microscopes and compound microscopes

Instructors: Andres Collazo, Jim Fadool, David Raible, and Debbie Yelon

In this pair of sessions, you will become familiar with the fluorescent dissecting microscopes and the fluorescent compound microscopes that you will use throughout the course. In addition to learning best practices for use and maintenance of these microscopes, you will be introduced to their associated cameras and image capture software. Finally, these sessions will also cover key landmarks in larval anatomy.

Specific topics will include:

- Basic microscope control:
  - Turning it on
  - Microscope and condenser focus
  - Field diaphragm operation
  - Touchpad controls

- Köhler illumination

- DIC

- Fluorescence

- Software tools for acquisition:
  - Channels
  - Camera exposure
  - Illumination intensity
  - Z-stack
  - Time-lapse

- Software tools for processing:
  - Orthogonal projection
  - Extended depth of focus

- Notable anatomical features:
  - 24 hpf: neural crest, notochord, floorplate, hatching gland, trigeminal ganglion, otic vesicle, brain subdivisions
  - 36 hpf: lateral line primordium, pharyngeal arches, pectoral fin
  - 4 dpf: jaw cartilages, gut, pronephros, fin fold
Magnification

Objective magnification X Eyepiece Magnification

Stereo microscope versus Compound microscope

1. Stereo has two light paths offset at a slight angle (~12°)
2. Compound microscope has single light path.
   (a) Upright
   (b) Inverted

Resolution

\[ R = \frac{1.2 \times \lambda}{\text{NA}_{\text{obj}} + \text{NA}_{\text{cond}}} \]

Electromagnetic spectrum

http://www4.nau.edu/microanalysis/Microprobe/Xray-Spectrum.html

Setting up Koehler Illumination

Transmitted light

Contrast

- Histological stains
- Fluorescence
  - Stokes shift

Fluorescence and Scanning Laser Confocal Microscopy

Comparisons of the light paths of typical fluorescence microscopy (A) with laser scanning confocal microscopy (B). (A) Fluorescence microscopy typically uses some type of broad-spectrum bulb for a light source (1). The light (dotted line) passes through an excitation filter (Ex) that restricts the wavelength and is reflected to the specimen (Spec), through an objective (2) by a dichroic beam splitter (Di). The light emitted by the specimen (dashed line) passes through an objective (2), the Di and an emission filter (Em) until it reaches the eye of the observer (3) or a camera. (B) Confocal microscopy uses a laser as a light source (1a) which is scanned across the specimen (Spec) by a motorized mirror (1b). Laser light (dotted line) may or may not pass through an excitation filter (Ex). Light is reflected to the specimen, through an objective (2) by a Di. Light emitted by the specimen (dashed line) passes through an objective (2), a Di, an Em and the pinhole aperture (Pin). Unlike what is shown, the Em is commonly located after the Pin. Emitted light is detected by a photo multiplier tube (PMT) (3a) and images are reconstructed by computer (3b).

Useful Reference

Resolution (the minimum distance between two objects that allows them to be distinguished as separate) and contrast are the two often conflicting goals of any imaging experiment. Different imaging techniques provide different advantages and disadvantages. Magnetic resonance imaging (MRI) can be used in vivo but the resolution is relatively poor, 1 mm for clinical machines and 10 microns for the best research instruments. Electron microscopy (transmission, TEM, more than scanning, SEM) provides the best resolution (Angstroms, 0.1 nanometers) but it can only be used with fixed tissues. Most of what we will talk about is light microscopy. The most common wavelengths are the visible spectrum from 400 to 700 nanometers. We will be concentrating on imaging with these visible wavelengths. Brightfield images are looking at all these wavelengths while fluorescence images look at a limited range of wavelengths (i.e. blue, green or red). Fluorescence microscopy is usually monochromatic so black and white cameras are perfect for such applications.

Cameras: Analog vs. Digital. Most cameras used for image acquisition today are digital. Even many analog cameras (such as camcorders) acquire the image digitally then convert it to analog for viewing on video monitors. Most digital cameras and camcorders acquire images with CCD’s (charge-coupled devices) which are rectangular silicon chips with their point light detectors arranged in columns and rows (i.e. 1200 x 1000).

Imaging Software: There are many imaging software packages. These software packages are used mainly for morphometric analysis, image acquisition with a camera, and control of microscopes, X-Y stages and shutters. Almost all are PC based though there are some good Mac ones as well (for example Openlab from Improvision, http://www.improvision.com). We will be mainly showing you two packages that are restricted to the PC. Metamorph from Molecular Devices (http://www.moleculardevices.com/pages/software/metamorph.html) and the Axiovision software from Zeiss (http://www.zeiss.com/us/).

Labeling techniques for following cells during development:

<table>
<thead>
<tr>
<th>Technique</th>
<th>Ease of Labeling</th>
<th>Initial position and time of labeling</th>
<th>Dilution</th>
<th>Single cell lineage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrovirus</td>
<td>++++</td>
<td>-</td>
<td>++++</td>
<td>+++</td>
</tr>
<tr>
<td>Lipophilic dye (i.e. Dil)</td>
<td>++++</td>
<td>+++</td>
<td>++</td>
<td>+</td>
</tr>
<tr>
<td>Dextran</td>
<td>+++</td>
<td>+++</td>
<td>++</td>
<td>+++</td>
</tr>
<tr>
<td>GFP and ilk Transgenics</td>
<td>+++</td>
<td>+++</td>
<td>+++</td>
<td>++</td>
</tr>
<tr>
<td>GFP and ilk Electroporation</td>
<td>+++</td>
<td>+</td>
<td>+++</td>
<td>++</td>
</tr>
<tr>
<td>Homotypic grafting</td>
<td>+</td>
<td>+++</td>
<td>++</td>
<td>+</td>
</tr>
<tr>
<td>Photo-convertible proteins</td>
<td>+++</td>
<td>+++</td>
<td>++</td>
<td>+++</td>
</tr>
</tbody>
</table>
Dil or DiD labeling. Both stocks are at a concentration of 0.1 or 1% in Ethanol which are then diluted 1 to 10 in 0.3 M Sucrose, both heated to about 37 degrees C°. Back fill needles with 5 microliters of solution which is more than you need but it keeps the dye from evaporating and precipitating.

How much does it all cost?

<table>
<thead>
<tr>
<th>Item</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good digital Camera</td>
<td>$19,000.00</td>
</tr>
<tr>
<td>Computer Software (upper end)</td>
<td>12,000.00</td>
</tr>
<tr>
<td>Computer</td>
<td>3,000.00</td>
</tr>
<tr>
<td>X-Y Stage</td>
<td>20,000.00</td>
</tr>
<tr>
<td>Compound Microscope</td>
<td></td>
</tr>
<tr>
<td>With good objectives, fluorescence and D.I.C.</td>
<td>85,000.00</td>
</tr>
<tr>
<td>Grand total</td>
<td>$139,000.00</td>
</tr>
</tbody>
</table>
Light sheet microscopy: sample mounting and imaging

Michael Weber, Anjalie Schlaeppi, Alyssa Graves, Jan Huiskens
Jan Huiskens: JHuiskens@morgridge.org
Anjalie Schlaeppi: ASchlaeppi@morgridge.org

AIM

Our goal is to give you a hands-on introduction to light sheet microscopy with our traveling microscope, the Flamingo. In his lecture, Jan will explain light sheet microscopy, show data recorded with our light sheet systems and discuss when light sheet microscopy is the ideal choice. We hope this will be an informative discussion about the challenges and possibilities offered by light sheet microscopy. During the hands-on session, you will learn how to set up a long term imaging experiment. We will explain and practice how to mount zebrafish embryos for light sheet imaging and we will acquire data on our Flamingo.

LIGHT SHEET MICROSCOPY

The principle of light sheet microscopy – also known as selective plane illumination microscopy (SPIM) – is to illuminate the sample from the side in the focal plane of the detection objective. The illumination and the detection path are distinct and perpendicular to each other. The sample is placed at the intersection of the illumination and the detection axes. The light sheet excites the sample in a thin volume around the focal plane and the emitted fluorescence is collected by the detection optics.

Light sheet principle. Fluorescence excitation (blue arrow) and detection (green arrow) are split into two distinct optical paths. Many different implementations of this principle exist.
The Flamingo is our shareable, modular light sheet microscope. It is configurable to suit a broad range of applications and perfectly suited for imaging live samples such as fruit fly embryos, zebrafish embryos and larvae, organoids, spheroids, worms, tissue sections and many more. Find out more at involv3d.org/flamingo and follow us at twitter.com/getinvolv3d. We have brought one of our Flamingo instruments to the course and you get to see how it is built and how it works.
MEDIA

- Appropriate medium for the specimen of choice, e.g. E3 for zebrafish
- Low gelling temperature agarose
- Methyl cellulose (optional)

CAPILLARIES & PLUNGERS

Glass capillaries shape the agarose cylinder and should be considered disposables. Matching plungers are required to take up samples in liquid agarose into the glass capillaries and can typically be reused. Both are spare parts for the Brand Transferpettor pipette.

<table>
<thead>
<tr>
<th>Color</th>
<th>Diameter (inner / outer)</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>white</td>
<td>tbd</td>
<td>Worm embryos</td>
</tr>
<tr>
<td>orange</td>
<td>0.6 / 1.2 mm</td>
<td>Drosophila embryos, adult worms</td>
</tr>
<tr>
<td>black</td>
<td>1.0 / 1.5 mm</td>
<td>Zebrafish embryos/larvae (dechorionated)</td>
</tr>
<tr>
<td>green</td>
<td>1.5 / 2.0 mm</td>
<td>Zebrafish embryos in chorion</td>
</tr>
<tr>
<td>blue</td>
<td>tbd</td>
<td>tbd</td>
</tr>
</tbody>
</table>
FEP TUBES

Fluorinated ethylene propylene (FEP) is a transparent polymer with a refractive index similar to water, which makes it a great material for imaging live samples. The right tube diameter is determined by the specimen. For zebrafish 0-5 dpf, we use either 0.8 x 1.6 mm (thick walls for increased rigidity) or 0.8 x 1.2 mm (thin walls for imaging). Good tube sizes for bigger samples are 1.6 x 2.4 mm and 2 x 3 mm.

A 1 ml plastic syringe with an injection needle is a convenient tool to take up samples into an FEP tube. Syringe needles come in different sizes with the outer diameter expressed in Gauge. This needs to match the tube’s inner diameter. Alternatively, especially for wider tubes, use a standard pipette and a matching plastic tip.

<table>
<thead>
<tr>
<th>Diameter</th>
<th>Wall thickness</th>
<th>Applications</th>
<th>Needle Gauge</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8 / 1.2 mm</td>
<td>200 µm</td>
<td>Zebrafish embryos/larvae (dechorionated)</td>
<td>21</td>
</tr>
<tr>
<td>0.8 / 1.6 mm</td>
<td>400 µm</td>
<td>Zebrafish embryos/larvae (dechorionated)</td>
<td>21</td>
</tr>
<tr>
<td>1.6 / 2.4 mm</td>
<td>400 µm</td>
<td>tbd</td>
<td>16</td>
</tr>
<tr>
<td>2 / 3 mm</td>
<td>500 µm</td>
<td>tbd</td>
<td>14</td>
</tr>
</tbody>
</table>

MOUNTING FOR L/T/X CONFIGURATION

There are numerous techniques of mounting samples for the L, T and X configurations. Here, we describe three distinct strategies: First, mounting in a free-hanging agarose cylinder (left). Second, mounting in an FEP tube, either in solid agarose (center) or in low-concentration agarose (right).
MOUNTING IN FREE-HANGING AGAROSE CYLINDER

- Melt 1.5% agar, keep it at 37°C.
- Treat samples with tricaine.
- Put the plunger in the glass capillary such that the white end barely comes out of the capillary.
- Put the sample in agar, with as little water as possible.
- Take up about 3cm (1”) of agar in the capillary by pulling the plunger.
- Take up the fish, head down. Keep the fish close to the end of the tube.
- Let agar set 1-2 minutes and transfer into a 12ml falcon with tricaine E3. Be careful not to move the plunger or the fish might be released.
- Once you are at the microscope and ready to image, push the plunger down such that the fish is just outside the capillary.

MOUNTING IN FEP TUBE

- Prepare a petri dish coated with a thin layer (1-2mm) of 1.5-5% agar.
- Melt 0.1% agar, keep it at 37°C.
- Treat samples with tricaine.
- Cut the clean and straightened FEP tube to the desired length with a razor blade.
- Mount the FEP tube on the blunt end needle.
- Place the sample in agar with as little extra medium as possible.
- Fill the FEP tube with agar first, then take up the fish, head down. Keep the fish close to the end of the tube.
- Carefully stick the FEP tube into the agar coated dish at a 90° angle. Avoid bubbles between plug and agar. Rotate the tube and take it out.
- Check by eye or stereoscope that there is an agar plug at the end of your FEP tube. If there is no plug, repeat the previous step.
- Cut the FEP tube at the edge of the blunt end needle.
- Transfer FEP tube into an Eppendorf tube with tricaine E3 until ready to image.

You can also take up the fish in 1.2-1.5% agar and not use the plug. The FEP tube will provide additional stability. However, keeping the developing fish in solid agar will impair its development. We recommend using 0.1% agar and a plug for imaging for more than one hour.

LITERATURE

- Weber & Huisken, Current Opinion in Genetics & Development 2011: *Light sheet microscopy for real-time developmental biology*
- Kaufmann, Mickoleit, Weber & Huisken, Development 2012: *Multilayer mounting enables long-term imaging of zebrafish development in a light sheet microscope*
- Weber, Mickoleit & Huisken, Jove 2013: *Multilayer Mounting for Long-term Light Sheet Microscopy of Zebrafish*
Egg Microinjection Technique and Morpholinos
M. Mullins, Zebrafish Course, August 2019

I. Introduction

To investigate the role of a gene during development, overexpression or misexpression of your gene of interest is a quick assay. You can inject mRNA or DNA of the wild-type gene or a constitutively active form of the gene to investigate its gain-of-function phenotype. To investigate its pseudo “loss-of-function”, you can inject various mutant forms such as dominant-negatives. You can also “knock down” a gene using a morpholino antisense oligo (Nasevicius, A. and Ekker, S.C., 2000. Effective targeted gene 'knockdown' in zebrafish. Nat Genet. Vol. 26, pp. 216-20).

In this lab, we will assay the effects of overexpression of BMP pathway components by injecting mRNA into the yolk through the chorion. We will inject morpholino oligos into the yolk to knockdown components of the BMP pathway and rescue these “morphants” by double injection of mRNA encoding the component, but not containing the morpholino binding site.

II. Materials

A. mRNA encoding Your Favorite Gene

B. 0.5% phenol red in DPBS (Sigma, cat. no. P-0290)

C. 0.1M KCl

D. 1X E3 medium
   5 mM NaCl
   0.17 mM KCl
   0.33 mM CaCl2
   0.33 mM MgSO4
   We make up the E3 as a 60X stock solution. When making the 1X E3, add 20 microliters 0.03 M Methylene Blue (prevents fungal growth) per 1L of 1X E3.

E. E3 medium/1% agarose dishes with furrows to hold embryos in place (described in the Zebrafish Book). Molds to make injection wells (6-well zebrafish injection molds, $35.00 in 2011, Adaptive Science Tools, 31 Gifford Drive, Worcester, MA 01606-3535 USA, Phone (774) 239-6133, Inject@AdaptiveScienceTools.com).

F. 1mm capillary tubes with filaments (World Precision Instruments, Sarasota, FL: cat. no TW100F-4)

G. Pipetman and sequencing gel loading tips (Denville Scientific cat. no P3111, Eppendorf tips, Round Orifice, 60mm x 0.2mm diam. (Fits 0.23mm openings)

H. Dumont #5 watchmaker forceps (older ones are not as sharp and will be less damaging to embryos)
I. 1 x 0.01 mm Stage micrometer for droplet calibration (Fisher, cat. no. 12-561-SM1; cheaper $10 micrometers from AmScope, catalogue number SKU:MR95; also can now be found on Amazon)

J. Halocarbon Oil Series 27 (Sigma, cat. no. H8773)

K. Glass or plastic pipet for embryo transfer

L. 10 cm petri dishes for embryos after injection

III. Preparation of RNA and Needles

A. **RNA synthesis:** We use the Ambion mMessage kit (cat. no. 1340) to synthesize *in vitro* capped mRNA. This RNA can then be diluted in 0.1 M KCl and phenol red. We generally dilute the RNA to a 1 in 5 dilution, which can then be further diluted to titrate the RNA. Morpholinos are treated differently. Please see section VI for details.

B. **RNA titration:** Every batch of *in vitro* transcribed mRNA must be titrated, even if the concentration looks similar on a gel or spectrophotometrically. The activity of the RNA can vary due to different efficiencies of the capping reaction. If you intend to use a particular RNA a lot, it is a good idea to transcribe several batches at once and mix them together, then titrate the mixture. Aliquot the RNA in small quantities (3-5 µl) and store at –80°C. Frequent freeze/thaw can result in mRNA degradation and loss of activity.

C. **Injection needles:** We make our needles from capillaries with an internal filament. The filament allows for efficient wicking of the nucleic acid solution to the tip of the needle following backfilling (see below). Establishing the correct settings on the needle puller is important in making a good needle. Needles with a long shank tend to break more easily and can bend on, rather than penetrate, the chorion. Needles with a short shank are sturdier and don’t break as easily, but can be damaging to the embryos as they tend to thicken quite quickly. Needles somewhere in between tend to give the best results. **A GOOD NEEDLE IS KEY TO THIS TECHNIQUE.**

IV. Preparing to Inject

(i) When setting up fish crosses the evening before injections, it is advantageous to separate the male and female in a box. Once you have the needle loaded and are ready to inject, you put a couple boxes of fish together and watch for them to lay eggs. This ensures that you have single-cell stage eggs to inject. After you have injected this batch of eggs, you can put a few more pairs of fish together and then inject more eggs at the one-cell stage etc.

(ii) We perform injections in a room cooled to 20°C to slow development, which prolongs the length of time that single-cell stage eggs can be injected. *However*, extended exposure to low temperature can result in ventralized embryos (via destabilization of microtubule-mediated transport of dorsal determinants), so when finished injecting, move your embryos to a warmer temperature.
A. **Switch on the microinjector and open the pressure valve.**
   Set the injection pressure between 10 and 20 psi. The balance pressure should be 0.2-0.4 psi to prevent medium from flowing back into the needle and diluting your RNA or introducing contamination. If the back pressure is too high, then the RNA will flow constantly out of the needle resulting in RNA loss and the inability to accurately determine the amount of RNA injected.

B. **Backfilling the needle**
   1. Spin RNA/DNA/morpholino before loading it into the needle, so particles that could clog the needle are in a pellet
   2. One can use sequencing gel loading tips (that have a long thin tip) to load the RNA. These tips fit inside the back of the needle, and the RNA flows to the tip by capillary action. Regular pipet tips can also be used.
   3. Place the needle on a vertical mound of clay for loading. By not holding the needle, you prevent the air between the RNA and the closed tip from expanding and expelling your RNA from the back of the needle. It also helps to load at least 1 µl of RNA. It is important to keep the meniscus of the liquid in the needle above the tapering of the needle. This prevents inflow of the E3 media by capillary action.
   4. When the RNA has migrated to the tip, introduce the needle into the needle holder on the micromanipulator.

C. **Breaking the needle**
   1. Needles can be broken either in the air or in the E3 medium.
   2. Using the highest magnification on your dissecting scope, gently scrape the tip of the needle with clean forceps. Only a very small amount of the tip needs to be broken.
   3. Press the injection pedal to be sure that the tip has been broken and RNA can flow out of the needle.

D. **Calibrating the needle to estimate the amount injecting.** Before injecting the RNA, we calibrate the volume to inject by measuring the droplet size.
   1. Clean the calibration micrometer slide with EtOH and put a drop of halocarbon oil on it.
   2. Put calibration slide on upside-down petrie dish lid, so that you do not have to adjust the micromanipulator position before and after, or change greatly the focal plane from that used for injection. Focus the microscope at 5X magnification on the level of the calibration slide to see the scale, which divides 1 mm into 100 units.
      a. For the best distribution of RNA in the 1-cell embryo, a volume of 2 nl should be used.
      b. For single blastomere injections at later stages (4, 8, 16 cell, etc), the injection volume should be decreased in a similar manner. These cells are smaller and cannot take up such a large volume without being damaged.
   3. Press the footpedal to observe the size of the drop in the oil. The drop should hang in the oil to form a perfect sphere. If the drop falls and spreads out on the slide, use a larger volume of oil to create a thicker layer. A slight increase in diameter
changes the volume by the third power. Thus, a 0.13 mm sphere already has twice the volume of a 0.1 mm sphere! (Volume of a sphere = \(\frac{4}{3}\pi r^3\)). See attached calibration table for a quick estimate of how droplet diameter corresponds to volume.

4. By changing the injection pressure or time, you can change the volume. If you are having trouble obtaining larger volumes, you can clip a little more off the end of the needle and then recalibrate the needle. Remember, needles that are too thick (too short) damage the embryo and reduce survival!

5. If the needle should break, recalibrate the droplet size to ensure a consistent volume is injected in all embryos.

E. **Submerge** the tip of your needle into the E3 medium in the injection plate to prevent drying out of the RNA at the tip and clogging the needle. You are now ready to inject!

V. **Injection**

A. **Magnification:** For injection, change the setting on your microscope to 1.2X or 1.6X magnification

B. **Organize embryos**

1. In setting up crosses for embryo injection, we keep the male separated from the female either by using a mating box that contains a divider, or by placing the male below the mating insert and female inside the mating insert. Only after the needle is loaded and calibrated do we put the fish together (e.g. remove the divider) to allow them to mate. We then watch and wait for eggs to be laid.

2. Move your needle out of the injection plate and arrange your collected embryos in the troughs of the agar with the transfer pipette and probe.

3. Remove nearly all the E3 medium for injection. **THIS IS VERY IMPORTANT.** This provides surface tension that prevents the embryo/chorion from sticking to the needle when trying to remove it after injection.

C. **Injection into the yolk**

1. Carefully extend the needle through the chorion and into the yolk and press the injection pedal. If the needle is within the yolk, the injected RNA/phenol red will not diffuse immediately. If the needle has extended through the yolk and lies outside of the embryo, the phenol red will diffuse immediately. If the injection is successful, you will see a red spot in the yolk or cytoplasm.
2. RNA is most active when injected directly into the embryonic cell instead of the yolk. However, this requires careful orientation of the embryos, and is more time consuming. RNA injected at the one-cell stage into the yolk will move into the cytoplasm via cytoplasmic streaming and is usually sufficient for most experiments (BUT not for injecting DNA).

3. Once you have mastered yolk injections, you may want to try injecting into the cell. The cell membrane is tougher than the yolk membrane, so we typically enter the needle through the yolk and extend it into the cytoplasm. To do this, you should orient the embryo in the trough such that the animal pole is opposite the needle.

VI. Morpholino Injection

Morpholinos designed to the 5’ UTR or early coding sequences act by blocking translation. Morpholinos can also be designed to overlap splice sites to block splicing (Draper, B. W., Morcos, P. A. & Kimmel, C. B., 2001. Inhibition of zebrafish \textit{fgf}8 pre-mRNA splicing with morpholino oligos: a quantifiable method for gene knockdown. \textit{Genesis}. Vol. 30, pp. 154-6).

The actual injection technique for morpholinos is the same as that for RNA injection into the yolk. However, there are some differences in preparation that we discuss in this section.

A. Preparation

1. Do not dilute morpholinos (MOs) in KCl.
   a. The manufacturer (Gene-Tools) suggests that MO powder be resuspended in sterile water or 1X Danieau solution (58mM NaCl, 0.7mM KCl, 0.4mM MgSO\textsubscript{4}, 0.6 mM Ca(NO\textsubscript{3})\textsubscript{2}, 5.0 mM HEPES pH 7.6).
   b. We resuspend our MOs in sterile Milli-Q water to a concentration of 65 mg/ml (usually around 40 microliters of water).
   c. Aliquot your MO into small volumes to avoid multiple freeze-thawings, which can cause a loss of the MO activity.

2. Once the stock solution is made, MOs are diluted in phenol red and 1X Danieau. Do not attempt to inject the aqueous MO solution, as this can be toxic to the embryo.

3. MOs must also be titrated to determine the lowest amount that is necessary to elicit a specific phenotype. At higher amounts (above 4-10 ng, depending on the MO) morpholinos often cause non-specific effects, such as brain or general cell death.

B. How can you show that a phenotype is the result of knocking down ONLY your gene-of-interest?

1. Common non-specific effects of MOs are a general delay in development and widespread cell death. Even low amounts of MO delay development, so it is important to stage-match control embryos, rather than age-match them. Injecting a control MO (mismatch or Gene Tools control) can control for the developmental delay in embryos.

   A second non-specific effect is cell death, which can be low and transient, frequently restricted to the brain, or widespread causing early lethality. By using a p53 mutant or co-injection of a p53 MO, cell death can be suppressed (Robu ME, Larson JD, Nasevicius A, Beiraghi S, Brenner C, Farber SA, Ekker SC. p53 activation by knockdown technologies. PLoS Genet. 2007 May 25;3(5):e78.). However, extensive cell death is only partially suppressed by loss of p53.
2. You can show that the phenotype is specific by rescuing the phenotype with wild-type mRNA of your gene-of-interest. However, MOs are frequently made to the 5’ UTR of the gene, and this sequence may be included in your in vitro transcribed mRNA. Thus the MO will inhibit the injected RNA as well, and the injected RNA may simply titrate out the MO resulting in “rescue”, but not rescue via expression of the wild-type gene product. To circumvent this problem, mRNA of an orthologue from a different species can be used that does not contain the MO binding site or a construct can be made with a different 5’UTR sequence. We will be rescuing MO phenotypes with the corresponding mRNA from Xenopus or mouse.

3. To do the rescue experiment in a controlled manner, each embryo is injected twice, first with the MO and then with the RNA. In this way, one can be certain that the amount of MO injected is at the appropriate level to cause the phenotype and that the mRNA truly does rescue the morphant phenotype.

   We will inject the morpholino first. Then remove all the MO injected embryos. Place 1/2 back in the trough and inject them with RNA. Compare the phenotype of MO-injected embryos alone to MO + mRNA-injected embryos to determine if rescue has occurred.

4. In some cases, injection of the wild-type mRNA may degrade too early to rescue the late manifesting morphant phenotype or may cause gain-of-function defects even at low doses. The next best control is to design a second MO, not overlapping with the first. If it elicits the same phenotype as the first, then this provides support that the defect is specific to the gene of interest. But strongly consider making a CRISPR or TALEN mutant instead.

5. For translation blocking morpholinos, an additional control should be performed to show that translation of the gene of interest is indeed affected. An antibody to the protein can be used to show that translation is blocked by western blotting. If an antibody is not available, then the typical control is to show that expression of a tagged version of the protein (e.g. myc or Flag tagged), when injected as mRNA into the embryo, is blocked via Western blot analysis.

6. For splice-site blocking morpholinos, RT-PCR should be performed to show that splicing is altered. It is important to sequence the mis-spliced mRNA to be certain that the ORF is sufficiently altered to cause loss of protein function.


VII. Tips and tricks

A. Avoid fast movements when manipulating the needle under the microscope.

B. If the needle gets plugged there are several options, which may help:
   1. Press the clear button.
   2. Scratch very carefully the needle over parafilm or your forceps to try to remove visible debris at the tip.
   3. The last option is to rebreak the tip and recalibrate the needle.

C. You can store your needle with RNA loaded for future use at 4°C in a sealed humid chamber (e.g. a 10 cm petri dish with wet Kleenex or KimWipes around the inside edge and sealed with parafilm). Put the needle on a clay mound in the petri dish to prevent sliding.

D. Agar plates can be reused. Remove all fluid and seal the dish with parafilm and keep in refrigerator. Warm up agar plate prior to injection by adding room temperature E3 to plate.


GOOD LUCK WITH YOUR INJECTIONS!!
Classes of dorsalized phenotypes

Class (C5)
- Lyse during somitogenesis
- All somites circumferential around DV axis

Class 4 (C4)
- No tail
- No blood
- Trunk twists around self

Class 3 (C3)
- No yolk extension
- No blood circulation in tail
- Tail is present, but shortened and twisted

Class 2 (C2)
- No ventral tail vein
- No ventral tail fin
- Tail is present

Class 1 (C1)
- No or reduced ventral tail fin
- Tail and ventral tail vein are present

Fig. 2. Live wild-type and mutant embryos at the 10-somite stage, day 1, and as adults. Lateral view of 1-day old embryos: wild type (A), snh (class 4) (B), pgy (class 3) (C), and laf (class 2) (D). A black arrow marks the midbrain/hindbrain boundary in A and B, and white arrowheads indicate the position of the ventral tail fin in A,D,G,H. An enlargement of part of the tail in a wild-type and a pgy mutant embryo is shown in E,F. The white arrows in E mark the position of the ventral tail vein, which is absent in F. Due to the absence of circulation in pgy mutants, stagnant blood cells are visible (white arrow in F). Tail of a pgy dty40 heterozygote (G) and a homozygote with a weak pgy allele (H), which are representative of class 1 phenotypes. Lateral views of 10-somite stage embryos: wild type (I), swr/+ (class 2; J), laf (class 2; K), and mfn (class 1; L). The black arrowhead in I-L marks the tailbud. Wild-type adults (M) and class 1 mutants as adults (N). Note the absence of the tail fin, partial deletion of the anal fin, and short tail in some adults in N.
Dorsalized and Ventralized at Bud Stage/end of gastrulation

| ventralized MOs BMP antagonists | wild type | dorsalized class 5, bmp7a +/- |
Classes of Ventralized Phenotypes at 1 dpf

**V1**
- Reduced eye and head

**V2**
- No eye
- Severely reduced head
- No notochord
- Expansion of posterior somites
- Enlargement of yolk extension

**V3**
- Loss of head and anterior trunk

**V4**
- Severe enlargement of yolk extension

**V5**
- Only tail tissue present
I. Introduction

I.1) Labelling specific cell types
To investigate a specific population of cells, you need to have an easy way of localizing this population. If the cells in question have a distinct morphology and/or localization in the embryo (e.g. cells of the yolk syncytial layer (YSL), enveloping layer (EVL), developing eye), this might not require specific labelling techniques. However, more often you will want to label a specific subset of cells in the developing embryo to follow their development or to isolate them for further analyses. Labelling can in principle be done in three ways:

1) RNA-based labelling
   Injected mRNA carries elements that cause tissue-restricted expression
   Example: labelling of the germline by 1-cell stage injection of mRNA encoding GFP-nanos-3’UTR (the nanos-3’UTR causes repression of expression in the soma)


   - PRO: it’s fast (in F0s), and in principle all cells will be labelled
   - CON: only works for embryos and early larvae since the injected mRNA will be degraded; only works for cell types which employ a post-transcriptional mechanism to achieve specific expression

2) DNA-based labelling
   2a) Past & present: transgenic expression
      Most commonly, you will use a DNA plasmid containing a cell-type-specific promoter that drives the expression of a fluorescent protein in the cell type of interest. This can be either
      • transient (mosaic): injection of the DNA plasmid together with Tol2 mRNA to integrate the DNA construct in SOME cells; analysis in F0s (injected embryos)
         - PRO: it’s fast (in F0s), and does not require making stable lines
         - CON: not all cells of the specific population will be labelled, and each individual embryo will only have a subset of the full expression domain labelled
      • stable: to generate a stable transgenic line, you grow up the injected F0 embryos with evidence of integration of the plasmid, and screen adult F0s for ‘founders’ with germline integration events to obtain a stable line.
         - PRO: all cells of the expression domain will be labelled; stable line -> reproducible
         - CON: slower since it requires making F1s (to obtain stable heterozygous lines) transmission

   2b) Future: endogenous tagging
      Using CRISPR/Cas9, gRNAs and a donor DNA template (containing the coding sequence of a fluorescent protein flanked by homology arms to the site of integration), integrate the donor DNA template into the locus of a gene that is expressed in the cell type of interest
      - PRO: reflects not only endogenous expression domain but also endogenous expression levels; (might become the ‘golden standard’)
      - CON: it’s laborious, and currently not yet very efficient
I.2) Experimenting with primordial germ cells (PGCs), a model of single cell migration

In this lab, we will use the RNA-based labelling technique to label primordial germ cells (PGC) in the developing embryo. PGCs originate from 4 clusters of localized germ plasm which are already visible at the 4-cell stage at the distal edges of the cleavage furrows. During gastrulation, PGCs start their journey to migrate first dorsally and then animaly. Directed cell migration of PGCs is known to depend on the chemokine receptor Cxcr4b, which is expressed in PGCs, and the chemokine Sdf1a/Cxcl12a, which is expressed in the target tissue.


Labelling of PGCs by GFP-nanos-3’UTR mRNA injection will allow you to follow their migratory path by live-cell imaging and by analyzing their final localization at 24 hpf. Moreover, you will experiment with depleting PGCs by injecting an essential regulator of PGC development, Deadend (Dnd), and with inducing PGC mis-migration phenotypes by depleting Cxcr4b.
II. Experimental approach

II.1) General outline

Note: all embryos will be dechorionated before injection.

This lab has 3 parts:

1) All embryos: injection of **GFP-nanos-3’UTR mRNA** into the yolk of dechorionated embryos
   -> labelling of PGCs

2) In 1/3 of **GFP-nanos-3’UTR mRNA** injected embryos: injection of **dndMO** into the yolk
   You will inject with a separate needle a morpholino targeting **deadend mRNA** (**dndMO**). Deadend is essential for germ cell development and survival, meaning **dndMO**-injected embryos will be depleted of their germline at 24 hpf -> no green germ cells at 24 hpf.

3) In 1/3 of **GFP-nanos-3’UTR mRNA** injected embryos: injection of **cxcr4bMO** into the yolk
   You will inject with a separate needle a morpholino targeting **cxcr4b mRNA** (**cxcr4bMO**). Cxcr4b is the receptor for the chemokine Sdf1a/Cxcl12a, which is essential for directing migrating PGCs to the future gonad. PGCs of **cxcr4bMO**-injected embryos will show random migratory paths in the embryo and fail to localize to the future gonad -> ectopic localization of green germ cells at 24 hpf.

TO DO (Day 1):

You will need to prepare 3 needles

1) **GFP-nanos-3’UTR mRNA**
2) **dndMO** (double-injection: inject into ~1/3 of the embryos injected before with **GFP-nanos-3’UTR mRNA**)
3) **cxcr4b** (double-injection: inject into ~1/3 of the embryos injected before with **GFP-nanos-3’UTR mRNA**)

Inject:

Inject all dechorionated embryos (~30-60) with **GFP-nanos-3’UTR**, and then in a second round of injection inject 1/3 of the already injected embryos with either **dndMO** (10-20 embryos) or **cxcr4bMO** (10-20 embryos)

- Use a glass-pipette to transfer each of the 3 groups of embryos from the injection dish into a well of an agarose-coated 6-well dish (make sure that embryos do not get in contact with air!)
- Label the dish with the date, your name, and what you injected in each of the wells
- Put the dish into an incubator (28°C)

In the afternoon/evening:

Check your plates and remove any debris or dead embryos; students that will get the microscopy introduction on that evening will mount a few embryos for time-lapse imaging over night.

TO DO (Day 2):

Check your embryos under a fluorescent scope:

- Presence of labelled PGCs per embryo in the different treatment groups
- Localization of PGCs (in the gonad? Ectopic localization?)
- For students that did time-laps imaging: process the raw data to obtain movies
Schematic outline of the experiment

Phenotypic scoring at 24 hpf

Wildtype + $GFP$-nanos$3^{\prime}$UTR mRNA

Wild type + $GFP$-nanos$3^{\prime}$UTR mRNA + cxcr4b MO (0.1 mM)
II.2) Materials

A. mRNA encoding **GFP-nanos-3’UTR**

B. 0.5% phenol red in DPBS (Sigma, cat. no. P-0290)

C. 0.1 M KCl

D. 1X E3 medium
   5 mM NaCl
   0.17 mM KCl
   0.33 mM CaCl2
   0.33 mM MgSO4
   We make up the E3 as a 60X stock solution. When making the 1X E3, add 20 microliters 0.03 M Methylene Blue (prevents fungal growth) per 1L of 1X E3.

E. Pronase (10x stock solution (10 mg/ml) in 1x E3 medium);
   We make up a 10x Pronase stock solution by dissolving 500 mg Pronase (Protease from Strep. Griseus; P5147-5G, Sigma-Aldrich) in 50 ml 1x E3 medium and storing 1-ml aliquots at -20 C.

E. Pyrex glass petri dish (Pyrex, 1480/02D) and 250 ml glass beaker (Pyrex, 1000/10D) to dechorionate embryos;

F. 1% agarose dishes (in E3 medium) with furrows to hold embryos in place (described in the Zebrafish Book). Molds to make injection wells (6-well zebrafish injection molds, $35.00 in 2011, Adaptive Science Tools, 31 Gifford Drive, Worcester, MA 01606-3535 USA, Phone (774) 239-6133, Inject@AdaptiveScienceTools.com).

G. 1 mm capillary tubes with filaments (World Precision Instruments, Sarasota, FL: cat. no TW100F-4)

H. Pipetman and sequencing gel loading tips (Denville Scientific cat. no P3111, Eppendorf tips, Round Orifice, 60mm x 0.2mm diam. (fits 0.23mm openings)

I. Dumont #5 watchmaker forceps (older ones are not as sharp and will be less damaging to embryos)

J. 1 x 0.01 mm Stage micrometer for droplet calibration (Fisher, cat. no. 12-561-SM1; cheaper ones can now be found on Amazon)

K. Halocarbon Oil Series 27 (Sigma, cat. no. H8773)

L. Glass pipet for embryo transfer (Pasteur pipette with wide tip)
M. 6-well dishes with 1% agarose (in E3 medium) to keep dechorionated embryos (6-well dishes: Nunc™ Cell-Culture Treated Multidishes, 6-well plates, #140685 Thermo-Scientific).

II.3) Preparation of RNA, MOs and Needles

For this part, please check the general injection guidelines by Mary Mullins

A. RNA
B. MOs
C. Injection needles

II.4) Dechorionation of embryos (we will perform this for you in the course)

NOTE: Dechorionated embryos are fragile – make sure that they are not exposed to air (they will explode), and are submerged in water at all times; they stick to plastic – use only glass-ware (glass pipettes (ideally flamed) and glass dishes) and Agarose-coated 6-well dishes containing E3 medium for handling and storage!

1. Thaw 1 aliquot of 1 ml 10x Pronase stock (10 mg/ml).

2. Pour freshly-laid embryos (within their chorions) into a small Pyrex glass dish. Remove as much water that only ~9 ml remain in the dish (rule of thumb: the Pyrex glass dish is half-full).

3. Add the thawed 1 ml 10x Pronase stock to obtain a 1x Pronase solution (1 mg/ml).

4. Incubate at room temperature for 5 minutes. Don’t stir since dechonrionated embryos are fragile, and embryos that are in the process of losing their chorions (‘pop out’ of the chorion) can easily be damaged. You can check the progress of dechorionation under the stereoscope: blister formation and embryos starting to ‘pop out’ of their chorions means that you can proceed to the next step (usually no longer than 5 minutes incubation needed).

5. Submerge the whole Pyrex dish into a 200 ml beaker filled at least half with E3 medium (be careful that the embryos are always completely submerged in water; do NOT pour the embryos over at this stage since they are likely to break).

6. Wash embryos 3x with blue water: carefully pour out the water containing chorion fragments (but leave a bit of water in their that the embryos are still fully submerged; it helps to keep the beaker tilted all the time), and let E3 medium run down at the side of the beaker to swirl the embryos gently around.

7. Transfer the embryos with a glass pipette (do not use plastic pipettes) to a Pyrex glass dish filled with E3-water or directly into your injection dish (containing E3-water).
II.5) Preparing to Inject

For this part, please check the general injection guidelines by Mary Mullins

A. Switch on the microinjector and open the pressure valve.
B. Backfilling the needle
C. Breaking the needle
D. Calibrating the needle to estimate the amount injecting.
E. Submerge the tip of your needle into the E3 medium in the injection plate

II.6) Injection

For this part, please check the general injection guidelines by Mary Mullins

BUT 1 specific point for injecting dechorionated embryos:

Organize embryos
   1. Move your needle out of the injection plate and arrange your collected embryos in the troughs of the agar with the transfer pipette and probe.
   2. If you inject dechorionated embryos: DO NOT REMOVE the E3 medium! Embryos need to remain submerged in water at all times!

II.7) Tips and tricks

A. Avoid fast movements when manipulating the needle under the microscope.
B. Keep dechorionated embryos submerged in water at all times; use glass pipettes to transfer them, and clean up plates in the evening to remove any debris or dead embryos.
C. If the needle gets plugged there are several options, which may help:
   1. Press the clear button.
   2. Scratch very carefully the needle over parafilm or your forceps to try to remove visible debris at the tip.
   3. The last option is to rebreak the tip and recalibrate the needle.
D. Agar plates can be reused. Remove all fluid, rinse and seal the dish with parafilm and keep in refrigerator. Warm up agar plate prior to injection by adding room temperature E3 to plate.

GOOD LUCK WITH YOUR INJECTIONS!!
CRISPR Design

Helpful Literature; Available in Supplemental Materials

CRISPRscan: designing highly efficient sgRNAs for CRISPR-Cas9 targeting in vivo. Moreno-Mateos et al., 2015. https://doi.org/10.1038/nmeth.3543

Optimized CRISPR-Cas9 System for Genome Editing in Zebrafish. Vejnar et al., 2016. https://doi.org/10.1101/pdb.prot086850

CRISPR-Cpf1 mediates efficient homology-directed repair and temperature-controlled genome editing. Moreno-Mateos et al., 2017. https://doi.org/10.1038/s41467-017-01836-2


Designing and Constructing your sgRNA

Product names and numbers are given at the bottom of this protocol

1) Peruse ENSEMBL and ZFIN for your gene. Get the ENSDARG number, and find which exon you want to target (in a specific ENSDART) that is conserved in the mammalian lineage (confirm in UCSC Genome Browser). Cas9 usually makes deletions in the 5' direction from where it binds.

2) Use the ENSDARG number for analysis in crisprscan.org, or input the sequence of the specific exon(s) you wish to target. In order to address questions about of-target mutations down the road, it is recommended to design two independent gRNAs to establish at least two independent mutant alleles with no possibility of shared off-target sites.

3) CRISPRscan.org will suggest a series of 20bp targets in your target, ranked in order of their predicted efficiency (see PMID: 26322839). In order to provide a 5’GG for optimal T7 polymerase priming for gRNA in vitro synthesis, many of the suggested targets will have a mismatch at the 5’ end (note that this 5’GG requirement is different from the 3’NGG PAM sequence that is absolutely required by Streptococcus pyogenes Cas9 but is not included in the oligonucleotide). Moreno-Mateos et al. (PMID: 26322839) showed that mismatches in the 5’ binding of the sgRNA (other than 5’GG) can be effective at mutagenesis. However consistent with Milligan et al., (PMID:2482430) we have found that while the canonical 5’GG will produce the highest yield in the T7 in vitro transcription reaction; a 5’GA, GT, and GC will all still make enough gRNA for multiple injections and not mismatch the genome. Accordingly, we choose oligos identified by CRISPRscan that introduce a 5’Gg mismatch (where the g introduces a mismatch with the target) but correct the g so that there is no mismatch. Add the T7 polymerase binding sequence to the 5’ side (taatacgactcactata) and the partial gRNA scaffold oligo to the 3’ side (gttttagagctagaa) resulting in (taatacgactcactata N20 gttttagagctagaa). Order this oligo.

4) The 120 bp double-stranded oligo that you will use for synthesizing the sgRNA is generated by overlap PCR using two single-stranded oligos: the Target Oligo designed above and a Scaffold Oligo (aaaacgacccgttcgcaatttttttaacttggtgccacttttaattttctatactctctctaaac) (the red nucleotides are complementary to the Target Oligo scaffold sequence) which you can purchase in bulk as you will use it for every sgRNA synthesis you do (PMID: 24873830). When the Target Oligo comes in, dilute a sample to 10uM with which you will do the first PCR to make the template double-stranded oligo for the in vitro transcription:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>H2O</td>
<td>2.5</td>
</tr>
<tr>
<td>2x Phusion</td>
<td>12.5</td>
</tr>
<tr>
<td>Target Oligo (10µM)</td>
<td>5</td>
</tr>
<tr>
<td>Scaffold Oligo (10µM)</td>
<td>5</td>
</tr>
</tbody>
</table>

98 for 30s
45 cycles of:
98 for 10s
60 for 10s
72 or 15s
72 for 5min

Optionally run 1µL on a gel to make sure this product is made.

5) Clean the DNA using a DNA cleanup kit, eluting in 8µL (Zymo DNA Clean and Concentrator).

6) Quantify the PCR product using a nanodrop or equivalent. It should be around 200-300 ng/µL.

7) Be RNAs free! Use the clean PCR product as the template for the RNA in vitro transcription kit (Megascript T7):

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template (~1µg)</td>
<td>x</td>
</tr>
<tr>
<td>H2O</td>
<td>4-x</td>
</tr>
<tr>
<td>T7 10X Buffer</td>
<td>1</td>
</tr>
<tr>
<td>RNA 2.5X NTP</td>
<td>4</td>
</tr>
<tr>
<td>T7 Enzyme</td>
<td>1</td>
</tr>
</tbody>
</table>
Incubate at 37°C for 3-4 hours (or overnight).

8) Stop the reaction by adding 1µL DNAse and incubating at 37°C for 15 min.

9) Bring the volume to 50µL using RNAse free H₂O.

10) Follow the instructions on the RNA clean kit.

11) Elute in 10-15uL warm (37°C) H₂O.

12) Quantify a diluted sample using the nanodrop or equivalent spectrophotometer.

13) Store at -80°C
Making Cas9 mRNA

Note: Injecting purified nuclear-targeted Cas9 enzyme together with sgRNAs also works well for mutagenesis (PMID: 24873830, 27130213). It can be purchased from various distributors (see below). We estimate protein to cost approximately $3.00 per experiment (1 µg per experiment, provided you don’t break the needle) compared to $1.25 if you make and inject mRNA (not including labor).

1) Linearize a few µg of the Cas9 plasmid:

<table>
<thead>
<tr>
<th></th>
<th>1x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plasmid DNA</td>
<td>x</td>
</tr>
<tr>
<td>CutSmart Buffer</td>
<td>5</td>
</tr>
<tr>
<td>H₂O</td>
<td>43-x</td>
</tr>
<tr>
<td>XbaI Enzyme</td>
<td>2</td>
</tr>
</tbody>
</table>

Incubate at 37°C O/N.

2) Clean the DNA with the DNA clean kit. Eluting in 10µL H₂O.

3) Be RNAse free! Use 1µg of the clean linearized product for the T3 in vitro transcription kit (mMessage mMachine T3):

<table>
<thead>
<tr>
<th></th>
<th>1x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear DNA (1µg)</td>
<td>x</td>
</tr>
<tr>
<td>H₂O</td>
<td>12-x</td>
</tr>
<tr>
<td>T3 10X Buffer</td>
<td>4</td>
</tr>
<tr>
<td>RNA 2X NTP</td>
<td>20</td>
</tr>
<tr>
<td>T3 Enzyme</td>
<td>4</td>
</tr>
</tbody>
</table>

Incubate at 37°C for 2-4 hours or overnight.

4) Stop the reaction with 1µL of DNAse. Incubate at 37°C for 15min.

5) Bring the reaction to 50µL with RNAse free H₂O.

6) Follow the instructions on the RNA clean kit.

7) Elute in 15-20µL warm (37°C) H₂O.

8) Quantify a diluted sample using the nanodrop or equivalent spectrophotometer.

9) Bring the stock to the desired concentration and aliquot in 1µL aliquots in the -80°C.

Product Numbers
mMessage mMachine T3 Kit
Life AM1348M
Megascript T7 kit
Life AM1334M
RNA clean columns
Zymo R1015
DNA clean columns
Zymo D4014
Zebrafish Cas9-encoding plasmid
http://www.addgene.org/46757/
Recommended Cas9 protein
PNABio CP01-50
Scaffold Oligo – PAGE purified
aaaaagcaccgactcggtgccactttttcaagttgataacggactagccttattttaacttgctatttctagctctaaac
RNA-sequence Data Analysis

Below is a list of some helpful tools and links for the hands-on demo and analysis of our RNA-Seq datasets. Please explore them ahead of the RNA-Seq Analysis workshop. Please also read the supplemental manuscript provided.

* Unix shell tutorial
  http://swcarpentry.github.io/shell-novice/

* Exploring the Jupyter interface:
  http://jupyter.org/try
  (Select “Try Jupyter with Python”)

* Python programming tutorial (facultative)
  https://nbviewer.jupyter.org/gist/wasade/8352109
  [a few more resources are cited in this tutorial]

* Intro to Python for Data Science (facultative)
  https://www.datacamp.com/courses/intro-to-python-for-data-science
Mounting, analysis & imaging of immunostained and in situ hybridized embryos

(Corinne Houart and Sharon Amacher)

Immunohistochemistry (antibody staining) and RNA in situ hybridization procedures are relatively straightforward methods, and each procedure takes about 2-3 days to complete. What is more challenging than the actual staining procedure is learning how to generate publication-quality images of stained embryos (e.g. preparing samples for imaging, choosing the right imaging methods, and performing the imaging). Thus, for this lab, we will provide you with stained embryos and give you time to practice different mounting methods. You will examine your sample(s) and decide whether embryos should be dissected and/or de-yolked, flat-mounted or mounted with yolk intact, oriented dorsally or laterally, and cleared and mounted in glycerol or Permount. We are here to help! At the end of the session, all groups will present their images and we will discuss them.

In this section of the course manual, please find the following materials, in this order:

1. This cover sheet ................................................................. p. 1
2. Overview of the Mounting and Imaging Module ................................................................. p. 2
3. What you will need for this module .................................................................................... p. 3
4. General tips for making mounting and imaging decisions .................................................. p. 3
5. Tips for mounting ISH-stained embryos ............................................................................. p. 4
6. ISH-stained embryos: Deyolking & Mounting .................................................................. p. 5
7. Permount mounting of ISH-stained embryos (more detailed protocol) .............................. p. 6
9. Dissection of zebrafish embryos ......................................................................................... p. 8
10. Bridged coverslips ............................................................................................................. p. 9

In the supplemental manual, you will find the following materials:

1. Entire IHC protocol
2. Entire ISH protocol with appendices (a. two color in situ, b. reagents, c. solutions, d. bridged coverslips, e. fluorescent RNA in situ hybridization, f. in situ on sections
3. Detailed RNAscope fluorescent ISH protocol (Erez Raz)

Please read the main manual pages and skim the supplement. Information in the supplement will be useful when you perform the procedures after the course.
**Overview of the Mounting and Imaging Module**

We will provide each group of 5 or 6 students with a 24-well plate with 10-12 samples in the first two rows. There is no direct relationship between wells (e.g. A1 and B1 are not mutant and wild-type embryos with the same staining). Each student will transfer the contents (embryos + solution) from two wells (one sample from Row A and one from Row B) into a 35 mm dish containing the appropriate media (glycerol or PBST). If possible, take one sample that is stored in glycerol and one that is stored in PBST. For example, Jamie might take embryos from A2 and B6 and Jordan might take embryos from A5 and B1. *Note the well number of your samples.*

**ROW A:** Each well contains wild-type embryos at a specific embryonic stage stained with a “mystery” probe. For your sample, try to ascertain the embryonic stage and what tissue/cell type is stained. Then, using the guidelines on the following pages, decide what mounting method will provide the best image and prepare and image your samples.

**ROW B:** Each well contains a mixture of mutant embryos and their wild-type siblings at a specific stage stained with a “mystery” probe. For your sample, try to ascertain the embryonic stage, what tissue/cell type is stained, and the mutant phenotype. Then decide what mounting method will provide the best image and prepare and image your samples.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td>In PBST</td>
<td></td>
<td>In Glycerol</td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The blue-shaded samples are ISH-stained embryos in PBST (A1-3 and B1-3). All of the brown-shaded samples are in glycerol (A4-6 and B4-6); almost all are IHC-stained samples, but there may be few wells that contain embryos processed by both IHC and ISH.

You will have time in the morning and afternoon for embryo and yolk dissection, mounting, and imaging. Each group should reserve the last hour or so of the lab time before dinner to prepare a presentation of your collective images. We will review the presentations together after dinner.
What you will need for this module

- Your two samples. Take everything in the well.
- Dish with appropriate solution (PBST or glycerol)
- Manipulation tools (fishing line “pokers”)
- Dissection tools (insect pin tools, blades, forceps)
- Microfuge tubes
- Mounting solutions
- Bridged slides & coverslips (only take what you will need)

Examine, then deyolk and dissect (if necessary), before processing for mounting!

General tips for making mounting and imaging decisions

- Use incident lighting to examine stained embryos
- Transfer your embryos into a dish that contains the same media as was in the well (either PBST or 70% glycerol).
- Examine stages and staining patterns. Try to estimate the embryo age, guess the structure(s) stained, and distinguish any mutant phenotypes (for “B row” embryos).
- Decide whether to deyolk (or not), whether to dissect relevant parts (or not – microknife is available for slicing by hand), and what mounting method will best show the pattern/phenotype. You want to mount the embryo in the orientation that best suits the structure of interest. Don’t hesitate to ask us!
- After deyolking and dissecting (if necessary), decide whether to mount the embryos in Permount or glycerol. All embryos already in glycerol should be mounted in glycerol. Embryos in PBST can be mounted using either method, but your choice will be influenced by embryo stage and desired orientation. The procedures for each type of mounting are described on the following pages.
- Mount one embryo per slide. Practice first on less optimal embryos to make sure you’ve chosen the correct bridged slide. Once you gain experience, you can mount more than one embryo or piece for glycerol mounting (not for Permount mounting).
- IMAGE the specimen!

**TIP #1:**

Embryos in PBST (ISH samples) can be mounted in glycerol or Permount. Embryos in glycerol (IHC samples) should be mounted in glycerol.

**TIP #2**

Gastrula-stage embryo images are usually sharper when mounted in Permount. Dorsal mounting of segmentation stage (or later) embryos is easiest in glycerol (and quite challenging in Permount).

**TIP #3**

If you want to discuss your mounting ideas before you start, just ask!
**Tips for mounting ISH-stained embryos** (those from the blue-shaded wells)

First, choose the right bridged slide and mounting method.

**For gastrula stage embryos:**
- Leave yolk intact
- Mount laterally or animal-pole-up on triple- or quadruple-bridged slides
- Generally, the best mounting method will be Permount

**For segmentation stage embryos:**
- Leave yolk intact or de-yolk, depending on what you want to image
- If yolk intact, mount dorsally or laterally on triple-bridged slides in glycerol or Permount (Permount will tend to look better).
- If de-yolked, mount dorsally in glycerol or laterally in glycerol or Permount, typically on single- or double-bridged slides.

**For 24 hpf stage embryos, or older:**
- Leave yolk intact or de-yolk, depending on what you want to image
- If yolk intact, mount dorsally or laterally on bridged slides (try doubles first). Dorsally-mounted embryos will tend to image better in Permount.
- If de-yolked, mount dorsally in glycerol or laterally in Permount. *(Note: it is very difficult to mount a 24 hpf embryo tail dorsally at this stage in Permount – you might have to dissect a small piece to get the image you want). If you are doing a lateral mount of de-yolked embryos in Permount, no bridges are necessary, just mount between two coverslips in a drop of Permount.*

Before performing any subsequent steps, de-yolk and dissect in the media that the embryos were stored in (if desired).

When processing embryos for mounting, **don’t process too many at once** – try 1-4 embryos at a time first!

A one-page short overview of glycerol and Permount mounting methods (for ISH-stained embryos) is on the next page. More detailed protocols for both methods are found on subsequent pages, so once you choose a method, be sure to read the more detailed protocols for tips.
ISH-stained embryos: Deyolking & Mounting

Embryos can be mounted in glycerol or dehydrated and mounted in Permount, with or without the yolk. Glycerol causes less shrinkage, but is not as effective a clearing agent. If embryos are mounted on the yolk, they should be kept in the dark, and photographed immediately, because the yolk darkens rapidly (use double or triple bridged coverslips (see below), so the yolk is not crushed when mounted). Also, using BM Purple rather than NBT/BCIP in the first coloration can prevent the yolk from subsequently turning purple, but that's not a choice you can make in this module.

**Permount mounting (see additional tips and more detail on the following page)**

- Deyolk and dissect if desired
- Dehydrate 1-4 embryos in a microfuge tube through an increasing methanol/PBS series: 30%, 50%, 70%, 100% (5 min per wash)
- Clear embryos by replacing the last methanol wash with 66% benzyl alcohol:33% benzyl benzoate, either in a microfuge tube or in the well of a glass depression dish
- Once the embryos have sunk (2-3 mins), pick them up with a glass hair and place in Permount on a bridged coverslip (see the more detailed protocol on the following page and the “bridged coverslip” instructions on the last page).
- Gently lower another coverslip on top and roll until the embryo is in the desired orientation
- Note: Embryos mounted in Permount can be stored indefinitely at RT

**Glycerol mounting (see additional tips in the IHC section)**

- If required, de-yolk the embryos with insect pins or other tools while in PBST. Adherent yolk granules can be removed by brushing with an eyelash or Dalmation hair glued to a toothpick or otherholder.
- Wash in 30% glycerol/70% PBS for about 10 min or until embryo sinks to bottom of tube
- Wash in 50% glycerol/50% PBS for about 10 min or until embryo sinks to bottom of tube
- Wash in 70% glycerol/30% PBS
- Prepare a coverslip (24mm x 60mm) or slide with 4 “posts” of high vacuum grease
- Transfer the embryos in a glycerol droplet to the coverslip.
- If deyolked, drag the embryo out of the drop, using an insect pin or other tool. Multiple embryos can be lined up in this way, each in their own micro-drop of glycerol.
- Place a coverslip (18 mm x 18 mm) on top and gently press down onto the vacuum grease posts until the embryo is flattened but not squished (be careful not to push too hard)
- Fill to the edges with 70% glycerol
- Image immediately or within a few days at most. If you wish to preserve the embryos long-term, it is best to lift off the coverslip, gently dislodge the embryos and store them in a microfuge tube in 4% PFA.
Permout mounting of ISH-stained embryos (more detailed protocol)

Background: Mounting in permount media is an option to mounting in glycerol, and involves gradual dehydration in a methanol:PBS series, clearing with benzyl alcohol: benzyl benzoate (BA:BB), and mounting in mounting media. This process causes more shrinkage than glycerol, but clears the embryo and yolk well, especially those in early stages (prior to mid-segmentation) with intact yolks.

Steps:

1. Choose the embryos you want to mount. Typically, it is better to process only 3-4 embryos at a time (not the whole clutch).
2. Embryos can be de-yolked if required. Note: it is difficult to get a dorsal mount of de-yolked embryos when mounting in Permout.
3. Dehydrate the embryos through an increasing methanol/PBS series: 30%, 50%, 70%, then 100% (5 minutes in each). For the last dehydration step, try to remove most of the alcohol.
4. Clear the embryos by adding 2:1 benzyl alcohol:benzyl benzoate (BA:BB). The embryos will immediately float to the top of the tube. You can also do this step in a glass well bottom dish (it can be easier to remove the embryos, especially if they are de-yolked). As the embryos clear, they will sink to the bottom of the tube.
5. Once the embryos have sunk to the bottom of the tube, select a bridged slide. For gastrula stage embryos, try a triple or quadruple bridged slide; for 24 hpf, try a double or triple. For deyolked ~24 hpf embryos, you can get a great lateral view by mounting between two coverslips with no bridges at all.
6. Set the appropriate-sized bridged slide across a 35 mm dish lid. Put a stripe of Permout across the bridged slide, from one bridge to another. The stripe should fill about 1/3 – 1/2 of the space between bridges. Don’t under- or over-fill. Alternatively, use a small Permout drop that won’t spread to fill underneath the bridges. Work quickly – Permout dries fast!
7. Transfer one embryo, with the smallest amount of BA:BB possible, to the prepared slide. If you use a poker or hair tool to transfer you can plop the embryo right in the center of the Permout; if you use a pipet, it’s better to place the embryo at the edge of the Permout, then drag into the center with a poker or hair tool to position. If not placed in the middle, the embryo will get sucked toward the corners when the coverslip is lowered.
8. Gently lower a 24x60 coverslip on top (avoid bubbles!) and gently slide until the embryo is in the desired orientation. Avoid touching the coverslip over the embryo (you will leave fingerprints!) If you want to take multiple orientations, you’ll need to snap an image, then roll the embryo into a new position before the Permout hardens. Alternatively, you can mount one embryo in one orientation and another in a different orientation.
9. Embryos mounted in Permout can be stored at RT.

Notes:

* Use separate pipets for the methanol series, the BA:BB, and the Permout. Keep an empty tube next to each container to hold the pipet, or distinctly mark the pipets.
* Pour a small amount of Permout into a separate tube for your use. Do not leave the Permout bottle open to the air!!
* Do NOT lift up the coverslip once it is placed. You can move the embryo into position by sliding the coverslip over the top.
* Permout dries quickly. Permout is sticky. Work quickly but carefully.
General tips for Glycerol mounting of ISH-stained and IHC-stained embryos

✓ Transfer an embryo or dissected embryo piece in just a small drop of 70% glycerol onto the middle of your bridged slide (usually “doubles” for de-yolked embryos and “triples” or “quads” for embryos with intact yolks).
✓ For embryo pieces, place them in the drop. For long pieces that you want to image dorsally, drag them out of the drop, leaving the tail just touching the drop.
✓ Add coverslip gently to avoid generating bubbles
✓ Gently move coverslip to re-orient embryo/piece. Avoid touching the coverslip over the embryo (fingerprints…)

Choose the right bridged slide: For deyolked embryos and pieces, double bridged slides usually work well, but you may have to play around to find the right # of bridges.

Assess whether dissecting the eyes or making sections by hand would improve imaging.

Glycerol-mounted embryos can be imaged in various orientations, either on the same slide, or re-oriented on another slide.

You can mount more than one embryo/piece per slide. After positioning and imaging one, you can manipulate the coverslip to re-orient and image another embryo/piece.

Embryo recovery: you can “rescue” your embryos from the slide and store in a microfuge tube indefinitely.

Alternative “High vacuum grease” method: You can skip bridged slides altogether, and use 4 posts of vacuum grease to provide support for the coverslip. Gently depress coverslip onto the posts to flatten the embryo/piece.
Dissection of Zebrafish Embryos

Removal of the eyes and skin of zebrafish embryos prior to antibody labelling can increase penetration of the antibody and provide better results, particularly if you wish to image more internal structures in the brain.

You will need:
- Sylgard petri-dish
- Watchmaker forceps
- Tungsten wire
- Needle holders
- Tungsten needle sharpening device*

Dissecting pins (these can be made of sharpened tungsten wire too)

*Tungsten wire can be sharpened to a fine point by electrolytically eroding the tungsten wire in a beaker of concentrated NaOH. Just hook up a circuit with a 9V battery or alternative power supply and connect your metal needle holder with the tungsten wire up as the positive electrode. The negative electrode can be any metal rod that rests inside the beaker of NaOH. With the power supply on gently dip the tip of the tungsten wire into the NaOH and slowly withdraw. You should be able to see bubbles forming where your wire contacts with the NaOH. Repeat this dipping and withdrawal action several times until the wire is sharpened to a point. You can examine the amount of sharpening using a dissecting scope – the point of the wire should taper to a fine point. It is a good idea to have a lid for your beaker when not in use.

For optimum dissecting, fix embryos in sweet fix (4% paraformaldehyde with 4% sucrose) overnight at 4°C. Next, wash embryos with PBS (NO TritonX-100) for at least 2 h, but preferably overnight. After dissecting the embryos, wash several times with PBS, then transfer into 100% MeOH for storage at -20°C until you are ready to immunolabel.

After practicing, you will all find slightly different methods of dissection that work best for you; here is the order of steps that I normally follow to dissect the eyes and skin from the embryo.

1: Pin the embryo on its side in a sylgard dish through the trunk with two dissecting pins.
2: Remove the eye using your tungsten needle by cutting around the edges of the eye, the eye cup should pop off very easily. Unpin the embryo and turn it onto its other side and re-pin. Remove the other eye by the same method.
3: Using your needle cut through the tissue from just above the notocord ventrally through the jaw/cardiac tissue at the AP level of the otic vesicle.
4: Using the needle and/or forceps cut the skin between the main body and the yolk sac and remove the yolk as an intact structure.
5: Using your needle and or forceps peel away the jaw from the underside of the brain.
6: Using your needle very gently cut through just the skin at the level of the hindbrain then using your forceps try and grip a flap of skin and pull this rostrally to remove all of the skin on the surface of the brain. Any bits remaining can be gently removed using your forceps.
Bridged Coverslips

**top view**

```
\begin{center}
\includegraphics[width=0.5\textwidth]{top_view.png}
\end{center}
```

**side view**

```
\begin{center}
\includegraphics[width=0.5\textwidth]{side_view.png}
\end{center}
```

Instructions: use a small drop of superglue to attach 18 x 18 x 1 mm or 22 x 22 x 2 mm coverslips to either end of a microscope slide or a 24 x 60 coverslip. Add more small coverslips to the pile until the required space is accomplished - this depends on the age of the embryo and on the extent of dehydration (more dehydrated embryos are smaller). The idea is to have the top and bottom coverslips just touching the embryo but not squishing it. The exact spacing is usually arrived at empirically, but usually 2 22x22x2 coverslips is enough not to squish a bud-stage embryo.
Chimera Analysis-Blastula stage transplants
Woods Hole Zebrafish Course – August 11, 2019

Instructors: Sharon Amacher (amacher.6@osu.edu)
Andres Collazo (acollazo@hei.org)
Jim Fadool (jfadool@bio.fsu.edu)

During the lab, turn ahead to the “Blastula stage cell transplants-short” page

Introduction:

On this day of the course, we focus on a powerful technique, the analysis of chimeras. It is therefore important to ask: What are chimeras, what types of questions can be addressed with this technique, what are the advantages over other methods, what are the limitations? Finally, what are the latest technical updates?

Chimeric embryos are embryos into which cells, or part of cells, have been introduced. Typically, chimeric zebrafish embryos are generated by transplanting cells of a donor embryo into a host embryo of a different genotype. This is in contrast to mosaic embryos, mostly used in flies, in which all cells are derived from the same embryo, but where through genetic manipulations such as mitotic recombination the genotype of a group of cells within the embryo is altered.

The basic strategy for generating chimera is to transplant a small number (~5-40 depending on the experiment) of labeled donor cells into unlabeled host cells.

Transplantation can be done at different stages of development, but here we will focus on blastula stage transplants. Ideally, cells should be transplanted at the shield stage, as the gastrula stage fate map allows you to better direct donor cells to a target tissue/cell type by transplanting into the appropriate region. However, it is more practical to practice transplanting at the high or sphere stages. Although this does not allow one to target cells precisely (the shield/future dorsal site is not visible yet), it has the advantage that a larger number of chimeras can be generated per session/clutch.

There are two main applications in the zebrafish for chimeras: 1. Generation of germline clones e.g. to examine the maternal-zygotic phenotype, and 2. Generation of somatic
chimeras e.g. to determine cell autonomy of a gene or to examine cellular behaviors (migration, adhesion etc) of cells with different genotypes.

1. Generation of germline clones. This strategy was initially employed by Lin et al (Lin et al., 1992) and has been modified since then (Carmany-Rampey and Moens, 2006) (see below). A common application is to determine if a gene, which is characterized by a particular zygotic lethal phenotype, also has an earlier, maternal role. To generate embryos lacking maternal and zygotic gene function, wild-type embryos are injected with morpholinos to block primordial germ cell (PGC) development. These embryos then serve as hosts for germ cells transplanted from homozygous mutants that carry a transgene that drives expression of GFP in PGCs or have been injected with GFP mRNA that is retained only in PGCs. Host embryos with GFP-positive PGCs are then raised to generate maternal zygotic mutants (Ciruna et al., 2002).

2. Generation of somatic chimeras to determine cell autonomy of a gene or to examine the behavior (migration, adhesion, etc) of cells with different genotypes. A frequent application is to determine in which cell type the gene of interest acts. This strategy was initially employed by Streisinger et al (Streisinger et al., 1989) and has been modified since then (see below). The importance of this application is highlighted by the fact that: a) no knowledge about the molecular nature of the mutated gene is required; b) genes are frequently expressed in multiple cell types, e.g. muscles and neurons or even ubiquitously; c) gene expression is frequently established by mRNA in situ hybridization, but a gene might be expressed more broadly but can be restricted to only one cell type due to posttranscriptional mechanisms. Let’s assume that we are analyzing the role of a gene during axonal pathfinding. To determine in which cell type(s) a gene acts, labeled cells are first transplanted from wild-type donors into mutant hosts. At the appropriate stage, these chimeric embryos are analyzed to determine if the presence of wild-type derived cells, e.g. neurons, rescues the axonal phenotype. This initial set of experiments should be complemented with the reverse experiment in which labeled mutant embryo cells are transplanted into wild-type embryos. Here, these chimeric embryos are analyzed to determine if the presence of the wild-type environment rescues the mutant-derived cells, e.g. neurons, axonal phenotype. Together, the results allow one to establish if the gene acts cell autonomously (i.e., in neurons) or cell non- autonomously (e.g., in muscle). If the results indicate a cell non-autonomous function, a third set of experiments is done to determine which cell type(s) is the source of the gene activity. In this third set, labeled wild-type cells are again transplanted into mutant/morphant embryos, but now the analysis focuses to correlate the identity of transplanted cells with their ability to rescue the mutant phenotype, e.g. muscle cells.

To interpret the results from chimera studies correctly, it is important to use null mutations. Transplanted cells carrying a hypomorphic mutation might behave like a wild-type cell when transplanted into a wild-type host, which could misleadingly indicate a cell-non-autonomous function for this gene (Childs et al., 2002; Torres-Vazquez et al., 2004). A similar effect could occur when using morpholinos at sub-optimal concentrations.
Traditionally, fixable rhodamine-dextran (see Protocol for details) has been used to label donor cells. While this is a very robust way to generate labeled donors, the dye does not label processes of some cell types such as retinal ganglion cells. The availability of transgenic lines expressing GFP ubiquitously or in specific subsets of cells frequently facilitates this analysis. If donors carrying an ubiquitously-expressed transgene are used (e.g. H2A-GFP (Pauls et al., 2001), see protocol for details), then no tracer dye is required. However, if a cell type-specific transgenic line is used, it is essential to inject tracer dye in order to visualize all transplanted cells. Alternatively, an ubiquitously-expressed transgene such as H2A-GFP can be used to label all of the host cells.

Overall aim.

The goal is to give you a hands-on introduction on how to generate and analyze zebrafish chimeras. Because there is only one-half day to do this, you will not be extensively trained, which hardly could be accomplished such short amount of time. Rather, our goals for the day are to: 1) give you a sense of time, efforts and setup required to perform chimeric analyses even in a small lab; 2) provide you with the basics of how chimeras are generated and the questions one can attack with them and 3) give you a feeling for the power of this method that is applicable to many studies. This will form a foundation that you can use should you want to generate chimeras in the future.

Outline of the laboratory demo and exercises.

1. Sunday, August 11th, 2019, 1-6pm
   Transplant cells from rhodamine dextran-injected donors into unlabeled wild-type or H2A:GFP host embryos.
   a. Donors may be wildtype or carry one of several transgenes:
      i. H2A:GFP donors (histone-GFP, ubiquitous, nuclear)
      ii. pou4f3:gap43-GFP donors (retinal ganglion cells, cytoplasmic)
      iii. mnx1:GFP (GFP in motoneuron)
      iv. isl2b:GFP (GFP in retinal ganglion cells and dorsal root ganglia),
   b. Transplants will be performed between the dome and the shield stage, and about 20-30 cells will be transplanted per embryo.
   c. There will first be a 30 minute demo and then each student will practice.
   d. The transplanted embryos will be kept in the transplantation dish until 10pm, and then should be transferred to agar-coated dishes and placed in the 28.5C incubator.

2. Sunday evening
   a. Time-lapse imaging of a few chimeras.

3. Monday, August 12th, 2019
   a. Examine the hosts and record:
      i. survival (%),
      ii. presence of GFP-positive and/or rhodamine dextran-positive cells
      iii. tissue distribution of these cells.

4. Tuesday, August 13th, 2019: Wrap-up, 8:30-10:30am
**Equipment, reagents etc:**

<table>
<thead>
<tr>
<th>Equipment/Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micromanipulator</td>
</tr>
<tr>
<td>1 ml syringe</td>
</tr>
<tr>
<td>16 or 18 Gauge needles for syringe</td>
</tr>
<tr>
<td>1.5 mm OD needle holders with sideport</td>
</tr>
<tr>
<td>tubing to connect syringe/needle with sideport</td>
</tr>
<tr>
<td>Transplantation needles, 1.5 mm OD polished; WPI, Cat. TW150-4</td>
</tr>
<tr>
<td>Transplantation molds</td>
</tr>
<tr>
<td>Injections molds</td>
</tr>
<tr>
<td>Pasteur Pipettes</td>
</tr>
<tr>
<td>Bulbs for Pasteur Pipettes</td>
</tr>
<tr>
<td>Pronase Powder</td>
</tr>
<tr>
<td>Agarose to coat plates</td>
</tr>
<tr>
<td>E2 Media with StrepPen</td>
</tr>
<tr>
<td>Rhodamine dextrane, filtered</td>
</tr>
</tbody>
</table>

**Preparation:**

1. Pour agarose plates: 1% agarose in E2 medium
   - coat several small plates for dechorionation
   - use molds in large plates for transplantation wells (1x2 mm holes)
   - use molds in large plates for injection wells (1mm grooves)

2. Needles
   - A. Injection needles: Pull 1.0 mm OD needles on needle puller (e.g. Sutter Instruments, model P-87 micropipette puller).
     - Start with settings like: H1 = 740, V = 130, P = 60, T = 200 and modify
   - B. Transplantation needles: Pull 1.5 mm needles (e.g. Sutter Instruments, model P-87 micropipette puller).
     - Start with settings like: H1 = 750, V = 40, P = 80, T = 110 and modify.
     - Break needle at a slant using forceps. Mark the pointed side of the needle with a marker.
     - Use the microforge (Narishige Instruments) to polish the edges and to pull the tip.
     - Note the size of the needle for later reference.

   - Needle sizes opening
   - early blastula: 55-65 µm
   - late blastula: 40-50 µm
   - gastrula: 25-35 µm
3. Prepare stocks

<table>
<thead>
<tr>
<th>Stock Description</th>
<th>Quantity</th>
<th>1L</th>
<th>5L</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X E2 stock (-bicarb and Ca)</td>
<td></td>
<td>1L</td>
<td>5L</td>
</tr>
<tr>
<td>NaCl</td>
<td>17.5 g</td>
<td>88 g</td>
<td></td>
</tr>
<tr>
<td>KCl</td>
<td>0.75 g</td>
<td>3.8 g</td>
<td></td>
</tr>
<tr>
<td>MgSO_4 (*7 H_2O)</td>
<td>2.4 (4.9)g</td>
<td>12.0 (24.5) g</td>
<td></td>
</tr>
<tr>
<td>KH_2PO_4</td>
<td>0.41 g</td>
<td>2.05 g</td>
<td></td>
</tr>
<tr>
<td>Na_2HPO_4 (*2H_2O)</td>
<td>0.12 (0.15) g</td>
<td>0.60 (0.75) g</td>
<td></td>
</tr>
<tr>
<td>500X CaCl_2 * 2H_2O</td>
<td></td>
<td>100 mls</td>
<td></td>
</tr>
<tr>
<td>CaCl_2</td>
<td>7.25 g</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500X Bicarb</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NaHCO_3</td>
<td>3 g</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Autoclave and refrigerate stocks

1X E2

<table>
<thead>
<tr>
<th>Stock Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X E2 stock</td>
<td>50 mls</td>
</tr>
<tr>
<td>500X CaCl_2</td>
<td>2 mls</td>
</tr>
<tr>
<td>500X bicarb</td>
<td>2 mls</td>
</tr>
<tr>
<td>500X Pen/Strep</td>
<td>2 mls</td>
</tr>
<tr>
<td>H_2O</td>
<td>944 mls</td>
</tr>
</tbody>
</table>

Pronase Stock, Sigma P5147-1G

30 mg/ml in H_2O; aliquot and store at -20°. Dilute 1:100 in E2 for use.

Penicillin/Streptomycin Stock

Penicillin 60 mg/ml, streptomycin 100 mg/ml; aliquot and store at -20°.

Dilute 1:500 in E2 for use.

Tricaine (3 aminobenzoic acid ethyl estyer)

Make as a 0.2% solution and pH to 7.0 with Tris (pH 8.0)

4. Prepare labeling reagents

5% Tetramethylrhodamine dextran 10,000 MW, Lysine Fixable (Fluoro-Ruby),
(Catalog #: D1817, Thermo-Fisher) <OR>
Combine 1:1, 5% Tetramethylrhodamine Dextran 10,000 MW, Neutral (Catalog #: D1816) and 5% Biotin Dextran 10,000 MW Lysine fixable (Catalog #: D1956) Dextran stocks prepared in 0.2M KCl and filtered (20 µm pore). Store at -20°.

**Cell labeling and transplantation**

1. Inject donor embryos with dextran conjugates of interest.
2. Let recover in the dark.
4. Treat chorions of donors and recipients with pronase. When chorions become ‘bubbly’ and become soft (5-10’), wash out pronase with excess E2 several times. Wash really well.
5. Gently push embryos in chorion through Pasteur pipette, the chorions will ‘fly’ off.
6. Place donors and recipients in transplant wells and use insect pin to orient the embryos.

For wild-type into mutants: one row of donors and 4 rows of recipients. Remove as many cells as possible from donor and transplant 5-40 cells (depending on experiment) into each host.

For mutants into wild-type: one row of donors next to one row of recipients. Remove 5-40 cells (depending on experiment) from one host and transplant into adjacent into host. Make sure you don’t poke through the host YSL, otherwise the embryo will not survive.

6. After transplantation, wait until epiboly has completed, then carefully transfer donors and recipients out of wells into new E2 for further development. For mutants into wild-type: use agarose-coated 24 well plate and place one donor and its host into the same well.

**Visualization of transplanted cells**

1. GFP and Rhodamine can be visualized in live embryos with a fluorescence microscope.
2. Embryos with clones of interest can be photographed or recorded with time-lapse imaging and/or fixed in 4% paraformaldehyde for direct visualization of fixable rhodamine dextran and fluorescent reporter genes or following strep-avidin labeling for biotin and immunolabeling for GFP.

**References**


Blastula stage cell transplants-short

- place & orient donors and hosts into single well agar molds

- pull in 120 or as many as possible donor cells
  (don’t suck in YSL nuclei layer at the interface)

- select area to transplant into and inject 10-40 donor cells
  don’t poke through YSL nuclei layer at the interface
  carefully remove needle to ensure that cell stay in embryo

Cell placement notes:
Rhodamine Dextran or H2A expressing cells can be placed anywhere and be visible in various tissues at later stages; for tissue-specific transgenic donor cells, consider where the transgene is normally expressed along with the fate map. Discuss!
This protocol can be used to move cells from donor to host embryos at any developmental stage. It was designed to require as little preparation as possible to be able to do many transplants per session. The two most limiting factors are the quality of the methyl-cellulose and the sharpness and diameter of the capillary used for cell manipulation.

What is needed:
- A compound microscope equipped with long working distance objectives (10 and 20X), a fixed stage (or a micromanipulator fix on the stage), an external zoom placed in the head of the scope (1.5 and 2X).
- A standard micro-manipulator (allowing some fine control of movement)
- 1.5 mm diameter glass capillaries (without inner filament!)
- Micro-syringe (commercial rig or plastic syringe) linked to a needle holder (same holder as injection rig)
- 4 or 5 % methyl cellulose (5 gr in 100 ml of E2 or fish water)
- E2 medium with PenStrep (see zebrafish book)
- 22 by 22 cover slips
- Pasteur pipettes

Protocol:

- Dechorionate the donor and host embryos (pronase treatment or by hand)
- Snip your pulled capillary with a pair of forceps, at the level required to give the diameter needed (bigger than a cell diameter and less than 2 – will vary with stage of embryo used). If needed, shape the tip of the capillary with a microforge. Note: commercialised micro-needle also an option)
- Place your needle in the holder of the microsyringe and the holder onto the micromanipulator. Adjust position of the needle under the objective.
- Place a cover slip on a glass slide (attached by capillarity using a small drop of water)
- Using a small diameter Pasteur pipette as a spreading tool, collect a bit of methyl cellulose by dipping the pipette into the tube of Methyl Cell. and then trace a line of methyl cell onto the cover slip (see illustration below).
- Using a clean Pasteur pipette, place one or two donor embryos and 4-6 hosts onto the cover slip, near the methyl cellulose strip
- With the back of a pair of forceps, push gently the embryos against the methyl cellulose. While pushing them, orientate them such that the area in which you...
want to operate is outside of the cellulose. Push until around ¼ of the embryo is into the methyl cellulose (see below).

- Place the slide under the scope and adjust the position of the needle and the embryos such that the needle is close to the donor embryo under the objective.
- Penetrate the donor embryo at the desired location, using rapid and short movement of the stage.
- Using the micro-syringe, begin to pull cells out of the donor embryo (control on the syringe should be good enough to move one cell at a time and have stability of the cell position inside the capillary). Great control can be obtained, increasing the magnification using the decoupled zoom in the scope head.
- Take around 20-30 donor cells in the needle, then move out of the donor and place the needle near the first host embryo.
- Penetrate the host at the side desired for the transplant planned
- Push the precise number of cells you wish to give the host, using the microsyringe.
- Move to the next host and repeat the operation. Repeat the previous 2 steps until either you run out of donor cells (and therefore collect more from the donor embryo if needed) or have transplanted all hosts.
- When the whole row of hosts are transplanted, remove the cover slip delicately from the slide, using your fingers, only holding a very small corner of the cover slip away from the embryos. Place the cover slip inside a 3 cmm diameter dish. Make sure it is place flat onto the bottom of the dish.
- Delicately poor a few ml of E2 + PenStrep medium on top of the embryos. Leave them to recover in a 28°C incubator. Never try to remove the embryos from the methyl cellulose, they will free themselves from it in a few hours in E2.
- The transplanted embryos can be used for time-lapse or other type of observation and experiments at the earliest 1 hour after surgery.
Live imaging of innate immune inflammation in zebrafish larvae

Woods Hole zebrafish course August 13, 2019

Instructors: Anna Huttenlocher (huttenlocher@wisc.edu)
Ruth Houseright (ruth.houseright@wisc.edu)

Today we will be imaging fluorescently labeled innate immune cells and following their migration in response to a wound or chemokine signaling using time-lapse microscopy. We will use larvae with GFP, dendra, or mCherry under the mpx promoter to label neutrophils or the mpeg1 promoter to label macrophages. We will perform a tail transection to induce directional migration of neutrophils and macrophages. Alternatively, a chemokine (LTB4) can be added to the bath to induce neutrophil migration, while the macrophages remain unaffected.

The innate immune response is highly conserved in zebrafish larvae. In response to inflammatory cues such as chemokines (LTB4) or tissue damage, neutrophils are recruited out of the hematopoietic tissue to the site of tissue damage. Macrophages are also recruited to the site of damage; however, the kinetics of their migration are different. By tracking motile cells in the larval zebrafish, our lab has defined different modes of leukocyte migration and determined essential wound signaling molecules. Cell velocity, directional migration, and duration at the wound can be determined from this analysis. Using these data, we have identified the chemokine receptor, Cxcr1 as being required for neutrophil recruitment to a wound, while Cxcr2 promotes neutrophil reverse migration from a tail transection.

This section provides an introduction to the zebrafish innate immune response and the migration of leukocytes in response to tissue damage or inflammatory cues.

The session will address the following techniques

Wounding zebrafish larvae by tail transection
Mounting larvae for live imaging
Live imaging of neutrophil and macrophage migration
Analysis of cell migration using ImageJ

References:


**Schedule**

**Tuesday, August 13:**

13:30-14:00  Wounding and fish mounting demonstration
14:00-15:30  Prepare samples and start live imaging
15:30-16:00  ImageJ demonstration
16:00-17:30  Tracking of leukocyte migration
21:00-22:00  Tracking wrap-up
Imaging and quantification of innate immune cell migration

You will need: 2% milk coated 35 mm plates (or tissue culture treated)
- 2% low melting (LM) point agarose in E3
- 4 mg/mL tricaine
- E3
- Glass pipettes
- Heat block set to 56°C
- Screened fluorescent positive 3 days post fertilization (dpf) larvae
- Scalpel blade
- p1000 and p200 pipettes and associated tips
- 15 mL conical tubes
- Probe
- 35 mm Glass bottom dish OR
- Silicone gasket with associated slides and coverslips

1. Prepare imaging solutions:
   a. If using a glass bottom dish: clean glass bottom dish with 70% ethanol and kimwipe. Be careful not to touch the glass with your bare hands
   b. Melt 2% low-melting agarose at 56°C
   c. 2X tricaine: 9 mL E3 + 1 mL 4 mg/mL tricaine
   d. 1X tricaine: 4 mL E3 + 4 mL 2X tricaine

2. Wound fish:
   a. Wound about 10 larvae (3 dpf):
      i. Transfer larvae in E3 with glass pipette into milk coated plate and wash twice with 1 mL fresh E3. After second wash, pipet in 3 mL 1X tricaine solution
      ii. Line the larvae up with a probe (Figure 1)
      iii. Tail transect each larva with a razor, cutting off about 2/3 of the fin (careful to avoid hitting the notochord) (Figure 2)
      iv. Note time of wounding:
      v. Continue onto step 3 or 4 for mounting protocols.

Figure 1: Diagram of plate setup for larval tail transection
3. Preparing imaging plate using a glass bottom dish:
   a. Place 5 wounded larvae on a glass bottom plate with glass pipette and remove most of the liquid, leaving a little to cover the larvae
   b. Add 1 mL 2% LM agarose to 1 mL 2X tricaine for a final 1% agarose mixture. Mix a couple of times with p1000 pipette.
   c. Quickly remove all the liquid from the larvae and gently pipette agarose over the bottom of the plate starting with the glass region
   d. Moving quickly before the agarose sets, guide larvae to rest on the bottom of the plate and line them up in the center of the glass (Figure 3). Arrange larvae with tails laying flat. It is important to avoid touching the fins, as not to cause additional wounds
   e. Let the agarose set (10-15 minutes) and carefully pour about 1-2 mL of 1X tricaine over agarose (Figure 4) (when using an inverted microscope)
   f. If using an upright microscope for a short time course, you can flip the plate upside down and image without tricaine/E3. It may be helpful to add moist kimwipes to the lid to prevent the agarose from drying out.
4. Preparing imaging plate using a silicone gasket:
   a. Gently press a silicone gasket onto a coverslip to create a seal.
   b. Transfer 1-3 wounded larvae into the center of the chamber, with minimal E3.
   c. Add 1 mL 2% LM agarose to 1 mL 2X tricaine for a final 1% agarose mixture. Mix a couple of times with p1000 pipette.
   d. Quickly remove all the liquid from the larvae and gently pipette a drop of agarose over the larvae.
   e. Moving quickly before the agarose sets, guide larvae to rest against the coverslip and line them up (Figure 5). Arrange larvae with tails laying flat. It is important to avoid touching the fins, as not to cause additional wounds.
   f. Allow agarose to set and gently fill chamber with 1X tricaine.
   g. Gently press a microscope slide onto the gasket creating a seal. Flip the set-up over to image with the coverslip right side up for upright microscopes.

5. Image larvae every 2-3 minutes (take note of interval length) for 2 hours. Note time at start of movie: ________________

**Figure 5:** Diagram of live imaging plate using a silicone spacer
Today we will be using the Fiji plugin, MtrackJ, to acquire information on leukocyte migratory behaviors. We will first be comparing the migration of our cells between the first and second half of our time-lapses. We can also use this information to compare wound responses between cell types and between pharmacological treatments.

**Getting started with ImageJ**

- Fiji - Fiji Is Just ImageJ
  - Fiji is a version of ImageJ that includes a pack of commonly used “plugins” (or specialty software components)
  - Download the appropriate 64-bit Fiji for your system (Figure 6)
    - following the instructions for installation at [https://imagej.net/Fiji/Downloads](https://imagej.net/Fiji/Downloads)

- MtrackJ - facilitates motion tracking and analysis
  - Installing MtrackJ onto Fiji:
    - Help > Update
      - ImageJ updater window will pop up, in the bottom left corner click “Manage update sites”
      - ImageScience
      - Click “Add update site”
      - Click “Apply changes”
      - Close and restart Fiji
      - MtrackJ should now be in the Plugins tab

- Useful tricks:
  - Pressing “L” in Fiji brings up a command search using keywords
    - Shows where a command is on the menu and any associated keyboard shortcuts
  - Too many windows up that you lost your tool bar? Press enter on your keyboard to bring the toolbar to the front

1. Uploading your data into Fiji
   - Drag and drop the file or stack into ImageJ menu bar or file > import > bioformats
   - Split channels

2. Saving your file (file > save as):
   - Save images and image sequences as .tif
i. Saving an image as a JPEG compresses the images and loses resolution every time it is opened, edited, and saved
b. Save movies as .avi with compressed jpeg
   i. This reduces the file size without reducing the quality
c. Always keep a copy of the raw data, since the software modifies the files and has limited undo options
d. Save versions as you edit so you can always go back to an earlier edit without redoing every step. Some actions in Fiji cannot be reversed

3. **Image adjustments** - Different image types and adjustments can be accessed via the Image menu (Figure 7)
   a. To extract a set or single slice over time:
      i. Image → duplicate
      ii. Define slice or slices and time frame. OK
   b. To make a maximum z-projection:
      i. Image → Stacks → Z Project… (Figure 7)
ii. Set slices to be used and projection type, as shown in Figure 8

c. Adjust brightness and contrast:
   i. Image→Adjust→Brightness/Contrast… (Figure 7)
   ii. This will change the display, not the pixel information
   iii. Play with the different sliders to see how it shifts the histogram of all the pixels (Figure 9)
   iv. DO NOT CLICK APPLY. This rescales the original data and does not reflect the true acquired data. When complete, close with the red exit button

d. Image type:
   i. Convert image to 8 bit- this type of image requires less memory
   ii. Image→type→8-bit (Figure 7)
   iii. 16 bit images are required for quantifications reliant on fluorescent intensity

e. Merging channels:
   i. Image→Colors→Merge Channels… (Figure 7)
   ii. Define which pseudocolor will be applied to each channel (Figure 10)
   iii. Ok
   iv. By making a composite, you can still edit the individual channels. Use the “C” slider to toggle between channels

Tracking using MtrackJ

1. The microscope file should have the basic metadata values at which your images were acquired. To determine these parameters: Image→Properties (Figure 7)
   a. Pixel width, height, and frame interval are necessary for acquiring measurements
   b. Unit length is in micron or um
   c. If these values are not listed, you will need to add the appropriate values determined by your acquisition parameters

2. Open MTrackJ plugin: Plugins→MTrackJ
3. Improve accuracy of tracking: Tracking (Figure 11-1):
   a. Apply local cursor snapping during tracking:
      Bright centroid ✓
      i. This improves accuracy of tracking by adding a point into the center of the bright object in the defined area
      ii. Maximum intensity can also improve accuracy of tracking but depending on the cell type and volume may not consistently be the exact center of the cell

4. To start a new track, click Add (Figure 11-2). This action will turn on tracking mode. To begin a track, click on the center of the first cell you will be tracking. The point is marked by an overlay shape and the program automatically moves the series to the next frame. Continue adding points frame by frame. You can manually move the frames with the forward and backwards arrows on your keyboard
   a. Active tracks will be white (Figure 12)
   b. When done with track: double click or esc

5. Displaying (Figure 11-3):
   a. Tracks’ display parameters can be altered, such as track size, head style, which tracks are displayed. Play with these as you are tracking to learn your personal preferences

6. Deleting: If a mistake is made while tracking, there are multiple ways (listed below) to correct the incorrectly added points
   1. You can remove added points by clicking Delete (Figure 11-4), then clicking the point on the track that want to delete. This can be the last point or earlier points (but subsequent points will remain)
2. You can override incorrect points by redoing added points for those particular frames. This is done the same as your original tracking, by clicking on the image in the correct position.

3. Using the “move” function: Going to the frame with the incorrect point, click Move (Figure 11-5), and drag the point to the correct position.

4. **To delete an entire track**, click Delete (Figure 11-4). While pressing the Ctrl key down, click on the track you want to delete entirely (it will be highlighted white).

5. **To continue adding to an existing track**, click Add (Figure 11-2), then while pressing the Ctrl key down, click on the existing track you would like to continue adding to. The track will be highlighted white when your cursor is hovering over it.

6. **To hide tracks (or un-hide hidden tracks)**, click Hide (Figure 11-2). Clicking on the track causes it to be hidden, but not deleted. If you hold the Ctrl key down while clicking, all tracks *except* the selected track will be hidden. Hidden tracks can be made visible again by keeping the Ctrl key down and clicking the Hide button.

7. We will be tracking cells “at the wound” and comparing migration dynamics between the first and second hour of the movie.
   a. At the wound: A cell is considered “at the wound” when it is the roughly 100 \( \mu m \) past the notochord (Figure 13). Start and end tracks when the cell roughly crosses this boundary.
      i. Draw a line at the edge of the notochord in your brightfield image
      ii. Place this line on the fluorescent channel file: edit \( \rightarrow \) selection \( \rightarrow \) restore selection
      iii. To make this a visible line: edit \( \rightarrow \) draw, process to all stacks
   b. Collecting data for a defined time-period (2 options):
      i. Track your cells for the first hour, collect measurements (step 9), save tracks (step 8), Clear (Figure 11-6) tracks, and repeat new tracks for the second hour.

1. **To save both tracks**, first copy your original tracks to a new location, if you do not do this Fiji will save the new tracks onto the same file overriding the previous tracks.
   ii. Track your cells for the entirety of the movie (and while they are “at the wound”)

1. **To split the tracks at the appropriate frame**: Split (Figure 11-7)
   a. Click on the track point at which you want to split
      i. The new track will start at this frame and the original track will end at the previous frame
   b. Ctrl + Click on the track
      i. The new track will start at this frame and the original track will end at this frame. They end and start at the same frame
   c. You can cluster the tracks: Cluster (Figure 11-8)
      i. Ctrl + Click to define which cluster to add the track to. You can add these tracks to a new cluster.
ii. Clicking on subsequent tracks will now be adding them to the active cluster which is now cluster 2

8. **Save tracks** by pressing Save (Figure 11-9). Save the track file (.mdf) with the same name as the image sequence file and any further information necessary (example: neutrophil tracks)
   a. You can access and continue editing tracks by opening your file and Load (Figure 11-10) the corresponding tracks

9. **Retrieve measurements**: Measure (Figure 11-11)
   a. Two windows will pop up, data for each individual point on each track and a second window with the average data for each track
   b. Save both windows as an excel file: command + s, change the file type to .xls
   c. You will get a warning when opening the file but it will still open with all the data
   d. We will review the data provided and analysis in the next section

10. **To create a movie:**
   a. Movie with tracks in your fluorescent channel only: Movie (Figure 11-12)
   b. Movie with tracks with your fluorescent and brightfield channels:
      i. Open your individual files into Fiji (drag and drop)
      ii. Merge the channels (Image→Colors→Merge Channels… (Figure 7 and 10))
      iii. Flatten the image (Image→Overlay→Flatten)
      iv. Open MtrackJ (Plugins→MtrackJ)
      v. Load tracks (Load (Figure 11-10))
      vi. Movie (Figure 11-12)
   c. Movie with tracks on a grey background:
      i. Displaying (Figure 11-3), Background: Gray, ok
      ii. Movie (Figure 11-12)

11. **Adding a time stamp and scale bar**: These steps should be done at the very end as these actions cannot be reversed or edited
   a. Time: Image→Stacks→Time Stamper (Figure 14)
      i. Put in correct time interval. This you should have from your microscope parameters or can be found on the corresponding file’s properties (Image→Properties (Figure 7))
ii. You can change the font size and location, but remember, this is a permanent stamp on the file. If you want to change this you will need to open an unedited movie file again to try another size or location.

iii. ✓ 00:00

iv. Suffix: s

v. Ok

b. Scale bar (Figure 15):

i. First set the scale to be applied to your new movie. Determine the scale using your microscope file (not the generated movie):

   Analyze → Set Scale…
   1. Distance in pixels should be set
   2. Unit length: um or micron
   3. ✓ Global – This applies the scale to all open documents.
   4. Ok
   5. You can check that the scale is now set for your movie by going to “Set Scale” for the recently generated movie

ii. Applying the scale bar: Analyze → Tools → Scale Bar…

   1. Set size of scale bar: 100
   2. You can change the font size and thickness of the scale bar. Again, this is a permanent feature on the file. You will not be able to go back and edit these parameters on an existing scale bar
   3. Location: You can use their defined locations (ex. “Lower Right”) or draw a line in the area you would like your scale bar and choose “At Selection”
   4. Check “Label all slices”
   5. Ok

Figure 15: Adding a scale bar

12. Controlling animation speed: To change the animation speed:

   Image → Stacks → Animation → Animation Options. You can change the frames per second to control the speed of the movie.
Analyzing Data

1. Open your tracks’ measurements file in excel. Your data should look similar to the excel output shown in figure 16

Figure 16: Track measurements table

2. A brief description of the quantities listed are given on the next page.

3. You will need to calculate the average time a cell is at the wound and its speed of migration. To do this we need the duration (Dur [sec]) and mean velocity (mean v [µm/sec]) (Figure 17)
   a. Duration [min] = (Dur [sec])/60
   b. Mean velocity [µm/min] = (mean v [µm/s])x60
   c. Average each of these values to obtain an average velocity and duration at wound for each individual fish.

Figure 17: Highlighted necessary values for migration measurements
MtrackJ Quantities

- **Nr**: The measurement number. Runs from 1 to the total number of points.
- **CID**: The ID number of the cluster to which the track point belongs. This quantity is not displayed if there is only one cluster and the user has deselected the displaying of cluster and assembly measurements.
- **TID**: The ID number of the track to which the point belongs.
- **PID**: The ID number of the point.
- **x [unit]**: The calibrated x coordinate of the point.
- **y [unit]**: The calibrated y coordinate of the point.
- **z [unit]**: The calibrated z coordinate of the point. This quantity is not displayed in the case of 2D image sequences.
- **t [unit]**: The calibrated t coordinate of the point.
- **c [idx]**: The channel index of the point. This quantity is not displayed if there is only one channel.
- **I [unit]**: The calibrated image intensity value at the point.
- **Len [unit]**: The length of the track from the start (first) point of the track to the current point (inclusive). Thus the value of this quantity for the end (last) point of a track equals the total length of the track.
- **D2S [unit]**: The distance from the start (first) point of the track to the current point. Thus the value of this quantity is always less than (or at most equal to) the value of Len.
- **D2R [unit]**: The distance from the current point to the reference point.
- **D2P [unit]**: The distance from the current to the previous point of the track.
- **v [unit]**: The speed, at the current point, of the object represented by the track. This quantity is computed as the magnitude of the most recent displacement vector (pointing from the previous point to the current point of the track), divided by the frame interval.
- **α [deg]**: The angle of the in-plane component of the most recent displacement vector (pointing from the previous point to the current point of the track) with respect to the x-y coordinate system of the image (with the origin taken in the previous point). Angle values range from -180 to +180 degrees, where 0 degrees means the vector component runs parallel to the positive x axis (pointing to the right), +90 degrees (or -90 degrees) means it runs parallel to the positive (or negative) y axis (pointing downward, or upward, respectively), and +180 degrees (which is the same as -180 degrees) means it runs parallel to the negative x axis (pointing to the left).
- **Δα [deg]**: The angular change between the in-plane components of the most recent displacement vector (pointing from the previous point to the current point of the track) and the preceding displacement vector.
- **θ [deg]**: The angle of the most recent displacement vector (pointing from the previous point to the current point of the track) relative to the x-y plane of the image (with the origin taken in the previous point). The angle values range from -90 to +90 degrees, where 0 degrees means the axial vector component is zero (that is, the displacement vector is entirely in-plane), and +90 degrees (or -90 degrees) means it runs parallel to the positive (or negative) z axis (pointing away from, respectively toward, the observer). This quantity is not displayed in the case of 2D image sequences.
- **Δθ [deg]**: The angular change between the most recent displacement vector (pointing from the previous point to the current point of the track) and the preceding displacement vector, relative to the x-y plane of the image. This quantity is not displayed in the case of 2D image sequences.
Neural circuitry underlying visual and locomotor behaviors
Woods Hole Zebrafish Course – August 14, 2019

Instructors for visual behaviors sections:
Jim Fadool (jfadool@bio.fsu.edu)
John Dowling (dowling@mcb.harvard.edu)

Instructors for juvenile and adult motor behaviors sections:
Michael Granato (granatom@mail.med.upenn.edu)
Jessica Nelson (jessicanels@gmail.com)
Joy Meserve (jhartm12@gmail.com)

Instructors for spinal circuits, fictive swimming and Ca imaging:
Claire Wyart (claire.wyart@icm-institute.org, claire.wyart@gmail.com)
Andrew Prendergast (andrew.prendergast@icm-institute.org, andrew.e.prendergast@gmail.com)
Laura Desban (laura.desban@icm-institute.org, lauradesban@gmail.com)

Overview:
In this part of the course, we focus on the formation and function of neural circuits underlying visual, locomotor and social behaviors. It is therefore important to ask: What are the advantages of zebrafish for studies of neuronal circuits and behavior?

- the transparency of the embryo and larvae, which has made them so useful in screening for developmental defects, also allows for optical studies of their neuronal circuits.
- the simplicity of the nervous system (compared to other vertebrate model systems) and the detailed maps of identified spinal cord and hindbrain neurons allow the study of circuits and behavior at a single cell resolution.
- the extrauterine development facilitates a number of powerful techniques, including single cell recording, labeling of individual neurons and their projections, application of drugs, and lesion experiments using a laser beam or genetically encoded toxins.
- the development of genetic constructs such as channel-rhodopsin and halo-rhodopsin allow for optical activation and silencing of neurons.
- the availability of mutants and transgenic lines and the ease with which they can be generated.
- quantitative behavior measurements of adult fish.

Together, these represent an unparalleled spectrum of techniques available to study the many different aspects of neural circuits and behavior in a single, intact vertebrate.

Overall aim of the laboratory demos and exercises.
The goal of the laboratory work today is to introduce you to some of the approaches to studies of neurons and behavior in zebrafish. Because there is only one day to do this, it will not be possible for you to learn to use all of the approaches on your own. Instead, the exercises will use a combination of demonstrations and hands-on experience with others. Our goals for the day are to: 1) give you a sense of the range of approaches possible for the study of behavior in zebrafish; and 2)
provide you with some of the basics of how the approaches are applied and the questions one can attack with them. This will form a foundation that you can use should you want to apply these approaches in the future.

**Introduction to visual behaviors and retinal development**

Retinal development, laminar organization, circuitry and phototransduction are strikingly conserved among most classes of vertebrate. The clarity of the early zebrafish embryo and relatively large size of the eye and lens make screening for morphological defects of the eye relatively straightforward, and have provided significant inroads into the genetic pathways or cellular functions essential to fundamental processes of retinal development. However, the majority of the earliest published mutations affecting the zebrafish are embryonic or larval lethal and are pleiotropic, whereas inherited diseases of the eye and retina can be congenital (present at birth) or late onset (appearing well after childhood); may be restricted to the retina or associated with a syndrome. These facts suggest that alternative strategies may uncover more subtle defects affecting the visual system.

Zebrafish larvae and adults are highly visual animals. The first visually evoked startle responses are observed 3 dpf. By 4 dpf, many larvae demonstrate an optokinetic reflex (OKR) in response to moving objects, and by 5 dpf, >95% of zebrafish larvae display smooth pursuit and saccade eye movements in response to illuminated rotating stripes (Easter and Nicola, 1996, 1997). The basic function of the OKR is to keep an object stably positioned on the retina while moving through the environment. The robustness of the OKR, the ability to screen young larvae and the potential to vary the assay to detect multiple types of visual system defects led to use by Brockerhoff et al. (1995, 2003) of the OKR as a robust method to identify recessive mutations affecting the visual system in otherwise normal appearing larvae. The assay was subsequently used to screen a collection of 450 mutants previously identified by morphological criteria, of which a total of 25 displayed visual system impairment (Neuhauss, et al., 1999). The assay is rapid, the responses from several larvae can be obtained simultaneously and an entire clutch can be assayed in minutes. Although the rate of isolating mutations affecting the OKR in otherwise normal appearing larvae is several fold less than the frequency of morphological mutants, the benefits are apparent.

One potential drawback of any behavioral screen is isolating the origin of the defect to the region of the CNS of interest, in our case, the retina. Therefore, histological analysis, EM and recording of the electroretinogram (ERG) are routinely applied as secondary screens to distinguish between a retinal defect versus alterations in midbrain nuclei or other structures necessary for the OKR such as the extraocular muscles or the neuromuscular junction. The ERG, however, provides information mainly about the outer retina, but single unit recordings can be made from zebrafish ganglion cells, providing information about inner retinal function.

Even with the wealth of information gained by the analysis of the existing mutations in zebrafish and other model organisms, novel screens for visually-guided behaviors or more subtle cellular alterations continue to reveal mutations not detected by other assays. Just as the OKR
offered a clear advantage over morphological screens for detecting some types of visual deficits in otherwise normal larvae, other well thought out assays can uncover additional phenotypes. The OKR is largely mediated by cone responses therefore it is likely that mutations specifically affecting rods were not detected in the previous larval screens. Modifying the parameters of the OKR may uncover alterations in retinal circuitry and inner retinal neurons. The growing number of transgenic lines demonstrating retinal-specific expression of fluorescent reporter genes or markers of specific cell types has enable more subtle, cell-specific defects to be uncovered (Perkins et al., 2002; Alvarez-Delfin, et al., 2009).

Introduction to larval locomotor behaviors

Understanding how neural circuits form and then function to allow for organisms to interpret their surroundings and behave appropriately is a daunting task. Notwithstanding, dissecting the genetic program that dictates how neural circuits modulate motor behavior through sensory perception, cognitive processing, and motor output is one of neuroscience’s most studied yet least understood questions. Recent studies have demonstrated the suitability of adult zebrafish to model aspects of complex behavior, such as reward, learning and memory, aggression, anxiety, shoaling and sleep (Spence et al., 2008; Mathur and Guo, 2010; Norton and Bally-Cuif, 2010; Sison and Gerlai, 2010), and genetic screens for drug addiction and visual behavior have been successfully executed in adults (Li and Dowling, 1997; Darland and Dowling, 2001; Webb et al., 2009). The growing characterization of adult zebrafish behavior and the expanding repertoire of adult behavioral assays represent an exciting opportunity to model complex, higher-level behaviors and neuropsychiatric disorders. However, using adult zebrafish for behavior-based mutagenesis screens introduces many of the same problems that plague screens on adult rodents: behavioral complexity and experience-based variability, mutant viability to adulthood, and less accessible and more complicated underlying circuitry.

Zebrafish larvae 5-7 days old offer a very streamlined approach to dissecting and characterizing the neural substrates of behavior through forward genetic screening (Burgess and Granato, 2008). Many of the early, stereotyped behaviors reflect the “hard wiring” of the nervous system and provide an opportunity to understand genetically specified behavior, while minimizing the influence of experience-based remodeling and increased behavioral variability at adult stages. By the end of their first week of life, larval zebrafish already possess a significant repertoire of stereotyped motor behaviors that allow them to navigate their environment. Larvae engage in slow (‘scoot’) and fast (‘burst’) swimming bouts, and a variety of unique turning behaviors with specific kinematic properties that distinguish each maneuver (Budick and O'Malley, 2000; Muller and van Leeuwen, 2004; Gahtan et al., 2005; McElligott and O'Malley D, 2005; Burgess and Granato, 2007a, b). Moreover, larvae execute sensory directed locomotion by moving their bodies, fins, eyes and mouths in a coordinated manner in response to acoustic, tactile, olfactory, and visual stimuli. Capturing larval locomotor behavior using high speed video cameras at 1,000 frames per second reveals that larvae execute relatively simple ‘one behavior’ sensorimotor responses, for example the optokinetic eye saccade (Clarke, 1981; Neuhauss, 2003), the acoustic startle C-bend turn (Kimmel et al., 1974; Eaton et al., 1977; Burgess and Granato, 2007b), or the dark flash induced O-bend turning behavior (Burgess and Granato, 2007a), as well as more complex behaviors, such as
optomotor behavior, phototaxis, and prey capture (Table 1 and (Clarke, 1981; Brockerhoff et al., 1995; Orger and Baier, 2005; Burgess et al., 2010). These more complex larval behaviors are comprised of a sequence of individual, stereotyped behavioral routines or episodes that can only be distinguished with high temporal resolution imaging (~1,000 frames per second). For example, prey capture of paramecium involves eye movements to visualize the prey, subsequently executing a series of J-bend or routine turns to align the prey with the longitudinal axis of the larvae, and then initiating a forward swim culminating with an oral capture of prey (Borla et al., 2002; Gahtan et al., 2005; McElligott and O'Malley, 2005). Since genetic analysis of behavior includes assignment of genetic function within the underlying circuit, it is critical to analyze behaviors with identified circuitry on an individual basis rather than complex behaviors on the whole.

Recently, genetic screens for complex larval behaviors such as habituation learning have been conducted. Habituation is a fundamental form of non-associative learning, characterized by progressive response decline to repeatedly experienced, yet inconsequential stimuli to filter irrelevant input and prioritize attention (Groves and Thompson, 1970; Rankin et al., 2009). Despite its simplicity, habituation is an attractive form of learning because it provides a quantifiable form of neuroplasticity (Poon and Young, 2006). Deficits in habituation represent hallmark features of human cognitive and behavioral disorders, including schizophrenia, addiction, attention deficit hyperactivity disorder, and other disorders marked by “intellectual disability” (Braff et al., 1992; Jansiewicz et al., 2004; McSweeney et al., 2005).

Inspired by behavioral screens in *Drosophila* and *C. elegans* (Benzer, 1967; Brenner, 1974; Eddison et al., 2012; Ikeda et al., 2008; L'Etoile et al., 2002; Lau et al., 2012; Pierce-Shimomura et al., 2008; Rankin, 2004; Rankin et al., 1990; Swierczek et al., 2011; Wolf et al., 2007), the Granato lab performed a forward genetic screen using a high throughput behavior testing apparatus that measures zebrafish startle habituation (Wolman et al., 2011), and then applied whole genome sequence (WGS) analysis to molecularly identify the mutated genes. This revealed genes with ‘expected’ functions such as the pyruvate carboxylase a (pcxa) gene, which encodes a rate-limiting enzyme in the production of the glutamate (Hertz et al., 2007), a key neurotransmitter for habituation learning (Bespalov et al., 2007; Bickel et al., 2008; Riedel et al., 2003; Rose and Rankin, 2006). Conversely, the screen identified genes previously not implicated in learning, such as the vertebrate specific gene pregnancy associated plasma protein-aa (pappaa). PAPP-AA is known to act as an extracellular metalloprotease to enhance local insulin like growth factor (IGF) signaling by cleaving IGF binding protein 4 (IGFBP4), which normally restricts IGF from signaling through cell surface IGF receptors (Conover et al., 2004; Laursen et al., 2007; Laursen et al., 2001; Lawrence et al., 1999). Using a combination of molecular-genetic, pharmacological and behavioral analyses, we uncover a previously unknown role for PAPP-AA regulated IGF signaling in mediating habituation learning through an acute and presumptive local mechanism. Overall, our results define the first in vivo function based set of genes regulating vertebrate habituation learning.

**Introduction to adult locomotor behaviors**

The study of neuroscience and behavior in zebrafish is dominated by studies performed at the larval stage. This is mostly due to their small size and the optical accessibility of zebrafish brains at these transparent stages. But, as zebrafish grow, their behaviours become increasingly
complex, including associative conditioning, shoaling, fighting and mating (Norton and Bally-Cuif, 2010). We have little understanding of the neuronal underpinnings of these more complex behaviours.

Developing systems to quantify adult behaviour may require more sophisticated strategies than those necessary to understand larval behaviour. One challenge is that while 2D recordings of larval zebrafish behaviour may be sufficient to capture most of their behavioural repertoire (Marques et al., 2018), adult zebrafish clearly explore the full 3D environment of their tanks. Therefore, researchers are increasingly turning to systems that can quantify behaviour using multiple cameras to reconstruct full 3D movements of adult zebrafish (Macrì et al., 2017; Stowers et al., 2017). Today, we will outline a system we are developing to track adult zebrafish using two cameras. We will show examples of the behaviors we can study using this system.
Station 1: Mutations affecting visual behavior and retinal anatomy

The development of behavioral assays to detect visual system deficits in zebrafish may hold the greatest potential to contribute to our understanding of retinal function and visual system processing. The OKR was first utilized by Brockerhoff to assay for visual system defects in otherwise normal appearing larvae. By varying the stimulus from bright to dim white light or using a long-wavelength illumination, subtle defects affecting specific aspects of photoreceptor function, single photoreceptor cell types, synaptic activity or biochemical pathways have been isolated (Brockerhoff et al., 1995, 1997, 2003; Allwardt et al., 2001). Computer assisted image analysis can be applied to quantify specific parameters of the eye movement and detect subtle changes in the response (Rinner, Rick and Neuhauss, 2005). And continued refinement of the paradigm has enabled evaluation of motion detection, color discrimination and higher order processes. The visually mediated escape response was developed as an assay to quantify visual sensitivity as a potential tool to detect retinal dystrophies in adult zebrafish (Li and Dowling, 1997) however that will not be demonstrated here.

1. Exercise:
To conduct the OKR, larvae are immobilized in a petri dish containing 3% methylcellulose and placed on a stationary pedestal in the middle of a rotating drum lined with vertical stripes. Rotating the drum elicits eye movements in the direction of the rotation of the stripes. Although the rate of isolating mutations affecting the OKR in otherwise normal appearing larvae is several fold less than the frequency of morphological mutants, the benefits are apparent. By varying the stimulus from bright to dim white light or using a long-wavelength illumination, subtle defects affecting specific aspects of photoreceptor function, single photoreceptor cell types, synaptic activity or biochemical pathways have been isolated.

Optimize parameters:
Students will work at the OKR stations. Each station consists of a stereoscope to mount and orient the larvae in the methycellulose, an OKR apparatus, video camera and monitor. First, the OKR will be examined in wild-type larvae at 5 dpf. These larvae typically give a robust response. Using a transfer pipette, move 4-6 larvae from the petri dishes to a 30 ml beaker containing methyl cellulose (3%) and while viewing the larvae through the stereomicroscope use a dissecting needle to orient the larvae. Mount the beaker using the clamp and position within the drum of the OKR apparatus. Using the rheostat, turn the drum speed to low. Watch for the characteristic movement of the eyes in the direction of the revolving drum, the pursuit, and observe the return to the original position, the saccade. Using the toggle switch, change the direction of the drum and observe the direction of the eye movements. Slowly increase the drum speed until the response by the larvae drops off. The screen is conducted using parameters in which 90-95% of the larvae respond. Other parameters that can be tested are the thickness of the stripe width, additional patterns and light intensity. Use the optimal parameters to test the robustness of the response in larvae of different ages.

Screen for larvae with visual system defects:
Use the optimal parameters to screen the provided samples for larvae homologous for mutations that affect the OKR. In the chart below, record the Cross ID, number of embryos screened, any
observable morphological phenotype and number with an altered OKR phenotype. Remember, in a third generation mutant screen, 25% of the larvae would be expected to be non-responders. Change parameters to test if that will elicit a response in the non-responders. A simple control must be done with no stripes on the drum.

a. Getting Started:
1. At each station, petri dishes, beakers, methyl cellulose, dissecting needles and transfer pipette are provided
2. Collect 5-6dpf larvae from the common dishes
3. Immobilize and orientate larvae in methyl cellulose in small beaker
4. Position beaker in drum
5. Using video camera, center beaker on monitor for viewing larvae

b. Establish parameters for robust responses using 5-6 dpf Wild-type larvae
1. test stripe width
2. change drum speed
3. adjust light intensity
4. test optimal parameters on larvae between 3-7 dpf

c. Mutant analysis-Screen larvae from the demo crosses
1. Score the larvae for morphological phenotypes
2. Use the optimal parameters to test OKR. What types of deficits did you observe?
3. Change the parameters in an attempt to elicit a response in all larvae
OPTIONAL: In addition to behavioral assays, the systematic screening of adult and late-larval-stage zebrafish for dominant and recessive mutations affecting retinal anatomy provides additional models of highly specific developmental defects or retinal dystrophies observed in the clinic. These methods are also used as a secondary screen following the OKR to narrow the cellular origin of the visual system defect. These phenotypes can be as simple as reduced eye size but others are only evident by observing alterations of expression of retinal specific transgenes or in situ labeling patterns. To view the internal structures of the eye, embryos and larvae are reared in a solution of PTU to inhibit pigmentation of the RPE. Wildtype and mutant larvae carrying transgenic lines or immunolabeled with cell specific markers will be available for you to identify cell types of the retina and identify mutations affecting retinal patterning. Many are of the same mutations you scored using the OKR.

d. Screening larvae for altered transgene expression:
   1. Larvae in 60mm petri dishes are anesthetized with MS222 and observed under the fluorescent stereo scopes. Following are a series of simple questions to ask:
   2. What is the pattern of expression of the transgene in the majority of the larvae? Identify the larvae with the altered expression pattern and compare to wildtype.
   3. Many zebrafish mutations lead to cell death. Do you observe a gain or loss of expression?
   4. Are their observable changes in other retinal cell types?
Station 2: High speed imaging of larval behavior.

Reflexes were long thought to be simple and invariant reactions to stimuli. It is now clear that reflexes are not fixed, but they are highly modifiable, dependent on the context. In fact, modifications of specific motor reflexes are now critical paradigms in identifying the neural mechanisms underlying sensory information processing, learning and memory, as well as CNS function and motivation. Additionally, modulations in motor responses can provide insight into cognitive dysfunction and drug addiction. In zebrafish, a well-characterized motor reflex is the startle response, which, as in mammals, can be modulated by environmental context. To study the startle response in zebrafish larvae, we use digital high-speed video technology. Compared to a standard video camera, which collects a frame every 33 milliseconds, standard digital high-speed cameras can image at adjustable rates above 2,000 frames/second (or 0.5 millisecond per frame). To introduce you to this technology and to the startle response, we will use a high-speed digital camera to:

1. Observe and compare the human with zebrafish startle response.
2. Perform a simple learning experiment using the zebrafish startle response.
3. See an example of automated imaging processing of the movements using freely available software (FLOTE) developed in the Granato lab (Burgess & Granato, 2007).

Details of cameras:

During the day we will use high-speed cameras from Photron(UX50). This systems can record in 2 ways: 1) record a set number of frames in “bursts” every time the camera is triggered, or 2) constantly collecting frames at high speed into a “circular” memory buffer. The buffer can accumulate several thousand frames depending on the resolution of imaging. New frames entering the buffer replace the oldest frames. Thus if you collect at 1,000 frames/second with a 32,000-frame buffer, then at any instant in time the buffer has images (one every millisecond) of the previous 32 seconds of the behavior being imaged.

Lab Exercises:

1. How fast is the startle response in fish compared to the response in humans?

One of the earliest components of the human startle response is the eyeblink reflex. We will pop a balloon and measure the latency to the beginning of the eyeblink. Next we will use an acoustic stimulus to startle 5 dpf zebrafish larvae. Just by using your eyes, you will not be able to ‘see’ all the details of the startle response, not even with a regular video camera. But with the high-speed camera, we can easily determine kinematic parameters, such as the latency of the startle response or the duration/speed of the startle response.

a. Your job is to use the high-speed camera in order to determine which is faster - the human startle response, or the zebrafish startle response. Image the human response at 1,000 frames per second with plenty of lighting (you can use the camera lens provided mounted in a tripod to observe the
b. Now go to the zebrafish larvae. Film at 1,000 frames per second and expose the 5 dpf zebrafish larvae to an acoustic stimulus using the shaker. How many milliseconds does it take the larvae to initiate and perform their initial turn? How does this compare to the human startle? You will see why high-speed cameras are needed.

2. Habituation (non-associative learning) of the larval zebrafish acoustic startle response

In response to experiences with their environment, organisms constantly update their behavior through the processes of sensorimotor integration and learning. The parameters and rules for acquiring and storing learned information are quite similar across diverse species from *C. elegans* through mammals, suggesting conservation of the underlying molecular mechanisms. A simple form of learning is non-associative learning, which is defined as a change in attention directed towards a stimulus. The startle reflex is stereotyped but highly modifiable, such that repeated presentation of startling stimuli suppresses the startle response. This decrease in attention towards an irrelevant stimulus is called **habituation**. In humans, habituation deficits have been identified as a major feature of several cognitive disorders, including schizophrenia. Despite its general importance, the molecular mechanisms that drive learning, including habituation, are poorly understood. Zebrafish show a remarkable capacity for behavioral plasticity, and we find that larvae exhibit non-associative learning (short-term habituation) with landmark behavioral and pharmacological characteristics. Today we will perform a simple set of experiments to show how larvae habituate to acoustic startle stimuli.

The speed at which an animal habituates to a stimulus can depend on the interstimulus interval (ISI). We can test this using an automated, computer-controlled system. To perform this experiment, pipet 1 fish into each well of the 6x6 grid on the behavior set up. We will control the stimuli using a National Instruments Digital Acquisition Device (PCI-6221 DAQ), which both triggers the camera to record and activates a mini-shaker (in this experiment) or lights at synchronized intervals to allow precise calculation of response latency. To facilitate high throughput behavioral analysis, we use custom freely available software that automatically measures and analyzes the movements of the fish (FLOTE, more information at http://ubn.nichd.nih.gov/flote.htm). The FLOTE package can locate each recorded larva and then identify the movement patterns performed based on their kinematic properties in an observer-independent way. The ability to do such automated processing permits the analysis of thousands of responses an hour and enables us to average out the inter-individual and inter-trial variability.

To test habituation of your fish, first, give 10 taps with an ISI of 20 seconds. What percent of larvae respond to the first tap? What about to the last tap? Next, give 10 taps with an ISI of 1 sec. Now what percent respond to the first tap? To the last tap? If time permits, repeat the experiment with different ISI, always starting with a long ISI to give a baseline for responsiveness. Remember, once you’ve tested fish and they’ve habituated, you won’t be able to test them again right away!
Station 3: High speed imaging of adult behaviors.

In this station we will demonstrate a system we are developing to track adult zebrafish using two cameras and how we can observe adult behavioural responses to various stimuli.

To record adult behaviour, we use two cameras. One of the cameras observes the top-down perspective, while the other acquires images from the side. In this way we can track the position of the animal in the full X/Y/Z coordinates. These cameras can record up to 400-frames per second, giving us good temporal resolution when trying to identify behavioural events. In this section we will demonstrate how we can acquire high-speed movies of adult fish behaviour, how we can track the animal using machine vision software, and how the behaviour of the fish changes as we present different stimuli.

1) Recording free behaviour

Open the camera acquisition software. Take one adult fish and place it in a tank. Take a 1 minute recording of the fish swimming around in the tank. Wait 15 minutes (proceed to tracking and step 2 in the meantime...). After 15 minutes take a second 1 minute movie. Does the behaviour of the fish seem to change over this time period? How does it seem to change? Think about what you might want to quantify in such videos.

2) Tracking 3D trajectories

To track the fish in the movies we will use some software we have written in Python, but first we will explore the data using FIJI/ImageJ.

- Open the two videos you recorded of the fish behaviour. Note that the fish appears as a dark blob.
- Make a minimum intensity Z-projection (Image -> Stacks -> Zproject -> Minimum Intensity). This will show us the tracks of the fish throughout the videos.
- Now take a maximum intensity projection - this will do the opposite of above, and the fish will disappear into the brighter background.
- Take this maximum intensity projection, and create a stack of duplicated images that has the same number of frames as the original video (n frames). Use Image -> Stacks -> Tools -> Stack sorter. Then ‘duplicate n’ and enter n-1.
- Now you can use this stack to make a “background subtracted” version of the movie. Use Process -> Image calculator, and subtract the original movie stack from the maximum intensity projection stack. If this works properly, the result will be the fish visible as a bright blob, while the rest of the background of the image will disappear (if it doesn’t work properly, try switching around the subtraction).
Thresholding these background subtracted images is the basic principle behind many tracking software packages, including the one we use in Python.

To track the movies open the tracking software, and input the two videos of the fish that you have recorded. This software identifies the position of the fish in both the top-down (x/y) camera view, and the side-on (x/z) view. From these two views we can identify the 3D (x/y/z) coordinates of the fish, and track it through time. Here we will just look at the trajectories of the fish, but such data can be used to extract many more relevant quantitative parameters of behaviour -- speed, movement frequency, diving, rising, pauses, wall proximity, depth, etc.

Compare the trajectories of the fish from the first recording, and the recording 15 minutes after acclimatization to the tank. Do there seem to be differences? What parameters might you want to extract from the data to identify differences in these conditions?

3) Tracking stimulus responses.

We can experiment by taking videos while presenting different stimulus conditions. Some things you may want to try include:

- Using the tapper to induce an acoustic escape response.
- Tapping repeatedly to see if the fish will habituate.
- Adding fish extract to induce the “alarm pheromone” response
- Simulating a predator by quickly approaching the tank (or using their natural lab predator -- the dreaded fish net).
- Feeding the fish
- Placing a novel object in the tank
- Placing a mirror along the side of the tank to simulate a neighbouring fish
- Whatever else you can think of!

Explore these movies using FIJI/ImageJ and the tracking software. What do these fish do when you stimulate them? How consistent is this effect if you look in different fish?
Station 4: Analysis of activity of motor neurons in living embryos and larvae during fictive motor behaviors.

Locomotion relies on the patterned recruitment of motor neurons in the spinal cord enabling the precise contraction of muscle fibers along the body of the animal. In contrast to Mauthner cell, which that fires a single action potential, motor neurons fire burst of action potentials whose frequency will determine the amplitude of muscle contraction.

The precise identify of the motor neurons activated will condition the type of muscle fibers recruited. Motor neurons in the spinal cord are recruited along the size principle (Henneman et al., 1965): while small motor neurons are recruited for small inputs from the descending commands from the brain, project onto slow muscle fibers and are typically recruited for slow swimming; large motor neurons require large inputs from descending commands from the brain and project onto fast muscle fibers and are typically recruited for fast swimming. In zebrafish, the organization of motor neurons follow a topographical map from ventral to dorsal (McLean et al., Nature 2007).

In this station, we will study the timing and amplitude of calcium transients in populations of motor neuron during different motor behavior. As the amplitude of the calcium transients correlates with the intensity of firing of the motor neurons during a burst, we will quantitatively analyze for different types of motor neurons in a segment the start and end of their activity and the intensity of their recruitment.

a) Study of motor neuron activity underlying twitches in the zebrafish embryo: effects of blue light!

At 24 hpf, zebrafish embryos initiate the first contractions of their body referred to as “twitch”. These contractions rely on the synchronous activity and alternation of one primary motor neuron for each segment on each side of the animal. The burst firing of primary motor neurons leads to massive calcium transients that we can monitor using the fluorescent genetically-encoded calcium sensors GCaMP (see Warp et al., Current Biology 2012). After performing analysis of single calcium transients from Mauthner cell in Station 4, you will now analyze the signals of populations of neurons. Dechorionate the embryos. Mount 3 embryos on a dorsal view to image motor neurons on each side and 3 embryos on a lateral view to monitor primary motor neurons from one side. After the agarose has solidified, place a drop of water on top of it and use the 20X or 40X water dipping lenses to screen through your mounted embryo to find in the plan multiple primary motor neurons from at least 3-4 subsequent segments in the spinal cord.

You will prepare 24 hpf old transgenic Tg(s1020t:gal4; UAS:GCaMP6f) embryos to monitor activity of primary motor neurons during fictive spontaneous twitching when the embryo is paralyzed (see Warp et al, Current Biology 2012). You will compare across populations of neurons: - Dorsally-mounted embryos: the activity of primary and secondary motor neurons along the spinal cord, and analyze the differential recruitment of primary neurons on the left and right side of the body; - Laterally-mounted embryos: the activity of different motor neurons within a segment.
Using a custom script in Matlab, you will analyze calcium transients in population of motor neurons: analyzing the time to start, to end and the amplitude of the calcium transients as a function of the identify (secondary versus primary) of the motor neurons recruited.

Second, it was previously shown that zebrafish embryo express valopa, an opsin which silences motor activity upon reception of blue light (Friedmann et al., Current Biology 2015). You will illustrate this effect by monitoring the spontaneous twitching of the zebrafish embryo at different power of the 488nm laser. Students will analyze whether the intensity of the blue laser light affects frequency (reflecting occurrence of burst firing) and/or amplitude (reflecting the frequency of firing during a burst) of the calcium transients observed in primary motor neurons.

b) Study of motor neuron activity underlying escapes in the zebrafish larvae

At 4.5dpf, zebrafish larvae need to explore the environment to look for food as well as to escape from predators. Here we will investigate the recruitment of motor neurons when the larva spontaneous swims versus when it escapes from a predator.

You will perform calcium imaging on 4-6 dpf old transgenic Tg(mnx1:GCaMP5G) larvae to monitor activity of primary and secondary motor neurons during fictive escapes when the larvae is paralysed (see Knafo et al, eLife 2017). Mount 5 larvae on their lateral side. Acoustic escape will be induced by using speakers attached to the dish or via a puff in the otic vesicle coupled to the fish for which we will need a picospritzer and pipettes to eject external solution on the ear.

Using a custom script in Matlab, you will analyze calcium transients in population of motor neurons: analyzing the time to start, to end and the amplitude of the calcium transients as a function of the identify (secondary versus primary) of the motor neurons recruited. We will focus on acoustic escapes that we will compare to visually induced burst swims and spontaneous swims (see Mirat et al., Frontiers in Neural Circuits 2013; Marques et al., Current Biology 2018).

We will go over the calculation of the DF/F for each neuron in a population and illustrate the problem of defining the background in streaming acquisitions coming from a spinning disk when the density of GCaMP expressing cells is high.

Check on endogenous opsins:
You will verify that in zebrafish larvae blue light does not affect swimming by recording activity of motor neurons at different power of the 488nm laser. Students will analyze whether the intensity of the blue laser light affects frequency (reflecting occurrence of burst firing) and/or amplitude (reflecting the frequency of firing during a burst) of the calcium transients observed in motor neurons.

If time permits:
Induce seizures in zebrafish larvae by adding the drug PTZ to the bath and monitor the activity of motor neurons associated with seizures. Compare these patterns of activity to what you have measured for escapes, visually mediated burst swims or spontaneous slow swims.
In Vitro Fertilization Lab
Sharon Amacher

While zebrafish are generally very easy to breed in natural crosses and are highly fecund, sometimes it is convenient or necessary to generate embryos by in vitro fertilization (IVF). For example, IVF is useful if you wish to cross a quarantined fish with a fish in your main facility, or if fish you want to cross have stopped breeding in natural matings, or if you need to recover a mutation from frozen sperm, or if you want large numbers of highly synchronized embryos, etc. As you will discover in this practical, IVF with fresh gametes is very easy: sperm is collected and held on ice in in buffered Hanks solution and pipetted onto squeezed eggs. Sperm collected in this way and kept on ice keeps its fertility for several days if necessary, though usually it gets used the same morning it was collected. The procedure was developed by Charline Walker at the University of Oregon and is exactly as described in Chapter 2 of The Zebrafish Book: http://zfin.org/zf_info/zfbook/zfbk.html. A detailed protocol is found on the following pages.

Although maintaining zebrafish in large numbers is relatively inexpensive for a vertebrate, zebrafish researchers are increasingly able to generate far more mutant and transgenic lines than is possible to maintain as live stocks in the average zebrafish facility. Fortunately, zebrafish lines can be preserved as frozen sperm in liquid nitrogen for many years. The protocol that is appended in the supplemental course manual was developed in ~2002 in preparation for freezing 10,000 sperm samples for the Moens Lab TILLING project (Draper et al., 2004 PMID:15602907, Pan et al., 2015 PMID:25886285). The sperm that the Moens lab froze between 2002 and 2003 is still fertile in 2018. As a rule, the Moens lab does a big sperm freeze twice a year to archive all the mutants and transgenic lines that were generated in the previous six months. They try to freeze at least 5 pairs of vials (kept in two separate liquid N2 freezers) per mutant or transgenic lines.

A video version of the sperm freezing and IVF protocols was published by JoVE (PMC2785217). Since many of the steps are the same for regular IVF with fresh sperm and eggs as for IVF with frozen sperm, you can watch the video to remind you of the regular IVF protocol that we will do together in class.

The Moens sperm cryopreservation protocol was further developed with some modifications at the Zebrafish International Research Center (ZIRC) and is available on their Protocols page: http://zebrafish.org/documents/protocols.php

What you will find in the course manual:
(1) This overview page
(2) IVF Protocol (this morning, you will begin on p. 3, “The IVF Process”)

What you will find in the supplement:
(1) Sperm freezing protocol
**IN VITRO FERTILIZATION**

Stock solutions .................................................................................................................................................. p. 1
IVF preparation .................................................................................................................................................... p. 2

The IVF process
What you need ...................................................................................................................................................... p. 3
MESAB Hazards and tips ...................................................................................................................................... p. 3
Extracting sperm .................................................................................................................................................. p. 3
Extracting eggs .................................................................................................................................................... p. 4
Fertilizing eggs .................................................................................................................................................... p. 5
Ordering information .............................................................................................................................................. p. 5

**REAGENTS TO GATHER ON THE MORNING OF THE PROCEDURE**

- Autoclaved RO water
- Hank's Premix
- MESAB (aka Tricaine, MS-222)
- 0.35 g sodium bicarbonate in 15 ml conical (dry)

### Recipes

**Hank's Premix**

Combine the following in order:
- 10 ml Solution #1
- 1 ml Solution #2
- 1 ml Solution #4
- 86 ml ddH2O or autoclaved RO H2O
- 1 ml Solution #5

**Hank's Stock Solutions:**

<table>
<thead>
<tr>
<th>Stock #1</th>
<th>Stock #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 g NaCl</td>
<td>0.358g Na2HPO4 Anhydrous</td>
</tr>
<tr>
<td>0.4 g KCl</td>
<td>0.60g KH2PO4</td>
</tr>
<tr>
<td>in 100 ml dd H2O</td>
<td>in 100 ml ddH2O</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stock #4</th>
<th>Stock #5</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.72g CaCl2</td>
<td>1.23g MgSO4x7H2O</td>
</tr>
<tr>
<td>in 50ml ddH2O</td>
<td>in 50 ml dd H2O</td>
</tr>
</tbody>
</table>

**25x MESAB stock solution (will be diluted to 1x in fish water for fish anesthesia)**

0.4g MESAB (Ethyl 3-aminobenzoate methanesulfonate)
0.8g Na2HPO4 anhydrous
into 100ml RO water

- Store Hank's Premix, Hank's stock solutions, and MESAB stock solutions in refrigerator
- Note: Hank's Premix becomes “Hank’s” when bicarb is added the morning of the experiment
**IVF Preparation**

*Note: Perform IVF only on adult fish (> 3 months). Wait at least 3 weeks before performing IVF again. After IVF, fish may be used in natural crosses after one week.*

### Afternoon prior:
Separate males and females into different containers and label appropriately. Set up IVF materials. Prepare fresh stock solutions if needed.

*For sperm collection, lay out the following:*
- Male “pillows” (or “cushions”)
- Microcaps (20 ul size) capillaries
- Rubber bulb (from Microcaps package) or mouth aspirator apparatus
- Blunt end forceps
- Eppendorf tubes or other sperm collection vessels (1 eppie for each sperm type)
- Kimwipes

*For each IVF station, also lay out:*
- Small stack of paper towels
- Plastic spoon
- 1-2 spatulas (2 spatulas if you want to divide large clutches into two or more dishes)
- 250 ml beaker for MESAB (Tricaine/MS222)
- Finger bowl
- P20 pipetman and tips
- 250 ml beakers, for housing individual fish (i.e., if the purpose of the experiment is to genotype)
- 35 mm dishes
- 2L flask (with 25 ml and/or 10 ml pipette) or squeeze bottle containing system water

### Morning of the IVF:

**Bring:**
- Ice bucket full of ice
- 0.35 g sodium bicarbonate aliquot in 15 ml conical

**Prepare:**
- *Hank’s stock #6:* Add 10 ml autoclaved RO to 0.35 g bicarb aliquot (Must be prepared fresh!)
- *Hank’s (final) mix:* Add 0.1 ml Stock #6 to 9.9 ml Hank’s Premix in 15 ml tube. Store on ice.
- *MESAB (working concentration):* In a 250 ml beaker, combine 4.2 ml 25X MESAB stock solution into 100 ml system water
The IVF Process

HAVE ALL SUPPLIES READY BEFORE STARTING

In your ice bucket you need:
- Hank’s (= Hank’s Premix with bicarb added morning of the procedure, see previous page)
- Labeled 1.7 ml eppie tubes. Add 50 ul of Hank’s to each tube (or 1 drop from a glass pasteur pipet). After sperm collection, you can add more Hank’s to further dilute the sperm sample if necessary.

For sperm extraction you need:
- Male fish, separated from females the night before
- Net
- MESAB beaker, at working concentration
- Spoon
- Finger bowl filled with system water
- Male pillows, dipped in system water and squeezed until they are slightly dampened but not wet. If a pillow gets too wet, you may need to occasionally re-squeeze to expel excess water.
- Kimwipes
- Microcaps capillary tubes
- Microcaps bulb or mouth aspirator
- Blunt end forceps

For egg extraction you need:
- Female fish, separated from males the night before
- A short stack of paper towels
- 2 metal spatulas per person
- 35 mm dishes
- Sharpie to label the dish
- Some of the items from sperm extraction station: net, MESAB beaker, fingerbowl, spoon

MESAB hazard warnings and tips:
- Do not over-anesthetize. Place only the number of fish into the MESAB beaker that you can process immediately after they “go out”. Extract sperm and expel eggs from fish in the order that they are anesthetized.
- When placed in the anesthetic, gill movement will initially be rapid, then it will slow gradually until it is barely perceptible. The fish is ready at this point.
- Avoid transferring water from the net into the MESAB beaker when adding fish. As the morning progresses it will take longer for the fish to become anesthetized if the anesthetic is diluted.

**Note:** Water activates both sperm and eggs. You want to prevent activation until you combine sperm and eggs, so avoid water contact with sperm and eggs during collection.

Extracting sperm from males:
- Net males and place them into the MESAB beaker. The number of fish you anesthetize (1-4 fish) should correlate with your skill and on whether you are working with a partner.
- Remove one fish at a time from the anesthetic with a plastic spoon, scooping from head to tail to avoid catching and injuring the gills.
- While still in the spoon, dip the fish into the finger bowl filled with system water to “rinse” the fish.
- Carefully place the fish belly side up into the slit of the foam pillow.
- Gently pat belly dry with a Kimwipe.
- Place fish under the microscope with good incident (overhead) lighting.
• If right-handed, it is easiest to place the fish with the head to the left. Hold the forceps in your left hand and the microcaps collector in your right hand. Reverse if you are left-handed.
• Using forceps, spread apart the pelvic fins to reveal the urogenital opening. (If the spot seems larger than usual and/or you can see capillaries, you probably have a female.)
• Insert a fresh microcaps capillary into the rubber bulb or mouth aspirator device. Extract sperm by placing the tube against (not into) the urogenital opening and gently depressing the sides of the fish a few millimeters before the pore with forceps. Sperm will enter the capillary via capillary action or by slight mouth aspiration.
• Expel sperm into a labeled tube containing ice-cold Hank’s by covering the hole at the end of the rubber stopper and squeezing the rubber bulb while the capillary is in the liquid.
• Put the male back into a recovery tank (or labeled beaker if genotyping).
• Repeat procedure for the next male. If you are extracting sperm from fish from the same stock and genotype and pooling sperm, you can re-use the capillary for several fish. Remember to change the capillary between fish of different genotypes.
• Sperm should look cloudy once it has dispersed into the Hank’s. If the sperm solution is very cloudy, you can add additional Hank’s to dilute the sample. Guideline: 50 ul Hanks for sperm from 1 male; 250 ul or more for sperm from 5 males. A good sperm sample from 1 male can fertilize many clutches. Store tubes of sperm on ice.

Extracting eggs from females:
• Net females and place them in the beaker of anesthetic. The number of fish you anesthetize (1-4 fish) should correlate with your skill and on whether you are working with a partner.
• Remove one fish at a time from the anesthetic with a plastic spoon, scooping from head to tail to avoid catching and injuring the gills.
• While still in the spoon, dip the fish while still in the spoon into the finger bowl filled with system water to “rinse” the fish.
• Place fish on a stack of paper towels.
• Using spoon, gently roll the fish over a few times on the paper towel to dry her off.
• Place fish into dish on its side with its head pointing towards you and belly pointing toward your dominant hand.
• Dip both pointer fingers into finger bowl and wipe off excess water. You want your fingers just damp enough so that they don’t stick to the fish and pull off its scales, but not too damp so that you drip water into the dish.
• If right-handed, use your left pointer finger to brace/support the back of the fish. Then, with your right pointer, gently press the fish’s belly and stroke/move your finger along the belly in the direction of the fish’s scales toward the urogenital opening. If left-handed, do the opposite.
• If the female has eggs, you will see a yellow round ball extruding from the opening, followed by a steady stream of eggs. Once eggs begin coming out, you do not need to press any harder, but just maintain the same pressure until the flow of eggs slows or stops.
• Do not press too hard. This will cause internal damage or organ extrusion.
• A good rule of thumb is that 1 in every 3 females will give good eggs. Some days are better, some worse. Some people “prime” the females by housing them the night before in the same container with males, separated by a divider to prevent mating.
• Once eggs are extruded, work relatively fast to prevent them from drying out.
• Assess egg quality. A good clutch will be a cohesive cluster of light yellow to dark yellow pearls with only a small amount of extruded liquid. A bad clutch can vary in appearance, but will often be pale or white and irregular and small in shape, with excessive fluid, often containing white flocculent material. A “mixed” clutch will have both. Fertilize only good (sometimes mixed) clutches.
- Use a dry spatula to gently scrape the eggs off the belly and underside of the fish.
- Lift the female out of the dish with the spatula and place her in the recovery vessel. Cover the eggs right away to prevent drying.
- If you wish to fertilize eggs from one female with two different samples of sperm, carefully divide the eggs using two metal spatulas and move half to a clean dish.

**Fertilizing eggs:**
- Using a P20 pipetman, add \(~10\) ul of sperm to the pile of eggs. (If you are running low on sperm, you can use less. If you think the sperm is too dilute, you can use more).
- Add a small volume of system water (~500 ul) to activate the fertilization process.
- Label the dish!!!
- After 1-2 minutes, you can add more system water to fill the dish. It is fine to wait longer to flood the dish as long as the fertilized eggs don’t dry out.

**Note:** Fertilize each clutch as soon as possible after eggs are expelled from the female. There are methods to “hold” eggs before fertilization using salmon ovarian fluid or solutions with high protein content. For example, see Sakai et al (1997) Delayed in vitro fertilization of zebrafish eggs in Hank’s saline containing bovine serum albumin. Mol Mar Biol Biotechnol 6:84-7.

### Catalog Numbers for IVF Supplies

Always verify catalog numbers before ordering.

<table>
<thead>
<tr>
<th>Use</th>
<th>Catalog Description</th>
<th>Manufacture &amp; Catalog #</th>
<th>Fisher Scientific Catalog #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capillary tubes used for sperm extraction, rubber stopper/dropper included</td>
<td>Microcaps 20 Lambda</td>
<td>Drummond #1-000-0200</td>
<td>#21-170G</td>
</tr>
<tr>
<td>Mouth aspirator</td>
<td>Aspirator Tube Assembly</td>
<td>Sigma A5177-5EA (pack of 5)</td>
<td>#21-180-10 (1)</td>
</tr>
<tr>
<td>Forceps for sperm extraction</td>
<td>Millipore Filter Forceps</td>
<td>Millipore XX6200006</td>
<td>XX62-000-06</td>
</tr>
<tr>
<td>Spatulas</td>
<td>Tapered Microspatula</td>
<td>Fisher #21-401-10</td>
<td>#21-401-10</td>
</tr>
<tr>
<td>Dishes</td>
<td>Easy Grip Petri Dish, 35 x 10mm</td>
<td>Falcon #35-1008</td>
<td>#08-757-100A</td>
</tr>
<tr>
<td>Kimwipes</td>
<td>Kimwipes delicate task wipers</td>
<td>Kimberly-Clark #34155</td>
<td>#06-666A</td>
</tr>
<tr>
<td>MESAB</td>
<td>Ethyl 3-aminobenzoate methanesulfonate</td>
<td>Sigma #A5040-25g</td>
<td></td>
</tr>
<tr>
<td>“Pillows”</td>
<td>Cut soft foam packing material to fit into dishes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Electrical Stimulation of Muscle Contraction and Quantitative Morphometrics of Effects of Force on Muscle Attachments

Arul Subramanian and Thomas F. Schilling

University of California, Irvine

**Background:**

Embryonic development is highlighted by changes in cell shape, cell number, and extracellular matrix (ECM) composition. Quantifying these changes is essential to understanding the mechanisms controlling morphogenesis and differentiation. Cells in a developing embryo are exposed to varying magnitudes of mechanical force. For example, during convergent extension, cells migrate toward the midline, intercalate, and push against each other to extend. This process involves non-muscle myosins and F-actin fibers, which both create and respond to compressive forces. Later, when the musculoskeletal system develops, forces exerted on tissues can be of many types and much greater in magnitude. Muscles exert tensional forces on the skeleton and associated connective tissues – tendons and ligaments - through their contraction. The effects of mechanical force on muscle growth and development have been studied in various model systems, yet responses in terms of cell morphology and ECM production remain largely unknown. How do muscle attachments respond to mechanical force? What role does the ECM at myotendinous junctions (MTJs) play in sensing and responding to mechanical force? To answer these questions, we have developed a technique to stimulate muscle contraction in developing zebrafish embryos and quantify its effects on associated connective tissue cells and ECM.

In this section, we will learn to use a Grass stimulator to electrically induce muscle contractions in embryos/larvae in a quantitative manner that allows precise measurements of the strength of muscle attachments. We will then use confocal imaging techniques and quantitative morphometrics to analyze the effects of the force generated by muscle contraction on the morphologies of individual tendon fibroblasts (tenocytes) and their associated ECM organization.

**Materials Required:**

- Grass Stimulator – SD9/SD5
- Insulated Connecting wires (26 AWG solid copper wire)
- Soldering iron
- Soldering flux
- Soldering lead
- 1ml Syringe
- 16-gauge needle (1.5 inch long)
- Stainless steel PFA coated electrode wires
- Sylgard gel plates (Sylgard 184 silicone elastomer curing agent and Sylgard 184 silicone elastomer from Dow corning corporation USA.)
Ultra-fine Needle file (optional)
Push pin connectors (optional)
Banana plugs
Hot air gun
Shrink wrap
Timer

**Preparation of Sylgard Plates:**
1. The sylgard elastomer mix is prepared by mixing 1-part curing agent with 10 parts elastomer and mixed well by inversion.
2. The mix is placed at -20°C overnight to remove bubbles.
3. The mixture is poured on to Petri plates to just cover the surface.
4. The plates are placed in 70°C oven for 4 hrs to cure.

**Preparation of Electrodes:**
1. Cut a 16-gauge needle tip with pliers and smoothen the inner edges with a needle file.
2. Cut two 10-inch strands of electrode wire.
3. Strip off the insulation at the tips (1/4 inch) of the wires.
4. Cut an approximately 3 ft long 26 AWG wire and strip off 1/4 inch of insulation at the tip.
5. Thread the electrode wires through an empty 1 ml syringe barrel attached to the filed 16G needle.
6. Solder the tips of the electrode wires to push-pin connectors. Solder the push pin connectors to the connecting wires. *Optional:* if you do not have access to push-pin connectors, you may solder the tips of electrode wires with the connecting wire tips.
7. Place shrink wrap around the connector and seal using a hot air gun to insulate.

**Stimulator Setup:**
The Grass stimulator is a versatile instrument used for delivering precise electrical impulses in physiological experiments, often while simultaneously recording the impulses. In this experiment, we will be generating impulses without recording. Instead, we will use the stimulators to produce a defined array of impulses to stimulate muscle contraction. With both SD9 and SD5 models, you are able to modulate the voltage, frequency, and duration of stimulation separately. Pay close attention to the multiplication selectors under each knob, which can be used to increase or decrease each parameter by several orders of magnitude. We will use twin pulses in the Repeat mode. Insert the banana plug connectors at the ends of the wires of the electrode to the +ve and -ve output terminals.
Stimulation Parameters:
For each experiment, the stimulation parameters need to be optimized for the type of analysis to be performed and the age of the embryos/larvae. Previously optimized parameters are listed below.

<table>
<thead>
<tr>
<th></th>
<th>Age of embryos (hpf)</th>
<th>Frequency (Hz)</th>
<th>Duration (ms)</th>
<th>Voltage (V)</th>
<th>Stimulation Time (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Muscle detachment assays</td>
<td>48 – 96</td>
<td>6.0</td>
<td>8.0</td>
<td>30.0</td>
<td>3</td>
</tr>
<tr>
<td>Morphometrics (tenocyte morphology and ECM organization)</td>
<td>24 – 96</td>
<td>6.0</td>
<td>8.0</td>
<td>20.0</td>
<td>2</td>
</tr>
</tbody>
</table>

Stimulation Protocol:

1. Transfer a small number of embryos (~20) to E3 + Tricaine medium.
   
   **Note:** Since we can only stimulate two embryos at a time, it is not advisable to anesthetize large numbers of embryos before starting the stimulation protocol as it can adversely affect their health.

2. Fill a Sylgard plate with 5 ml of E3 + Tricaine medium containing 0.01% Tween.
   (Addition of tween prevents bubbles generated by the electrodes from sticking to the embryos.)

3. Dip the electrode pair into the medium to a depth where the ends touch the Sylgard surface. The distance between the two electrodes should be about 0.5 cm.

4. Transfer a pair of embryos to the Sylgard plate. Position them such that their body axis extends head to tail from one electrode to the other and in opposite orientations.

5. Set a timer to 2 minutes (for morphometrics) or 3 minutes (for muscle detachment assays) and switch on the Grass stimulator.
6. After a short delay, embryos/larvae will twitch longitudinally and bubbles will form at the end of the electrodes. Use a needle to keep the embryos more or less stationary and in position.

7. After half of the allotted time has elapsed, rotate the embryos 90 degrees so that they are perpendicular to the line connecting the two electrodes and position them close to the electrode tips. The embryos will twitch from side-to-side.

8. After the stimulation, transfer the embryos to a Petri dish with prewarmed (28.5°C) E3 medium.

9. Allow the embryos to recover and prepare them for further analysis. Embryos may be grown, fixed for staining, mounted for live imaging, or used for real time PCR analysis.

**Post-Stimulation Analyses:**

A. **Quantification of Muscle Attachment/Detachment:**
   Assay muscle detachment in response to induced contractions by imaging muscle fibers after stimulation using either: 1) birefringence microscopy, which relies on orienting the embryos/larvae such that polarized light passes through the linear striations of the sarcomeres, 2) fluorescent transgenics that label muscle, or 3) immunostaining to visualize muscle fibers.

   Count the number of embryos showing detachment phenotype in control and experimental samples. Perform 2–3 biological replicates to estimate standard error and standard deviation for each experiment. Perform a Chi square ($\chi^2$) test on the data to determine significance. $\chi^2$ tests are used to determine the significance of a relationship between independent categorical variables (# of detached and attached embryos).

   Example of a dataset showing detachment of muscles post stimulation in control and experimental samples with statistical significance ($\chi^2$ test).

<table>
<thead>
<tr>
<th></th>
<th>Detached</th>
<th>Attached</th>
<th>total</th>
</tr>
</thead>
<tbody>
<tr>
<td>control</td>
<td>25</td>
<td>31</td>
<td>56</td>
</tr>
<tr>
<td>Experimental</td>
<td>32</td>
<td>16</td>
<td>48</td>
</tr>
<tr>
<td>total</td>
<td>57</td>
<td>47</td>
<td>104</td>
</tr>
</tbody>
</table>

   \[
   \text{Chi test: } 0.024464, \quad \chi^2: 0.024464 
   \]

B. **Quantification of Morphological Changes in Tenocytes:**
   We will use an approach commonly employed to quantify changes in the length of neuronal projections (axons and dendrites) to measure tenocyte projections. Following stimulation, fix
embryos for immunostaining or image them live (if transgenic and expressing a fluorescent
marker) with a confocal microscope.

We will use a Simple Neurite Tracer plugin, which is under the Segmentation category in the
Plugins tab of ImageJ (Fiji).

**Step 1: Load File and open program**
Load the confocal Z-stack or single file and open Simple Neurite Tracer (SNT) plugin in ImageJ.
Navigate to Plugins> Segmentation> Simple Neurite Tracer

**Step 2: Create new Viewer**
Choose ‘Create New 3D Viewer’. This option opens up a 3D viewer window, showing the
reconstructed image of the Z stack. This allows you to verify the correctness of the traces.

**Step 3: Prepare image for analysis**
Once the plugin is opened, you will notice that the confocal stack is in grey scale (this helps
visualize weaker signals). Adjust Brightness and Contrast by navigating to
Image>Adjust>Brightness/Contrast.
Once the program is activated four new windows appear on the screen. Three of these are ‘action’ windows, as shown below.

- Measurement Window
- 3D viewer window
Step 4: Select starting point of projection
Scroll through the original confocal file to find the optimal starting point for the projection. In this image, we use the approximate central point of the tenocyte cell body to begin.

Using the magnification glass icon on the Fiji control window, magnify the image to help resolve the signal spots.

Make sure that the ‘hand icon’ is selected on the Fiji Control window. Now click on the start point. A blue spot appears on the image.
Step 5: Track points along the process
While observing the signal, scroll forward 5-10 slices and click on a signal spot that appears to be part of the same cell or projection. A blue line connects these spots.
Before you approve this line by clicking ‘Yes’ on the control window, rotate the 3D image on the 3D viewer to both visualize the projection and the trace drawn. If the trace coincides with the projection, go ahead and click Yes. If not, click No and try again.
Step 6: Finish path of projection measurement
Once the trace is approved, the color of the trace changes from Blue to Red on both the 2D (original confocal image) and 3D windows. If this trace segment is covering the entire length of the projection, click on ‘Finish Path’ in the control window. If not, continue selecting points that connect with the existing path to complete the trace. Once you click ‘finish path’, the path is registered into the measurement window and cannot be edited. However, the entire path can be deleted.

Step 7: Observe finalized trace
Once you finalize a trace, the color changes to purple/pink and a measurement of the length in microns appears in the measurement window.
Step 8: Finish tracing measurements of other projections (repeat steps 4-7 for new traces)

Step 9: End tracing experiment
If this trace completes the experiment, click on ‘Fill volume’ in the measurement window (bottom left). This refines the trace and ensures a proper fit with the signal in the region.
Step 10: Retrieve data for analysis

Copy the measurements to an Excel spreadsheet and use it for further downstream analyses including statistical significance. We usually perform 2–3 biological replicates for these experiments to determine statistical significance (t-test).

A t-test is run to determine the significance of the relationship between the means of two independent groups (projection length in wild type and paralyzed embryos). Each sample had a normal distribution.

C. Quantification of Changes in ECM Distribution in Response to Force

Cells secrete and adhere to the ECM, which must have the correct organization to handle different types and magnitudes of force. Mechanical force has been shown to alter the composition, levels, and spatial distribution of ECM proteins. Changes in ECM protein composition and levels are usually analyzed with quantitative western blots while spatial changes are traditionally examined with electron microscopy. We have devised a protocol to
measure changes in ECM organization at zebrafish MTJs in response to force by quantifying fluorescence brightness and spatial distribution from images of immunostained embryos.

**Step 1: Generation of Z stack**
To analyze the area of an ECM protein’s distribution along the somite boundary (where trunk MTJs are located), first generate a 3D projection of a confocal Z stack through the following path: Image>Stacks>3DProject. It is essential to collect the images with an optimal Z-spacing (determined by the type of objective used) to ensure accurate quantification.

**Step 2: Orient plane to visualize somite boundary**
Using the bottom scroll bar, rotate the 3D-projected image to face the somite boundary in the transverse plane, perpendicular to muscle fiber orientation.

Navigate to Image>Lookup Tables to change the color to grey scale to aid in visualization of the fluorescent signal.
Step 3: Set up freehand drawing tool

Select the ‘Freehand selection’ drawing tool for selecting a Region of Interest (ROI).

Step 4: Outline each MTJ:

Trace the outline of an ROI encompassing the area in which immunofluorescent staining of the ECM protein can be detected. Measure the area of the ROI (square pixels) using the ‘Measure’ function (Analyze>Measure).
Step 5: Repeat measurements for other boundaries

Repeat this measurement along 3 different somite boundaries per embryo and record the mean value. Repeat these measurements in 10–15 embryos for each sample.

Step 6: Run statistical analysis

Plot the mean area measurements for each sample. Calculate the statistical significance (t-test).

D. Quantification of ECM Protein Levels in Response to Force.

Step 1: Generation of Z stack
Open the confocal image stack in Image J. Assemble a Z-stack projection of the image with maximum intensity (Image>Stacks>Z project).

Step 2: Prepare image for measurement
Using Image>Lookup Tables, change the color to grey scale to aid in visualizing the fluorescent signal. This function does not alter signal intensity. Select the ‘Freehand selection’ drawing tool. Trace the outline of an ROI encompassing the visible fluorescent signal. Measure the signal intensity using ‘Measure’ function (Analyze>Measure), which is represented as arbitrary units.
Step 3: Select area of background intensity:
Using the ‘Hand’ tool in the control bar move the ROI to a blank region in the image, which has no observable signal. Measure the signal intensity using the ‘Measure’ function (Analyze>Measure), which is represented as arbitrary units. This value represents the background intensity for this embryo.

Step 4: Controlling for background intensity:
Similar to the Area measurement protocol, measure 3 somite boundaries in each embryo.

Subtract the mean background fluorescence intensity signal from the mean fluorescence signal intensity at the somite boundary. Quantify the average mean value of adjusted fluorescent intensity.
Step 5: Repeat measurements to collect more data
Repeat this measurement protocol for 10-15 embryos for each sample.

Step 6: Statistical Analysis
Plot the values as a histogram and calculate statistical significance (t-test).
**Labeling cells with photoconvertible fluorescent proteins in zebrafish**

Instructors: Debbie Yelon (dyelon@ucsd.edu), Dena Leerberg (dleerberg@ucsd.edu)

**Introduction:**

Lineage analysis involves elucidation of the particular cells or populations of cells that give rise to specific target tissues. Along with identifying the origins of specific tissues, clonal lineage analysis at single-cell resolution can also identify the individual decisions that cells make during differentiation and proliferation (Blanpain and Simons, 2013). These analyses are vital for the investigation of a large range of concepts in developmental biology, from patterning and tissue formation to stem cell and regenerative biology.

Below we have highlighted the pros and cons of a few (but not all) of the powerful techniques developed in zebrafish for performing lineage analysis. For a more comprehensive review of lineage analysis techniques, the following reviews and their included references are likely to be helpful (Blanpain and Simons, 2013; Buckingham and Meilhac, 2011; Kretzschmar and Watt, 2012; Solek and Ekker, 2012).

- **Direct observation/time-lapse imaging:** Classically simple bright field observation of a cell within the embryo and its subsequent daughter cells has been used to trace the lineage of cells (Kimmel and Law, 1985). The transparency of the zebrafish embryo makes this analysis particularly useful. However, the increasing number of cells and size of the embryo limit this analysis to only the earliest embryonic stages. Recently though, in toto imaging efforts using GFP and advanced light sheet microscopy have helped to expand this analysis to later stages of embryogenesis (Amat and Keller, 2013; Keller et al., 2008; Olivier et al., 2010). This analysis can provide single-cell level resolution as well as reveal the morphogenetic events occurring development. However, unlike other lineage analysis techniques, one must follow a cell and its progeny from start to finish, instead of assaying only at the beginning and ending timepoints. Furthermore, this analysis is limited by one's ability to continuously image cells over a long period of time and obtain high enough spatial and temporal resolution to distinguish individual cells and their progeny.

- **Injection of dextran and other non-protein based labels:** A more efficient lineage analysis technique involves the injection of dextran or other labels, such as lipophilic dyes, in order to label a small subset of cells. The lineage of these cells can then be observed at a later time point, without having to follow the cells throughout their development. A popular method is to inject caged fluorescent dextran and to then uncage it using UV light, allowing for the precise temporal and spatial labeling of a small population of cells (Keegan et al., 2004; Kozlowski et al., 1997). Although a small population of cells can be labeled, single-cell clonal analysis is not guaranteed. This technique is somewhat limited by dilution of the label through multiple cell divisions, but antibodies that recognize the lineage tracer allow sensitive detection of labeled cells.
• **Use of fluorescent and photoconvertible proteins:** In these methods, blastomere transplantation is used to create mosaically labeled embryos with containing fluorescent clones. This technique does not allow for precise spatial control of initial lineage selection. However, the recent creation of photoconvertible fluorescent proteins allows for both spatial and temporal control of initial lineage selection through photoconversion. Furthermore, by combining photoconvertible fluorescent proteins with promoter-specific transgene expression, distinct timing of emergence of cell lineages can be distinguished, in a process called birthdating (Caron et al., 2008; de Pater et al., 2009; Hatta et al., 2006). Similar to lineage analysis with fluorescent dextran, these techniques are limited by the dilution of the converted protein through cell divisions.

• **Recombination-based lineage analysis:** Another popular technique is the use of Cre recombinase to activate a conditional reporter; permanently labeling a cell population and its progeny (Buckingham and Meilhac, 2011). This technique commonly utilizes a gene-specific promoter to express Cre recombinase in combination with a conditional cassette in which a stop codon surrounded by loxP sites interrupts the continuous expression of GFP. In this approach, spatial control over the labeling of specific cell populations is limited to the specific promoter used to drive Cre expression. This differs from other approaches in which the initial populations are labeled based on their anatomical positions. Advances in recombinase technology allow for temporal control by utilizing CreER(T2), in which Cre is excluded from the nucleus until the introduction of 4-hydroxy-tamoxifen (4-HT) (Hans et al., 2009). Initial recombinase-based lineage techniques labeled large initial populations of cells; however, recent advances such as multicolored labeling with zebrabow cassettes (Gupta and Poss, 2012; Pan et al., 2013) or highly selective labeling through the dilution of 4-HT levels allow one to obtain clonal analysis (Hans et al., 2009).
<table>
<thead>
<tr>
<th>Technique</th>
<th>Advantages</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-lapse Imaging of cell population and progeny throughout duration of development</td>
<td>Single-cell resolution</td>
<td>Continuous imaging required. Limited by capacity of microscope to obtain temporal and spatial resolution for faithfully following cells throughout development and maintaining cells within the field of view.</td>
</tr>
<tr>
<td>Injection of dextran and other non-protein based labels Injection/uncaging of fluorescently labeled dextran.</td>
<td>Efficient; continuous imaging not required. Anatomical spatial control.</td>
<td>Small but not single cell clones. Dilution of label.</td>
</tr>
<tr>
<td>Use of fluorescent proteins, including photoconvertible fluorophores Mosaic labeling using blastomere transplants or photoconversion</td>
<td>Efficient; continuous imaging not required. Birthdating can identify temporally distinct lineages.</td>
<td>Transplants don’t allow for spatial control, but do allow for small clone size. Photoconversion allows for anatomical spatial control, but small clones are hard to obtain. Dilution of photoconverted signal over long time periods</td>
</tr>
<tr>
<td>Recombination based lineage analysis Expression of Cre recombinase with a conditional cassette for activation of a reporter gene.</td>
<td>Efficient; continuous imaging not required. Permanent label. Temporal control and single cell resolution</td>
<td>Spatial control based on gene expression and not anatomical position. Requires transgenic animals.</td>
</tr>
</tbody>
</table>

Table 1. Lineage analysis techniques used in zebrafish.

**Lineage analysis with photoconvertible proteins**

We will focus our experiments on using photoconvertible fluorescent proteins for lineage analysis. Photoconvertible (aka photoswitchable or photoactivatable) fluorescent proteins exhibit fluorescence that can be modified by a light-induced reaction. In zebrafish, the exquisite optical accessibility of the embryo provides fantastic opportunities for labeling cells via photoconversion. A number of labs have taken advantage of photoconvertible proteins to track cells over time during embryonic development. To cite just a few specific examples (of course, this is not a comprehensive list of relevant studies):

- Photoconversion of individual cells has been used to track the dynamics of cell shape changes. Examples include studies in neurons (Sato et al., 2006) and in floor plate cells (Nakayama et al., 2012).
- Photoconversion of subpopulations of cells has been used to monitor cellular rearrangements during morphogenesis. Examples include studies of organ rotation during cardiac morphogenesis (Baker et al., 2008) and studies of cell division during morphogenesis of the neural tube (Tawk et al., 2007).
- Photoconversion of entire tissues has been used to birthdate cells. Examples include protocols for monitoring the timing of myocardial differentiation (de Pater et al., 2009) and the differentiation of trigeminal neurons (Caron et al., 2008).

Several types of photoconvertible proteins have been employed in zebrafish. The characteristics of three of the most commonly used proteins – Kaede, Dendra2, and KikGR1 – are listed in Table 2. They all share several features:
- Photoconversion is irreversible.
- There is no spontaneous conversion or cytotoxicity.
- The excitation/emission wavelengths for the original and photoconverted forms are clearly separable.
- The wavelength used for photoconversion does not overlap with the spectrum of wavelengths used for observation.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Kaede</th>
<th>Dendra2</th>
<th>KikGR1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original</td>
<td>Excit./emis.maxima (nm)</td>
<td>508/518</td>
<td>490/507</td>
</tr>
<tr>
<td>Photoconverted</td>
<td>572/580</td>
<td>553/573</td>
<td>583/593</td>
</tr>
<tr>
<td>Oligomerization</td>
<td>Tetramer</td>
<td>Monomer</td>
<td>Tetramer</td>
</tr>
<tr>
<td>Isolated from…</td>
<td>The stony coral, Trachyphyllia geoffroyi</td>
<td>The octocoral, Dendronephythya sp.</td>
<td>The stony coral, Favia favus</td>
</tr>
<tr>
<td>Reference</td>
<td>(Ando et al., 2002)</td>
<td>(Gurskaya et al., 2006)</td>
<td>(Tsutsui et al., 2005)</td>
</tr>
</tbody>
</table>

Table 2. Photoconvertible proteins commonly employed in zebrafish.

Depending on the goals of a particular photoconversion experiment, there are choices to make regarding how to introduce the photoconvertible protein and the level of resolution for photoconversion. As a source of photoconvertible protein, you might inject RNA or DNA encoding the photoconvertible protein or you might employ a stable transgene that drives expression of the photoconvertible protein. If your experiment requires restriction of photoconversion to a particular area, you might adjust the size of the pinhole on your compound microscope or you might select the region of interest using a confocal microscope. In the course, we will demonstrate methods for photoconversion on a compound microscope, using the following general protocol.

**Protocol:**

Solutions needed: 0.3X Danieau’s, 3-4% methylcellulose, Tricaine stock solution (use a final concentration between 100-200 ug/ml)

1. Prepare glass slides with bridges for mounting embryos. For embryos from gastrulation to somitogenesis stages, use three layers of No.1 cover slides to make bridges. For embryos 24 hpf and older, use two layers of No.1 cover slides. Use superglue to adhere slides together. Wearing gloves is recommended. Acetone (or nail polish remover) is helpful to clean up any stray superglue.

2. Dechorionate the embryos in 0.3X Danieau’s manually with forceps. (Egg water containing methylene blue can create background fluorescence and is therefore not recommended.) Embryos at gastrulation stages should be kept in a glass dish. Add Tricaine to the dish for embryos 18 hpf and older. Estimate the dilution of Tricaine needed to reach the desired final concentration, adding it gradually and until the embryos stop moving (and until the heart stops beating, if applicable).

3. Dilute some Tricaine into an eppendorf tube containing 3-4% methylcellulose. Vortex the tube at maximal rpm for 30 sec. Spin down the tube at RT in an eppendorf centrifuge at the maximal speed for 1 minute. Use a serological pipetter with a fire-polished glass pipette to pick up one embryo. Bring along only a minimal amount of Danieau’s in order to avoid too much dilution of the methylcellulose. Insert the tip of
the glass pipette into the eppendorf tube containing methylcellulose, and then slowly release the embryo into the prepared methylcellulose. Caution: active pipetting is not recommended, especially for young embryos. Be patient and let gravity do the work. After embryos gradually sink into the methylcellulose, remove the glass pipette and release all of the remaining liquid in its tip. Re-insert the tip of the glass pipette into the methylcellulose and suck up a small amount of solution (about 3 mm length within the pipette). Then suck the embryo into the glass pipette and drop the embryo very carefully onto the glass slide between the bridges. The diameter of the drop should be about 8 mm (either too much or too little methylcellulose will make it difficult to position the embryo in the following steps). Put another smaller drop of methylcellulose (about 2-3 mm in diameter) on one side of the cover slip. Merge the two drops together carefully (this will help to avoid bubble formation) as you place the coverslip on the glass slide, hanging upon the bridges. As pictured below, the cover slip should not be aligned in parallel with the glass slide. A 45 degree rotation is better for use in the following step of positioning your embryo (Embryo image adapted from Kimmel et al., 1995).

4. Position your embryo as desired. Using two fingertips (typically the index fingers of your left and right hands), place tiny amounts of pressure exactly above the position of each bridge. Use subtle motions to slide the cover slip around until you achieve the desired orientation of your embryo.

5. Place the slide on the observation stage of the compound microscope. Find the embryo in bright field. Use the green filter set to detect the original form of Kaede. Use the red filter set to confirm that photoconversion has not already occurred.

6. Switch to the DAPI filter set and perform the actual photoconversion (exciting!). (For localized photoconversion, adjust the size of the pinhole.) After exposure of the embryo to UV, examine the fluorescent signal using the red filter set to determine whether photoconversion has been achieved. Then switch back to the green filter set to determine whether photoconversion has been complete. Repeat the photoconversion until no green fluorescence remains. (Note that the level of UV
exposure will need to be calibrated for each individual microscope. Prolonged UV exposure is harmful to the embryos. In the Yelon lab, we find that 30-60 seconds of exposure can achieve complete photoconversion in embryos carrying Tg(myl7:kaede) and is compatible with normal embryonic development.

7. Recover your embryo. For a short experiment (in which you would analyze the embryos within 3-4 hours after photoconversion), your embryo may be fine developing on the slide if you keep the slide in a covered, humid container. For a longer experiment, your embryo should be transferred into normal 0.3X Danieau’s medium. Slide the glass slide into a glass dish filled with 0.3X Danieau’s; be sure to use a glass dish when working with younger embryos. Caution: don’t drop or dip the slide into the dish; instead, slide it in carefully at an angle. The methylcellulose around the embryo will gradually dissolve into the 0.3X Danieau’s, and the solution should gradually lift up the cover slip. If not, swirl the dish very gently to help lift the cover slip. Using a fire-polished glass pipette, transfer your embryo to a 24-well plate (agarose-coated for younger embryos). As before, when transferring your embryo, pipetting is not recommended; be patient and let gravity do the work.

8. At a later timepoint, analyze your results, using the red filter set to view the photoconverted Kaede and the green filter set to view the original form of Kaede.

References:


the zebrafish heart. Development 136, 1633-1641.


Controlling protein localisation in vivo with light

Jon Clarke and Rachel Moore

Background

While gene knockout, over-expression, and mutation have been used to reveal the involvement of proteins in biological systems, more subtle manipulation of proteins may be needed to interrogate their precise roles. For example, manipulation of protein localisation within cells will be critical for understanding how intracellular asymmetries and polarity are established. The use of optogenetics to precisely control cell processes such as gene transcription, signalling activation and protein dimerization allows researchers to probe specific components of signalling pathways and cellular function, often with subcellular resolution and rapid temporal control.

There are several optogenetic systems that can be used to manipulate function in vivo. Light-oxygen voltage (LOV)-based strategies have so far had the most success of the optogenetic systems in transferring from cell culture to whole organisms (Motta-Mena et al., 2014; Wang et al., 2010; Wu et al., 2009; Yoo et al., 2010) and after optimisation are highly adaptable, particularly for transcriptional regulation. The cryptochrome system (Kennedy et al., 2010) has also been used in vertebrates for regulation of protein transcription, both in whole homogenates of zebrafish embryos and in the mouse cortex (Konermann et al., 2013; Liu et al., 2012).

If the focus of an experiment is to precisely control the spatiotemporal dynamics of a protein, rather than to directly alter its transcription, then arguably the most important property of an optogenetics system is its speed of reversibility. Only two optogenetics systems can be actively reversed. The first is the photoactivatable protein Dronpa, which has been used in multicellular organisms for photoswitching experiments (Aramaki and Hatta, 2006). Although successfully used in cell culture (Zhou et al., 2012), Dronpa has so far not been used to regulate protein interactions in multicellular organisms. A faster reversal can be achieved with the Arabidopsis red light-inducible Phytochrome (PHYB-PIF) system, which comprises the phytochrome B (PHYB) protein and the basic helix-loop-helix (bHLH) transcription factor phytochrome interaction factor (PIF; PIF3 or PIF6). These two domains are induced to bind under far-red light and the binding is reversed within seconds.
of exposure to infrared light but is otherwise stable for hours in the dark (Ni et al., 1999). The Phytochrome system has a 10-100x larger dynamic range (respectively) than the cryptochrome and LOV-based systems (Pathak et al., 2014) and the affinity of its light-gated interaction is 100x tighter than Dronpa (Levskaya et al., 2009; Zhou et al., 2012). The Phytochrome system therefore offers the highest level of spatiotemporal control of the currently available systems. An added advantage is that the wavelengths required for photomodulation (red and infrared) are far from the wavelengths of the fluorescent proteins commonly used for imaging cells and subcellular compartments. The Phytochrome system has been highly successful in modulating signalling in single cells, such as testing the subcellular spatial sufficiency of Rac for directed cell migration (Levskaya et al., 2009) and dynamically controlling the activation and inactivation of signalling pathways in yeast (Yang et al., 2013) Hoeller et al., 2014; Toettcher et al., 2011).

**Demonstration**

Clare Buckley in our lab recently developed the use of the Phytochrome system to manipulate subcellular protein localisation in the zebrafish embryo (Buckley et al 2016). Here we will demonstrate the use of the Phytochrome system to rapidly and reversibly recruit proteins to specific subcellular regions within cells in the intact fish embryo. We will use RNA injection at the 16-32 cell stage to obtain mosaic expression of the fluorescently tagged PHYB and PIF6 proteins. As well as 633nm light, heterodimerization of PHYB and PIF6 also requires a chromophore called Phycocyanobilin (PCB) and we inject HPLC purified PCB protein along with the RNAs. We will use a PHYB construct that is tagged with the CAAX motif to direct this (the “anchor”) to the cell membranes.

When the embryos are at approximately 20hpf, we will anaesthetise and mount them in low melt agarose and then use a confocal microscope to manipulate the subcellular location of the PIF6 protein (the “bait”). We will use 633nm light to initiate heterodimerization of PHYB and PIF6 and thus drive PIF6 to the membrane. We will use 750nm light to reverse heterodimerization and remove PIF6 from the membrane. By using restricted ROIs for the 633nm light we will target PIF6 to particular subregions of the membrane of individual cells (for example either the apical or the basal poles of neuroepithelial cells).
Full details of all methods can be found in Buckley et al 2016.

References

Transgenesis and Cell Biology in the Fish

Instructor: Florence Marlow
Icahn School of Medicine Mount Sinai, Department of Cell, Developmental and Regenerative Biology, New York, NY
Florence.marlow@mssm.edu

Teaching Assistant: KathyAnn Lee
Icahn School of Medicine Mount Sinai, Department of Cell, Developmental and Regenerative Biology, New York, NY
Kathyann.lee@mssm.edu

Introduction:
Several approaches have been used in zebrafish to generate transgenic lines using fluorescent reporter systems to label, quantify, and deduce lineage relationships of cell-types-of-interest. Transgenesis is also useful for killing cells (Nitroreductase (Curado et al., 2008; Pisharath, 2007)), monitoring pathway activities (e.g. Calcium signaling (Mizuno et al., 2013; Shimozono et al., 2002), FRET(Fritz et al., 2013), ERK (Wong et al., 2018)), modifiers of pathway activities (e.g. ion channels, inducible channels, toxins such as tetanus or C3), or temporal delivery of Cas9 for mutagenesis (Ablain et al., 2015). Several transgenesis systems have been developed and used in zebrafish, with each having its own set of strengths and limitations. Below, a few commonly used transgenesis systems are listed as a reference and parameters to consider when generating transgenic lines are briefly summarized. This is incomplete and is meant to serve as a catalyst for discussion and reference to get you started once you are back in your lab.

BAC transgenesis: (Yang et al., 2006)

I-SceI Meganuclease: (Soroldoni et al., 2009; Thermes et al., 2002)

Transposons/retroviral insertions

Sleeping beauty: (Davidson et al., 2003)

Tol2: (Kawakami, 2007) reviewed in (Kawakami, 2005)
- iTol2 for BACs:(Bussmann and Schulte-Merker, 2011; Suster et al., 2009)
- Enhancer Trap/gene trap:(Kawakami et al., 2004; Kotani and Kawakami, 2004; Scott et al., 2007)
- “Gateway” cloning for vector construction/Tol2 kit: (Kwan et al., 2007; Villefranc et al., 2007)

Targeted integration

- PhiC31:(Roberts et al., 2014)
When to turn to transgenesis?

If your gene-of-interest (GOI) is expressed or the process that it regulates occurs after 2-3 dpf, you will likely need to use a knock-in or transgenesis approach to explore its function. For relatively early developing structures, a transient approach may be feasible, but for studies of later processes, studies of adults, or when you want to generate conditional gain or loss of function/interference stable transgenic lines are needed. Although creating a stable transgenic line requires an initial time investment, averaging about 3-6 months to generate founders and propagate the line, once established these lines are simply propagated and offer a reliable way to access late processes or, for proteins lacking reliable antibodies, offers insight into the subcellular distribution, stability, or activity of the protein of interest in both wild-type and mutant contexts. For example, transgenic rescue of a mutant phenotype is a standard and important control to demonstrate specificity or sufficiency of gene function.

Key parameters when designing transgenic lines:

1. Which promoter should be used? Ideally, the native promoter or another appropriate well-characterized promoter.
2. Will a fluorescent protein or antigenic tag be used to label your GOI protein product? If so, where should it be placed?
3. Does my gene require noncoding sequences for proper regulation?
4. Will a transgenesis marker be used to allow carrier fish to be easily identified?

(1) Promoter selection: While several excellent promoters already exist for transgenic expression, these promoters may not be expressed with the same spatiotemporal pattern or levels as your GOI. To solve this issue, it may help to clone the promoter for your GOI, but you will need to make sure that the promoter recapitulates the endogenous pattern of gene expression. This can be accomplished by placing coding sequence for a fluorescent reporter behind your putative promoter and comparing the expression of an RNA encoding a fluorescent protein by RTPCR and in situ hybridization. Ideally, if antibodies are available, it is best to compare the expression of a tagged or fluorescent fusion of your GOI to the endogenous protein, but this is often not possible. In this case, demonstrating that the transgenic protein can rescue the mutant phenotype without causing phenotypes in “wild-type” siblings is a control for “physiological activity”.

In addition to tissue specific promoters, conditional or inducible promoters can be useful ways to control the timing (e.g. heat shock (Halloran et al., 2000)) or tissue in which your GOI is expressed (e.g. Gal4/UAS ((Asakawa and Kawakami, 2008)), Gal4FF (Akitake et al., 2011; Goll et al., 2009), Cre/Lox (Thummel et al., 2005), Tet (Huang 2005), mifepristone/LexPR (Emelyanov and Parinov, 2008), photoactivation (Hatta et al., 2006).

(2) Tag selection: The zebrafish field is still lacking reliable antibodies for immunofluorescence of many proteins. Without these reagents, generating a transgenic line expressing a tagged or fluorescent fusion of your GOI may be useful for examining the subcellular distribution or activity of wild-type or mutant proteins. In addition, tagged transgenic proteins can be useful for downstream approaches such as immunoprecipitation to identify interaction partners. As mentioned above, keep in mind that when using transgenic expression your GOI may be
expressed at higher or lower levels than the endogenous protein. Moreover, protein tags can interfere with some biological activities, especially if the tag disrupts folding, stability, localization, or interactions with binding partners. In general, small tags (for example Myc or HA) are less disruptive than larger fluorescent proteins, but these small tags do not allow for live imaging analysis of your protein. Knowledge of your protein’s structure or surveying the literature to determine where others have successfully proteins similar to yours can guide you in tag placement.

(3) **Including other regulatory sequences:** In addition, there are other regulatory features that you may need to include in your constructs. For example, for some genes-of-interest it is clear that non-coding sequences such as the 5’ and 3’ untranslated regions, or even intronic regions, are required for proper regulation and translation. UTR-mediated regulation is particularly important for maternally expressed genes and genes in the nervous system (Heim et al., 2014; Kumari et al., 2013; Nojima et al., 2010) and reviewed in (Andreassi et al., 2018). For such genes expressing the open reading frame (ORF) alone (Heim et al., 2014; Kumari et al., 2013; Nojima et al., 2010) is not sufficient for proper translational control, presumably because these non-coding regions are critical for maturation, splicing, transport/localization and translation of these RNAs (reviewed in (Lasko, 2012). For such genes it is generally beneficial to generate and compare constructs lacking to those that include potentially important non-coding elements in the transgene.

(4) **Selectable Markers:** Finally, if your promoter is not activated before 5dpf, when larvae are typically placed on the systems, then it extremely helpful to engineer your plasmid to include an independent, tissue-specific transgenesis marker. For example, in this demo we will use the cardiac myosin light chain 2 (cmcl2) promoter, which drives expression in the embryonic heart that is easily detectable at 2dpf, and thus has been commonly used as a selectable marker to screen for and identify transgenic positive embryos for line propagation or analysis (Huang et al., 2003; Kwan et al., 2007). Additional markers that are commonly used are IRES (Kwan et al., 2007) and the PTV viral 2A peptide (Provost et al., 2007).

**Today’s demo will cover:**

- Stable and Transient transgenesis
- Cell biology in the fish
  - Transgenesis and overexpression can be used to study subcellular localization of proteins/structure function assays/subcellular structures/visualization of organelles in vivo. Examples of some of these will be covered.

**References**


Lipid metabolism: feeding and visualization

Friday August 16, 2018

Instructor: Steven Farber
Carnegie Institution for Science, Department of Embryology, Baltimore, MD
farber@carnegiescience.edu

Teaching Assistant: Monica Hensley
Carnegie Institution for Science, Department of Embryology, Baltimore, MD
Hensley@carnegiescience.edu

Introduction:
Traditional methods of visualizing dietary lipid metabolism typically involve the use of lipophilic dyes in cell culture models. Though these cell-based and ex vivo studies have played a vital role in our understanding of metabolism, they are limited in that the complex milieu of the intestine, microbiome, liver, and enterohepatic circulation cannot be adequately replicated in vitro. Imaging lipid-processing events in live, intact vertebrate systems has historically been technically challenging, however, the larval zebrafish has recently emerged as a powerful model in which to visualize lipid-processing events in the gastrointestinal system through the use of fluorescently-labeled molecules, including BODIPY®-labeled lipids [1-12]. The zebrafish GI system is similar to that of humans and is composed of organs including the pharynx, esophagus, intestine, liver, gallbladder, and exocrine and endocrine pancreas. Inter-organ lipid transport is also conserved from fish to humans: lipids are initially absorbed by intestinal enterocytes from the lumen of the intestine, transported to the liver via chylomicrons, exported by the liver to the periphery in low-density lipoproteins, and returned to the liver in high-density lipoproteins [9, 12]. Notably, the gastrointestinal system of the larval zebrafish is fully functional by 5 days post fertilization, when the larvae are still optically clear. At this time, fluorescently-labeled lipids can be incorporated into their food, which allows for visualization of dietary lipid transport and processing at the tissue, cell and sub-cellular levels [3, 5, 6]. These microscopy approaches can be easily combined with traditional biochemical approaches, as well as pharmacological and genetic manipulations of the zebrafish, in order to study lipid biochemistry and transport, lipoprotein biology, and gastrointestinal physiology.

Today we will cover:
- Methods to prepare a high-fat meal containing fluorescently-labeled fatty acid
- Conditions in which to feed larval zebrafish that encourage eating
- Screening larvae to verify ingestion the lipid meal
- Mounting methods for imaging live larvae following a meal
- Choosing the correct BODIPY®-labeled fatty acid analog for your experimental goal
- Visualization of BODIPY®-labeled fatty acids in the intestine and liver with confocal microscopy

Methods:
The following protocol was adapted by Meredith Wilson & Steven Farber and reprinted from Zeituni and Farber (2016) [13].

Fluorescently labeled Liposome Preparation:
Larvae can be fed a high-fat meal by immersion in an emulsion of 5% chicken egg yolk in E3 media. The composition of chicken egg yolk is 65% triglyceride, 30% phospholipid and 5% cholesterol.
Materials:

- Purchase organic eggs from the grocery store; avoid eggs with vitamin fortification or omega fatty acid supplementation.
- Separate egg yolks from egg whites and store 1 mL aliquots of egg yolk in microcentrifuge tubes at -80°C.
- Fluorescently tagged fatty acid analogs are available from ThermoFisher:
  - BODIPY®FL C16 (D-3821), BODIPY®FL C12 (D-3822), BODIPY®FL C5 (D-3834), BODIPY®FL C2 (D-2183); fatty acid analogs can be stored long-term in chloroform at 0.5 µg/mL in brown glass vials at -20°C. Alternatively, for short-term storage, fatty acids can be dissolved in 200 proof EtOH at 0.5 µg/mL.

- Nitrogen gas
- 50 mL and 15 mL conical tubes
- Sonicator with 1/4th inch tapered microtip (Sonicator Ultrasonic Processor 6000, Misonix Inc., Farmingdale, New York, USA). Set a program for 5 s total processing time, 1s on, 1s off, output intensity: 3W).
- 2.5 inch nylon mesh strainer (Progressus Brand; 970775).

1. Prepare BODIPY® fatty acid analog
   a) Transfer desired volume of BODIPY® fatty acid analog to a 1.5 mL microcentrifuge tube. The desired final concentration is 2 µg/mL fluorescent fatty acid in the egg yolk emulsion (stock is 0.5 µg/mL). (Example: 20 µL of stock fatty acid for 5 mL of needed egg yolk solution)
   b) Remove chloroform storage solution by drying down BODIPY® fatty acid under a stream of Nitrogen gas.
   c) Resuspend BODIPY® fatty acid analog to 0.5 µg/mL in 200 proof EtOH, making sure to solubilize all of the dried analog on the sides of the tube.
   d) Add 180 µL of E3 medium.
   e) Protect the solution from light & set aside.

2. Prepare chicken egg yolk emulsion and incorporate BODIPY® fatty acid into liposomes
   a) In a 50 mL conical tube, prepare a 5% egg yolk solution by combining 1 mL of egg yolk with 19 mL of E3 medium. It is easiest to slightly thaw the frozen aliquot of egg yolk and use a metal spatula to scoop the semi-frozen aliquot into the E3 solution.
   b) Vortex until the egg yolk dissolves fully in the E3 and place on a room temperature rocker table until you are ready to sonicate.
   c) Immerse the 1/4th inch tapered microtip of the sonicator half-way into the 5% chicken egg yolk solution.
   d) Pulse sonicate the egg yolk solution with the following program to make liposomes: 5 s total processing time, 1s on, 1s off, output intensity 3 watts; run the program 4 times, waiting 5 seconds between programs.
   e) Pour the 5% chicken egg yolk solution through a nylon mesh strainer into a new 50 mL conical tube to remove any solid debris.
   f) Repeat the sonication protocol: 4 program runs with 5 seconds between each run.
   g) Immediately after sonication, separate the 5% chicken egg yolk solution into desired volumes in 15 mL conical tubes.
   h) Quickly add the prepared BODIPY® fatty acid analog to the sonicated chicken egg yolk emulsion. (Example: add 200 µL fatty acid solution to 5 mL of 5% egg yolk solution)
   i) Vortex at full speed for 30 seconds. This will incorporate the fluorescent fatty acid analog into the liposomes that were formed as a result of the sonication procedure; mixed egg yolk solution may be placed on a rocker table or orbital shaker until you are ready to feed larvae.
Feeding Larval Zebrafish Liposomes & Screening for Ingestion

Zebrafish rely on nutrients supplied by the embryonic yolk sac for the first four days of development. Although they begin to eat exogenous foods starting on 5dpf, feeding assays are typically performed on 6dpf or later, once the larvae have completely depleted their yolk supply. At this time, the larvae not only eat more reliably, but experimental results are more consistent because nutrients are solely provided by the exogenous food source and are not influenced by varying degrees of yolk absorption.

Materials:
- Zebrafish larvae at 6dpf or older
- 35 x 10 mm or 6-well culture dishes; 100 x 20 mm culture dishes
- Incubated orbital shaker set to 29.5°C and 30 RPM (Incu-Shaker Mini; Benchmark Scientific, South Plainfield, NJ, USA; H1000-M); alternatively an orbital shaker or rocker table at room temperature or in a heated room can be used.
- Tricaine solution (0.03% Tricaine in E3 media).
- Stereomicroscope

1. Feeding zebrafish larvae with liposome preparations
   a) Place larvae in E3 media in 35 x 10 mm Petri dishes or 6-well culture dish. An optimal feeding density is 20-80 larvae per dish/well.
   b) Remove almost all of the E3 media.
   c) Quickly add the prepared egg yolk liposome preparation (3-5 mL depending on dish or well capacity; if you are using a rocker table, use the smaller volume).
   d) Place the feeding larvae in an incubated orbital shaker at 29.5°C and 30 RPM to feed. We have found that the elevated temperature and slow rotation promotes consistent consumption of the liposomes by the larvae. Additionally, we have found that feeding the larvae under ambient light conditions also promotes liposome consumption and does not noticeably affect the BODIPY® signal in downstream imaging applications.
   e) Under ideal conditions, larvae can eat substantial quantities of liposomes in 1hr of feeding, but feeding times can be varied depending on the design of the experiment.
   f) At the end of the desired feeding time, wash the fed larvae with at least two rinses of E3 media by moving them with a glass pipet to new 10 cm cultures dishes containing fresh E3 media. Reduce carry-over of the egg yolk solution by allowing the larvae to swim out of the tip of the pipet.

2. Screening larvae to verify consumption of liposomes
   a) Anesthetize larvae with a low dose of tricaine in E3 media (0.03 % tricaine).
   b) Examine larvae under a stereomicroscope to verify ingestion of the lipid meal. Using a poker, turn larvae gently to allow a lateral view of their intestine. Fed larvae will have intestines that appear dark, whereas unfed larvae have translucent intestines. The more lipid the larvae consume, the darker the guts will appear and more of the length of the intestines will be dark.
   c) Evaluate the fed status of each larvae and return the fed fish to a dish with fresh EM
   d) Immediately process the larvae for imaging or biochemical analysis, or incubate the fed larvae at 28.5°C to process their meal for the desired period of time.
Mounting live larvae for microscopy analysis of fluorescently labeled fatty acid absorption, transport, packaging, etc. Following consumption and processing of the liposomes containing fluorescently labeled fatty acid, larvae can be imaged at the level of the whole fish, gut, organ, cell and/or sub-cellular level. Depending on the desired level of resolution and length of the imaging protocol, larvae may be mounted for microscopy using any number of mounting methods. Here, we describe a few methods for optimal observation of the intestine, liver and typically, the gallbladder.

Low-magnification (whole fish, whole organ resolution)

Materials:
- Fluorescent stereomicroscope
- 3% methylcellulose in E3 media
- 25 x 75 x 1 mm glass glass slides
- metal block chilled in ice
- Kimwipes
- poker

1. Place a Kimwipe on top of the chilled metal block.
2. Chill a glass slide on top of the Kimwipe.
3. Using a wide-bore pipet, put a drop of 3% methylcellulose on the center of the glass slide
4. Pipet 1-6 larvae onto the drop of 3% methylcellulose in as little E3 media as possible
5. Under a stereomicroscope, use a poker to gently push the larvae into the methylcellulose and position them laterally (if visualization of the gall-bladder is desired, place the head to the right and the ventral side of the larvae facing you).
6. Image the larvae as desired, BODIPY is
7. If the methylcellulose warms up, the larvae may begin to roll and may need re-positioning with the poker or may need to be chilled again
8. When finished, larvae can be gently picked up from the methylcellulose with a poker and returned to E3 media.

High-magnification, short-term live imaging (organ, tissue, cell and/or sub-cellular level)

Materials:
- Confocal microscope (scanning or spinning disk; conventional or inverted)
- Stereomicroscope
- Prepared slides: a 22 x 22 mm glass coverslip is glued to one end of a 25 x 75 x 1 mm glass slide using QuickTite® Instant Adhesive Gel (LocTite® Item#39202, Henkel Corporation, USA). This provides a ledge that will partially protect the zebrafish larvae from compression, while allowing optical access of the objective to the tissue.
- 22 x 30 mm glass coverslips
- 3% methylcellulose in E3 media
- Tricaine (0.03% Tricaine in E3 media)
- Kimwipes
- poker

Larvae may be mounted in low-mount agar for long-term live imaging or mounted on glass slides for short-term imaging of fluorescent fatty acids in live larvae.
1. Place prepared slide on a stereomicroscope.
2. Using the tip of a wide bore pipet, draw a thick line of 3% methylcellulose vertically along the slide immediately to the right of the glued coverslip. This will create a methylcellulose cushion.
3. Place 1-4 anesthetized larvae in a droplet of E3 media on the slide away from the methylcellulose.
4. Dip a poker into the 3% methylcellulose and then use it to gently pick up one larva from the droplet. Move the larva into the methylcellulose, minimizing the amount of E3 media carried into the methylcellulose. Repeat with the other larvae. Wipe off the remaining droplet of EM using a Kimwipe.
5. Use the poker to orient the larvae in the methylcellulose laterally with heads proximal to the glass ledge established by the glued coverslip.
6. Apply four beads of QuickTite® Instant Adhesive Gel to the corners of a 22 x 30 mm glass coverslip and place it onto the glass slide: with the 22 x 30 mm coverslip held at an angle, first adhere the left-most edge to the top of the 22 x 22 mm, then gently press the other side down to adhere it to the glass slide beyond the methylcellulose cushion. This will cover and compress the larvae in the methylcellulose.
7. Place the slide on the microscope stage and image as desired (to image BODIPY® use a 488 nm laser; 498 nm excitation; 530 nm emission)

High-magnification, long-term live imaging (organ, tissue, cell and/or sub-cellular level)

Materials:
- Confocal microscope (scanning or spinning disk; conventional with immersion objective or inverted)
- Stereomicroscope
- 70°C heat block
- 42°C heat block
- 1.2 % low melt agar in EM. To make aliquots ahead of time, melt the 1.2 % agar in EM and aliquot 1 mL into 1.5 mL Eppendorf tubes. Aliquots can be stored at 4°C for up to 1 year.
- Tricaine solution (0.03 % tricaine in E3 media).
- 35 x 10 mm sterile plastic culture dish (conventional microscope with water immersion objective) OR 35 mm glass-bottom dish (MatTek P35G-1.0-20-C; No. 1.0, uncoated)(for inverted microscope)
- metal block chilled in ice
- poker

1. Heat 1.2% low melt agar at 70°C in a heat block. Agar should flow smoothly when the tube is inverted.
2. Once the agar turns liquid, transfer it to a 42°C heat block to maintain fluidity during the mounting process and cool it so that it will not damage or kill the larvae.
3. Anesthetize the larvae in 0.03% tricaine solution.
4. When using an immersion objective:
   a. Gently pipet 1-10 individual anesthetized larvae into the liquid agar, transferring as little E3 media as possible.
   b. Transfer the larvae and the agar to a droplet in the middle of the 35 mm culture dish.
   c. While the agar is still liquid, quickly orient the larvae with the poker, positioning them laterally; then use the poker to square-off the top of the agar droplet to make a flat surface.
d. Once the agar hardens, add a drop of E3 media to the surface to prevent drying and move the plate to the microscope; add E3 gently to the dish so that it fully covers the agar droplet.

5. When using an inverted microscope:
   a. Place two Kimwipes on top of the chilled metal block.
   b. Place the glass-bottom culture dish on top of the Kimwipe immediately before pipetting larvae.
   c. Pipet a single larvae onto the glass portion of the dish, and rapidly remove excess E3 media using the corner of a kimwipe, trying to use the movement of the liquid to pull the larva onto its side, flush with the glass.
   d. Immediately pipet a drop of warm agar onto the fish, moving from head to tail. The chilled metal block will quickly harden the agar, so that the fish will remain pressed against the glass.
   e. Repeat with additional fish, no more than 4 per dish.
   f. Pipet a drop of E3 media onto each agar droplet and move the plate to the microscope.
   g. Add additional drops of E3 media as needed to prevent the agar from drying.

6. Place the slide on the microscope stage and image as desired (to image BODIPY® use a 488 nm laser; 498 nm excitation; 530 nm emission)

Video demonstrations of many of these protocols are also available online as part of a JoVE article:


Please see digital course material for Supplemental Material and References
Use of genetically encoded calcium indicators (GECIs) to visualize calcium ion signaling in the heart

Instructors: Debbie Yelon (dyelon@ucsd.edu), Dena Leerberg (dleerberg@ucsd.edu)

Introduction:

The dynamic transit of calcium ions in the cell acts as an essential second messenger mediating a variety of biological processes including neurotransmitter release and muscle contraction (Berridge et al., 2000). The live visualization of calcium ion dynamics using calcium sensors has been critical to understanding and elucidating these processes. Calcium sensors can be divided into two broad categories: chemical indicators and genetically encoded Ca²⁺ indicators (GECIs) (Demaurex, 2005; Horikawa, 2015; McCombs and Palmer, 2008; Paredes et al., 2008). Chemical indicators, such as Calcium Green, are derived from Ca²⁺ chelators such as BAPTA (Eberhard and Erne, 1991; Grynkiewicz et al., 1985; Tour et al., 2007). These indicators have a wide range of sensitivities but are diffusely distributed and suffer from poor retention and the inability to target their localization. GECIs were designed to overcome these limitations. Generally, GECIs have been designed either as a FRET-based system (i.e. Cameleon (Miyawaki et al., 1999; Miyawaki et al., 1997)) or as a single fluorescent protein (i.e. GCaMP).

GCaMP is a circularly permuted eGFP molecule attached to a Calmodulin domain and the Calmodulin binding peptide M13. GCaMP was designed based on the premise that, in the absence of Ca²⁺, solvent quenches the eGFP chromophore. However, in the presence of Ca²⁺, the M13 peptide binds to the Calmodulin domain, occluding solvent from the chromophore (Akerboom et al., 2009; Baird et al., 1999; Nakai et al., 2001). Multiple rounds of optimization have created newer versions of GCaMP sensors with high sensitivity, high signal-to-noise ratios, and fast kinetics (Chen et al., 2013; Muto et al., 2011).

Ca²⁺ dynamics in the heart mediate the role of the conduction system, coordinating the sequential, rhythmic contraction of cardiac tissues required for efficient blood flow (Staudt and Stainier, 2012). Briefly, the conduction system in zebrafish is comprised of three main components: a sinoatrial (SA) node in the inflow tract containing pacemaker cells (Arrenberg et al., 2010; Tessadori et al., 2012), an atrioventricular (AV) node in the AV canal, and a fast conduction network within the ventricle. Pacemaker cells undergo regular spontaneous membrane depolarization triggering Ca²⁺ influx and a wave of depolarization across the heart. This wave slows at the AV canal allowing the sequential contraction of the atrial and ventricular chambers (Milan et al., 2006). The wave then accelerates due to the fast cardiac conduction network within the ventricle which also coordinates the sequential contraction of the ventricle from apex to outflow creating an efficient synchronized pump (Chi et al., 2008).
Protocol:

In this demonstration we will use the \textit{Tg(myl7:GCaMP)} transgene to visualize Ca\textsuperscript{2+} dynamics in the zebrafish heart. Since different elements of the conduction system develop at different times during heart formation, we can visualize the changes Ca\textsuperscript{2+} dynamics by examining different stages of cardiac development.

1. Inhibit cardiac contraction. In order to properly visualize Ca\textsuperscript{2+} dynamics in the heart, Ca\textsuperscript{2+} influx must be decoupled from cardiac contraction, otherwise imaging artifacts will significantly distort our ability to accurately detect changes in fluorescence. We will use two methods to inhibit cardiac contraction: a mutation in \textit{tnnt2a}, called \textit{silent heart (sih)} (Sehnert et al., 2002), or the drug 2,3-butanedione monoxime (BDM)(Ostap, 2002). Using a mutation or morpholino that targets \textit{tnnt2a} to inhibit cardiac contraction is technically very straightforward and robust; however, many aspects of heart development depend on blood flow (Auman et al., 2007; Berdougo et al., 2003; Peshkovsky et al., 2011), including the development of the fast cardiac conduction network in the ventricle (Chi et al., 2008) and thus this technique is not applicable for later stages of development. A chemical inhibitor of muscle contraction such as BDM addresses this deficiency since a chemical can be added just prior to analysis, however many of these chemicals including BDM also affect Ca\textsuperscript{2+} dynamics (Gwathmey et al., 1991; Phillips and Altschuld, 1996). In the case of BDM, it affects Ca\textsuperscript{2+} dynamics at a higher concentration than the concentration at which it affects cardiac contraction, thus the dose can be titrated to inhibit contraction and not conduction.

2. Orient and mount embryos for imaging. Embryos will be mounted in methylcellulose and oriented with their hearts facing the objective using the protocol described above in the lineage tracing section.

3. Visualize the GCaMP reporter and conduct short timelapse experiments with a ultra-fast camera to capture the dynamics of Ca\textsuperscript{2+} influx at different developmental stages.

References:


Milan, D.J., Giokas, A.C., Serluca, F.C., Peterson, R.T., MacRae, C.A., 2006. Notch1b and neuregulin are required for specification of central cardiac conduction tissue. Development 133, 1125-1132.


Zebrafish Genetics and Development 2019 Roundtable Discussions

**Responsible Conduct in Research;** Wednesday Aug 13, 5-6pm, Starr 209  
**Sharon Amacher,** Debbie Yelon  
We will discuss best practices for responsible conduct in research using examples of misconduct. We will also briefly discuss the NIH rigor and reproducibility requirements. We will spend the majority of the time discussing student questions, concerns, and experiences.

**Morpholinos;** Thursday Aug 8, 2-3pm, Starr 209  
**Mary Mullins,** Sharon Amacher, Andi Pauli  
In this roundtable session, we will discuss how to do a morpholino knockdown experiment that passes the tests of rigor and reproducibility, replete with the necessary controls and meeting the most recent guidelines for using morpholinos by the zebrafish community. We will discuss the controls needed to show specificity of the knockdown and the typical non-specific effects. We will also discuss genetic compensation and its distinct effects on genetic mutations versus morpholino knockdown.

**Genome Editing;** Thursday Aug 8, 5-6pm, Starr 209  
**Antonio Giraldez,** Sharon Amacher, Mary Mullins, Alex Schier  
In this roundtable session, we will discuss the successes and failures that various labs have had with gene editing techniques using a variety of nucleases. Based on the experiences of panelists and students, we aim to address concerns regarding specific knock-in and knock-out approaches, and to share specific tricks to improve homologous recombination for short and long fragments. For this reason, it will be important for all students to bring their own experiences to the table. This session will differ from the separate CRISPR design workshop, in that the workshop will be more focused on the principles of CRISPR targeting, design tools, and practical advice.

**Disease Models;** Sunday Aug 11, 9:45-10:45am, Starr 209  
**Anna Huttenlocher,** Jeff Gross  
In this roundtable, we will discuss aspects of disease modeling using genetic, toxicant, nutritional and other approaches which induce disease in zebrafish. We will discuss how to integrate discoveries in zebrafish with human disease phenotypes and disease outcomes and the different perspectives in using zebrafish as a model or a tool for studying disease.

**Husbandry: Lecture & Discussion;** Tuesday Aug 13, 10:30am-12, Starr 209  
**April Freeman**  
The purpose of this lecture is to provide basic zebrafish husbandry information, including environmental parameters, biosafety and health management, breeding, rearing and much more. Questions and open dialogue are encouraged during and following the presentation.
Behavior; Wednesday Aug 14, 4-5pm, Starr 209
Michael Granato, Jim Fadool
In this roundtable, we will discuss the strengths and limitations of studying behavior in zebrafish. Rather than providing a comprehensive overview, the goal here is to have an interactive conversation on a range of topics related to zebrafish behavior. Since the mid-1990s, behavioral approaches in zebrafish, combined with genetic, pharmacological, physiological, and imaging techniques, have revealed unique insight into the molecular-genetic pathways, biological processes, and neural substrates that influence behavior. We will discuss parameters to consider when designing behavioral experiments, if and to which degree behaviors exhibited by larvae and adult zebrafish mimic rodent or even human behaviors, and consider the utility of zebrafish to study complex human disorders, such as autism spectrum disorders.

Transgenesis; Wednesday Aug 14, 5-6pm, Starr 209
Flo Marlow
In this roundtable session, we will discuss transgenesis approaches and applications. We will discuss controls for specificity, promoter/method selection, advantages and disadvantages compared to knock-ins, which will be covered in a separate gene editing session. Participation, questions and open dialogue are encouraged throughout the session.

Zebrafish in Education; Saturday Aug 17, 1:00-3pm, Starr 209
Kara Cerveny, Steve Farber, Dave Daggett
The goal of this roundtable is to provide a forum for discussing how zebrafish can be used in a wide range of educational settings. We’ll first provide a brief overview of some examples including undergraduate curriculum design (Dave), research and teaching programs at small liberal arts colleges (Kara), and K-12 outreach efforts (Steve). Then we’ll have an open discussion based on student questions and interests.
**Course Directors**
Sharon Amacher  
The Ohio State University  
amacher.6@osu.edu  
Debbie Yelon  
University of California - San Diego  
dyelon@ucsd.edu

**Course Coordinators**
Kara Cerveny  
Reed College  
cervenyk@reed.edu  
Dave Daggett  
University of Connecticut  
david.daggett@uconn.edu

**Course Faculty and Teaching Assistants**
Dan Burkhardt (TA)  
Yale  
daniel.burkhardt@yale.edu  
Gina Castelvecchi (TA)  
Washington University, St. Louis  
castelvecchi@wustl.edu  
Jonathan Clarke  
Kings College London  
jon.clarke@kcl.ac.uk  
Andres Collazo  
Cal Tech  
acollazo@caltech.edu  
Laura Desban (TA)  
University of Pennsylvania  
lauradesban@gmail.com  
Lydia Djenoune (TA)  
ICM Brain and Spine Institute  
ldjenoune@gmail.com  
Jim Fadool  
Florida State University  
jfadool@bio.fsu.edu  
Steve Farber  
Carnegie Institute  
farber@ciwemb.edu  
Florence Giger (TA)  
Kings College London  
florence.giger@kcl.ac.uk  
Antonio Giraldez  
Yale  
antonio.giraldez@yale.edu  
Michael Granato  
University of Pennsylvania  
mullins@pennmedicine.upenn.edu  
Hannah Greenfield (TA)  
University of Pennsylvania  
hgr@pennmedicine.upenn.edu  
Monica Hensley (TA)  
Carnegie Institute  
hensley@carnegiescience.edu  
Corinne Houart  
Kings College London  
corinne.houart@kcl.ac.uk  
Ruth Houseright (TA)  
University of Wisconsin - Madison  
houseright@wisc.edu  
Jan Huiskens  
Morgridge Institute for Research  
jhuiskens@morgridge.org  
Anna Huttenlocher  
University of Wisconsin - Madison  
huttenlocher@wisc.edu  
Mina Kojima (TA)  
Yale  
mina.kojima@yale.edu
Zebrafish Husbandry Coordinators
April Freeman
Zebrafish International Resource Center
april@zebrafish.org

Caitlin Inglis
cstewartswift@gmail.com
Students

Jingxun Chen
University of California, Berkeley
jxc415@berkeley.edu

Anthony Cirrincione
University of Miami
acirrincione@miami.edu

Briana Davis
Duke University
briana.davis@duke.edu

Victoria Deneke
Institute of Molecular Pathology
deneke.victoria@gmail.com

Safia Essien
MD Anderson Cancer Center
safia.essien@uth.tmc.edu

Matthew Hendricks
University of Washington
mhendric@uw.edu

Harini Iyer
Stanford University
iyerh@stanford.edu

Benjamin Jepson
The Ohio State University
jepson.19@osu.edu

Julie Jurgens
Boston Children’s Hospital
julie.jurgens@childrens.harvard.edu

Takuya Kaneko
Fred Hutchinson Cancer Research Center
tkaneko@fredhutch.org

Christopher Kassotis
Duke University
christopher.kassotis@duke.edu

Francisca Leal
Harvard Medical School
fleal@hms.harvard.edu

Xuan Liang
University of Cambridge
xl450@cam.ac.uk

Shari Litch Gray
Regis College
shari.gray@regiscollege.edu

Roeland Merks
Leiden University
merksrmh@math.leidenuniv.nl

Lucas Mongiat
Centro Atomico Bariloche - CNEA
lucas.mongiat@cab.cnea.gov.ar

Alma Rodenas-Ruano
Fordham University
arodenasruano@fordham.edu

Kristian Saied-Santiago
University of Pennsylvania
kristian.saied@live.com

Bhagyesh Sarode
University of Missouri, Kansas City
bsvg5@mail.umkc.edu

Mollie Sweeney
Duke University
bsvg5@mail.umkc.edu

José Uribe-Salazar
University of California, Davis
jmuribesalazar@ucdavis.edu

Oliver Vöcking
University of Kentucky
oliver.voecking@uky.edu
Sponsors of Zebrafish Development and Genetics Course 2019

- ZEISS
- ZIROL
- Leica
- Nikon
- Harvard Apparatus
- WPI
- World Precision Instruments
- Bruker
- Sutter Instrument
- Tecniplast
- IWAKI Aquatic Systems and Services
- Eppendorf
- Aquatic Enterprises, Inc.
- IDT
- Integrated DNA Technologies
- 3i Intelligent Imaging Innovations
- Aquaneering Incorporated
- MIZAR Imaging
- Narishige
- VisiTech International
- National Institute of Neurological Disorders and Stroke

Reducing the burden of neurological disease...